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& PLEDGE

India is my country

All Indians are my brothers and Sisters.

I love my country and I am proud of its rich and
varied heritage.

I shall always strive to be worthy of it.

I shall respect my parents, teachers and all my
elders and treat everyone with courtesy.

I pledge my devotion to my country and its people.
My happiness lies in their well-being and prosperity.

Shree Shreyas Education Trust
Manjalpur Naka, Vadodara-390 004.
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FUNDAMENTAL DUTIES

It shall be the duty of every citizen of India:

a) To abide by the Constitution and respect its ideals and
institutions, the National Flag and the National Anthem;

b) To cherish and follow the noble ideals which inspired our
national struggle for freedom.

c¢) To uphold and protect the sovereignty, unity and integrity of
India;

d) To defend the country and render national service when called
upon to do so;

e) To promote harmony and the spirit of common brotherhood
amongst all the people of India transcending religious,
linguistic and regional or sectional diversities; to renounce
practice derogatory to the dignity of women;

f) To value and preserve the rich heritage of our composite
culture;

g) To protect and improve the natural environment including
forests, lakes, rivers and wild life, and to have compassion for
living creatures;

h) To develop the scientific temper, humanism and the spirit of
inquiry and reform;

1) To safeguard public property and to abjure violence;

To strive towards excellence in all spheres of individual and

collective activity so that the nation constantly rises to higher
levels of endeavor and achievement
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Mrs. Anandiben M Patel
Minister of Revenue,
R&B, WCD,
Government of Gujarat.

MESSAGE
The principal goal of education is to cre

ate men who are capable of

doing new things, not simply of repeating what other generations

have done.

People always fear change. People feared electricity when it
was invented, didn’t they? People feared coal, they feared gas-
powered engines. There will always be ignorance, and ignorance

leads to fear. But with time, people will
masters.

come to accept their silicon

On the occasion of Swarnim Gujarat celebration, I release the e-

book to my citizens of our nation.

My Best Wishes .......
Mrs. Anandiben M Patel
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Shri Narendra Modi
Chief Minister

State of Gujarat

MESSAGE

If you are planning for a year, sow rice; if you are planning for a

decade, plant trees; if you are planning for a lifetime, educate people.

The aim of education should be to teach us rather how to
think, than what to think - rather to improve our minds, so as to
enable us to think for ourselves, than to load the memory with
thoughts of other men.

My Best Wishes .......
Shri Narendra Modi
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Shri. Kapil H. Sibal
Union Cabinet Minister,
Human Resource Development

MESSAGE

The reader will understand important issues of a

computer technology based Society and will be able to exhibit

ethical behavior in the use of computer.

The reader will also be able to use a variety of

computer technologies to access, analyze, interpret, synthesize,

apply, and communicate information.

My Best Wishes .......

Shri. Kapil H. Sibal
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Shri. Ramanlal Vohra
Education Minister
Gujarat

MESSAGE

The Book Computer @ Home focuses on the goal which is
concerned with fundamental computer operations and application software
used that will make the reader independent, productive, users of computer

technology.

With the help of this book, the readers will be able to select and use

most appropriate technology tools and resources to meet their needs.

Best Wishes .....

Shri. Ramanlal Vohra
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Shri. Balkrishna K. Shukla
Mayor, Vadodara Seva Sadan
Member of Parliament
Gujarat

MESSAGE

In the growing global competitive world, the changing technology

has its own significance and the computer knowledge has vital role to
play. Without this knowledge, we cannot survive and explore the available
opportunities.

A step towards providing basic computer literacy, this book will
be immensely useful to our community at a large.

On the occasion of SWARNIM GUJARAT MOHOTSAV this
educational project will contribute to the people in computer literacy,
the need of the present day.

Shri. Balkrishna K. Shukla
Ex. Mayor, MP
Vadodara
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From the Desk of the Managing Secretary
Mr. Pankaj R. Jani on the Occasion of the release of the
book...

Computer technology education allows the learner to explore a
variety of activities related to many areas of human endeavor. Learners
can develop problem solving strategies and work habits that will be
useful in almost any career or occupation. Learner should develop a
greater appreciation for their work and computer skills required for that

work.

Within the scope of this book, an effort has been made to
develop “Soft Skills within the reader as well as to give an opportunity
to the reader to see how systems work together and chance to put
much of the soft skills in better developed way, for any problem solving

situation.

Happy Reading ....
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Aims and objectives of the book

Dear fellow friends,

At the end of this book, the reader should not have any hesitation
or apprehension about using computers.
The reader should have developed the openness to use new
technology and also be convinced about how computers can help
them in their day to day activities of life, independently.
The reader will also become familiar with the hardware parts
of the computer.
The illustrations given in the chapters will enhance research,
communication, collaboration and the thrust of analyzing
computer skills of the reader.
It will serve as a base of survival skills for rural residents and
give them an opportunity to know about related government
programs.
It will assist the farmers to enhance the productivity of the crops
by applying the latest computer technologies.
It will enable the reader to have the familiarity to access web-
based information across the globe, to keep pace with the
developing technologies
The reader will be in a capacity to trouble-shoot and cope up
with virus related problems.
The reader will be able to add more mileage to their career by
easing themselves from the work pressures and can have end to
end solutions for computer related queries.

Author :

Mrs. Nita P. Jani

Principal

Shreyas Vidhyalaya

& Hon. Director,

Computer Department

)

\

10



N

7

Table of Content

(A) Introduction to Computers, its types and usage:
1. The Structure of Personal Computer

2. Operating System

3. Installing new software

4. Viruses

5. The Internet

(B) Computer Softwares to help in daily activities of life- Add

more mileage to your careers

6. Primary desktop applications MS Office and Microsoft

windows accessories

() Career courses — Add more mileage to your career
7. softwares and Language softwares

8. Multimedia Softwares and Media Softawares

0. Engineering, Accounting and programming softwares.

)

\

11



N

7

(A)

Sub-Content

Introduction to computers, its types and usage:

1.

The Structure of a Personal Computer

Central Processing Unit, Memory(Random Access Memory,
Read Only Memory), Storage Devices (Floppy Disk Drive, Hard
Disk Drive, Compact Disk Drive, Pen drive), Input-Output
Devices(Keyboard, Mouse, Soundcard, Microphone, Scanner,
Webcam, Joystick, Graphics Tablet Input Devices, Modem,
Monitor, Dot Matrix Printers Inkjet Printers, Laser Printer,
Speakers, Woofer, Subwoofer, headphones)

Using operating system

What is operating system, types of operating system (disk
operating system, UNIX Operating system, Linux operating
system, Windows XP, Creating shortcuts in start/programs)
Installing new software

Introduction, Install Shield, Installation, Installation of
Operating System, Install Windows XP, Uninstallation, Zip
files, Uses of Zip files, Where does WinZip fit in?, Software
Installation, Opening Zip files

Viruses

What are they, Types of viruses, Causes of viruses, Virus
evolution, guarding against viruses, Anti virus softwares,
Installation of Anti Virus Avast! Home Edition

The Internet

What it is, What it can provide (mainly WORLD WIDE WEB),
Hypertext and navigating hypertext, URLS, How to access
internet, The Internet Service Provider (ISP), The Modem,
Browsing the Web, Sending E-Mail, To create an Email account,
To send a mail with a attachment, Online chat with webcam,
Searching for information on the internet, Downloading the
softwares from the Internet, uses of internet, Various Websites
assisting in accessing information in daily routine schedule
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(B) Computer Softwares to help in daily activities of life

6. Primary desk top applications MS office, Microsoft Windows
accessories.

Introduction , Primary desktop applications for MS- office , Microsoft
Windows versions Word, Excel, Access, Outlook and Microsoft windows
accessories.

(C) Career courses — Add more mileage to your career

7. Text editing softwares, Desktop publishing Softwares and Language Softwares

o Text editing softwares

WordPad, Notepad.

o Desktop publishing softwares

Adobe PageMaker, MS-Publisher.

o Language Softwares

Shree-Lipi software, Indic, Sulekh, Baraha

8. Multimedia Softwares and Media Softwares :-

. Multimedia Software

Introduction

Graphic design software.

Paint Brush, PowerPoint, CorelDraw , Photoshop, Adobe Illustrator, Adobe
dream wear,

Web designing Softwares- Adobe Flash player, HTML with JavaScript,
3D Design Software

Maya

o Media Softwares

Windows Media player, Quick time media player, VLC media player,
Winamp.

0. Engineering software, Accounting softwares and programming
Softwares

o Engineering software

AutoCAD

o Accounting Softwares

Tally, EX-Next Generation Software, SAP

. Programming Languages

C, C++, JAVA, Visual Basic
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(A) Introduction to Computers, its types and usage:
Computers have affected every aspects of our day-to-day life.

The present global age is the consequences of the Computer Age. Computer knowledge has
become necessary these days to succeed in any area of specialization. Our daily routine work
can be performed with ease and speed with the help of computer because it is an electronic
device that stores and processes data, accordingly to a list of instructions. It allows a user to
manipulate data easily. The speed of performance of a computer is in comparable. The Computer
and Internet have changed our way of working, communicating and also writing. In fact, computers
have changed every aspects of life today. Computers have revolutionized all types of industries.
They have proved a boon to mankind.

The beginners can use the different types of computers in the varied situation related to their
work; Personal Computers come in variety of form such as desktops, laptops and personal
digital assistants.

Desktop:

A desktop is intended to be used on a single location. The spare parts of a desktop Computer
are readily available at relative lower cost. Desktops are widely popular for daily use in workplaces
and households.

Laptop:

Similarly in operations to desktops, laptop computers are miniaturized and optimized for mobile
use. Laptops run on a single battery or an external adapter that charges the computer batteries.
They are enabled with an inbuilt keyboard, touch pad acting as a mouse and a liquid crystal
display. Its portability and capacity to operate on battery power have served as a boon for
mobile users.

Personal Digital Assistants (PDAs):

It is a handheld computers and popularly known as a palmtop. It has a touch screen and a
memory card for storage of data. PDAs can also be effectively used as portable audio players,
web browsers and smart phones. Most of them can access the Internet by means of Bluetooth or
Wi-Fi Communication.

Supercomputer:

The highly calculation-intensive task can be effectively performed by means of supercomputers.
Supercomputers are also used in technical studies. Their ability of parallel processing and their
well-designed memory hierarchy give the supercomputers, large transaction processing powers.

)
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Wearable Computer:

A record-setting steps in the evolution of computers was the creation of wearable computers.
These computers can be worn on the body and are often used in the study of behavior modeling
and human health. Military and health professionals have incorporated wearable computers into
their daily routine, as a part of such studies. Wearable computers are of great use in tracking
human actions. Wearable are consistently in operation as they do not have to be turned on and
off and are constantly in interaction with users.

Different types of Comuters

Desktop Laptop

Super Computer Wearable Computer

)
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1. The Structure of Personal Computer

The different hardware parts of the computer when connected together will form a great structure
of'a Personal Computer. The Personal Computer consist of various hardware parts within it in
order to take input from the user store it in memory, to manipulate the input accordingly to
produce the output etc. All these various process are done with the help of various Hardware
parts of the computers.

Effective use of Computers can be achieved only with the help of excellent knowledge of various
hardware parts of computers and method of their practical usage in day to day activities.

We have wide range of varieties in hard ware parts of the computer

mentioned as follows:
Central Processing Unit, Memory(Random Access Memory, Read Only
Memory), Storage Devices (Floppy Disk Drive, Hard Disk Drive, Compact
Disk Drive, Pen drive), Input-Output Devices(Keyboard, Mouse, Monitor,
Soundcard, Microphone, Dot Matrix Printers Inkjet Printers, Laser Printer,
Scanner, Webcam, Joystick, Pen, Modem, Speakers, headphones).

Central Processing Unit:

CPU (Central Processing Unit) is the main Brain of the Computer which is also known as central
processor or processor. It is the place where most calculation takes place. In terms of computing
power, the CPU is the most important element of a Computer System.

On large machines, CPU requires one or more printed circuit boards. On personal computers
and small workstations, the CPU is housed in a single chip called microprocessor.

The CPU itself'is an internal component of the computer. Modern CPUs are small and square
and contains multiple metallic connectors or pins on the underside. Modern CPUs also have an
attached heat sink and small fan that go directly on top of the CPU to help dissipate heat.

Two typical components of a CPU are the following:
e The Arithmetic Logic Unit (ALU), which performs arithmetic and logical operations.
e The Control Unit (CU), which extracts instructions from memory and decodes and
executes them, calling on the ALU when necessary.

Memory:

A computer has memory; it can be easily understood by common word- memory (Ability to
remember).Memory in Computing is that part of the computer which stores information.

)
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Types of Memory:
The memory of the computer is basically divided into three types: Cache, RAM, and ROM.

e Cache: This is usually pronounced as ‘cash’. It is a small, high speed memory area that
stores the most recently used instructions or data. The basic idea behind the cache
memory is to make it possible for the computer to save the most recently used or
accessed segments of a program, data, instruction or process, in the Central Processing
Unit, where they can be accessed almost instantaneously.

e RAM: Random Access Memory is the temporary storage for data and programs that
are being accessed by the CPU.RAM is volatile memory, which means that the contents
are erased when the computer is powered off, the greater the RAM, the greater the
opportunity to open the application together with good results and speed.

e ROM: Read Only Memory is the computer memory that can retain the stored information
even when computer is not powered on is known as read only memory and it is also
know as Non volatile memory because it is used for information about computer system
that never changes, For example, the boot-up routines for the computer.

Memory management:
e [tisimportant to free up the memory space in order to have remarkable working speed
in computers.
It is also important to protect memory against unauthorized access to avoid data loss.

RAMLow  RAM High ROM

Fig : 1.1Central Processing Fig : 1.2 Read Only Fig : 1.3 Random Access
Unit Memory Memory

Storage devices:

The device that stores data from computer hardware or from internet or from other data bank is
known as storage devices.

There are different kinds of computer storage devices that are available, which can
keep you from using up too much space on your computer hard drive. They can also help you in
keeping your computer hardware drive from crashing, along with keeping it running at top speed.

\>
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Usage:
¢ Byusing maximum of storage devices the computer hard disk memory can be freed up
which helps the computers to act fast.
e Another usage of storage device is to have safe copy of all important documents with us.
The most common storage devices are:
e Floppy Disks
Zip Disks
CD+RW
CD+R
DVD+RW
DVD+R
Flash
PC Cards
Storage Tapes

Floppy Disk: A floppy disk is a data storage medium that is composed of a disk of thin, flexible
(“floppy ) magnetic storage medium encased in a square or rectangular plastic shell. Floppy
disks are read and written by a floppy disk drive or FDD, the initials of which should not be
confused with “fixed disk drive , which is another term for a (nonremovable) type of hard disk
drive.

Zip Disk: The Zip drive is a medium-capacity removable disk storage system, introduced by
Iomega in late 1994. Originally, Zip disks launched with capacities of 100 MB, but later
versions increased this to first 250 MB and then 750 MB.

CD-+RW Disc (Compact Disc Rewriteable): This disc looks like a regular CD. The only
difference is that you can write on this disc and erase it as many times as you want. It works just
like a floppy disk or a zip disk. A CD+RW disc holds 650 MB.

CD+R Disc (Compact Disc Recordable): This is a CD that you can record on. It’s mostly
used to record audio and once it’s been written on, you cannot rewrite or erase anything off of it.
This compact disc comes in different sizes, but they are usually silver in color. CDs are commonly
used storage device to store the data.

e It is important to handle CDs without any scratches, to avoid data corruption.

ADVD-R Disc (Digital Video Recordable): This disc holds the space of about4.7 GB and
is used to record movies and other kinds of personal and professional Videos.

Flash Drive: This is a storage device that comes in many colors and has a stick shape to it. They
are very small in size, but they can hold anywhere between 256 MB and 3 GB of material on
them.

\
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PC Cards: PC Card was originally designed for computer storage expansion, but the existence
of ausable general standard for notebook peripherals led to many kinds of devices being made
available in this form. Typical devices included network cards, modems, and hard disks. This is
thin card that fits into PC card slot, usually on a notebook computer.

Storage Tapes: This one is magnetically coated ribbon that stores large amount of data at a very
low cost.

The other types of storage devices that are used rarely are Removable hard Drive, Internet hard
drive, Miniature mobile storage media, memory stick, micro drive, smart media disc.
The storage devices such as Floppy disk drive, hard disk drive, flash drives are used as both

input and output device.

t\
Il

Flash Floppy Ihsk Zap Dusk D+« RW
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CD+R DVD - RW DVD+R Storage Tape
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Fig : 1.4 Storage Devices

Input and Output Devices:

Input/output devices are the means by which a computer exchanges information with the outside
world. Devices that provide input or output to the computer are called Peripheral.

Input devices:

An input Device is any peripheral (piece of computer hardware equipment) used to provide data
and control signal to an information processing system (such as computer).

\>
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We have a wide range of input devices which helps us in feeding data to the computer, in order
to derive the desired result.

The Input devices which are in frequent use are:
Keyboard, Mouse, Scanner, Webcam, Graphic Tablet

Keyboard:

A keyboard is the most important input device and it is a human interface device which is
represented as a layout of buttons. Each button, or key, can be used to either input a linguistic
character to a computer, or to call upon a particular function of the computer.

The keyboard is a combination of number, characters and special symbols and control keys,
which helps the user to input data for manipulation.

Explanation of the keys on a Keyboard:
e Escape key (Esc) — Equivalent to clicking the cancel button. In power point the Esc
key will stop a running slide show. The Keyboard Combination Ctrl+Esc will open the
Start Menu.

¢ Functional Keys:

While working in an application, depressing this
key bring up the application help menu.

Choose this key to rename a Selected item or
object.

Depressing this key will display the Find: All
F3 | Files Dialog box.

F1

F2

Selects the go to a different folder box and
F4 | moves down the entries in the box.

Es Refreshes the current window.

Moves among panes in windows Explorer.
F6

7
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Used to check the spelling while working in any
application

F8 | Used for contiguous selection of information.
Users have no use of this key in
Windows, but if you press this key
in MS Word you will update the
selected fields.

F10 | Activates the menu bar.

In the Internet Explorer this key will allow you to
F11 | toggle between full screen and normal screen
viewing mode.

This opens the save as dialog box to save the

F12 | document for further manipulation.

F7

F9

e Print Screen/ SysRq — Usually located at the upper right hand corner of your keyboard
next to the Scroll Lock and Pause/Break keys. Often abbreviated prtScr. In DOS,
pressing the Print Screen key causes the computer to send whatever images and text are
currently on the Print screen key to obtain Screen Captures.

e Tab —This key can be used to move forward through options in a dialog box.
Ctrl+Shift+Tab can be used to move backward through options.
Ctrl+Tab allow movement from one open window to the next in application with
more than one open window.
ALT+TAB-Displays a list of open application.

e Capslock - This key converts the keyboard in Capitals mode (only for alphabets).

e Shift— This key is used to make capital letters character by character. Shift+Delete
permanently delete a selected item.

Control Key — Depressing the ctrl key while clicking allows multiple selections. Holding the
ctrl key down and pressing other key combinations will initiate a few actions as follows.

Ctrl+A Select all
Ctrl+C Copy the selected item.
Ctrl+X Cut, removes the selected item.

CTRL+V Paste, inserts the copy on area
which you have selected.

Ctrl+H Replace, brings the find and
replace dialog box.

Ctrl+B Add or remove Bold formatting

Ctrl+] Add or remove Italic formatting

7
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Windows Key - On either side of the spacebar, outside the Alt key, is a key with the
windows logo. Holding the alt key down and pressing another key will initiate quite a few

actions as follows.
Window key Displays the start menu
press
Window+D Minimizes and opens
window accordingly

Alt- Located on either side of the space bar. Holding the Alt key down and pressing

Ctrl+U Add or remove Underline formatting

Ctl+P Print

Ctrl+S Save

Ctrl+W Will close the document

Ctrl+Y Redo last command

Cl+Z Undo last command. Multiple
undo’s is possible by pressing
Ctrl+7Z+7...

Ctrl+= Spell checker

Window+E

Opens explorer window

Window+F1

Displays the windows
Help menu

another key will initiate various actions as follows.

Alt+F4 Closes the current active
window

Alt+Enter Display the selected items
properties

Enter key- Creates a new paragraph; in a selected icon it opens the folder, in any dialog

Alt+PrtScn Captures the top window of
the active application

Alt+Tab Displays a list of open
application windows.

box a selected button or command can be opened by depressing this key.

Backspace-While working with text editor this key, deletes characters to the left of the

insertion point.

Delete- While working with text editor this key deletes characters to the right of the

insertion point; this key is also used to delete selected files.

\
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e End- Depress and hold the ctrl key as you select end to go to the last line of a document.

e Page up and page down keys are used to move up and down one full screen on a web
page.

e Up, down, right, left, arrow keys are used to navigate within the document accordingly.

e Number lock key is used to lock the number keys on the right side of the keyboard.

e Special characters available on the number keys in the left side of the key board can be
used with help of shift keys.

Mouse:

A device that controls the movement of the cursor or pointer on a display screen. Amouse is a
small object you can roll along a hard, flat surface. Its name is derived from its shape, which
looks a bit like a mouse; its connecting wires can be imagined as its tail. As you move the mouse,
the pointer on the display screen moves in the same direction. Mice contain at least one button
and sometimes as many as three, which have different functions depending on what program is
running. Some newer mice also include a scroll wheel for scrolling through documents.

The mouse allows an individual to control a pointer in a graphical user interface (GUI). Utilizing
amouse a user has the ability to perform various functions such as opening a program or file or
internet explorer, easily.

There are three basic types of mice:

1. Mechanical mouse: has a rubber or metal ball on its underside that can roll in all
directions. Mechanical sensors within the mouse detect the direction the ball is rolling
and move the screen pointer accordingly.

2. Optomechanical: Same as a mechanical mouse, but uses optical sensors to detect
motion of the ball.

3. Optical mouse: use a laser to detect the mouse’s movement. You must move the mouse
along a special mat with a grid so that the optical mechanism has a frame of reference.
Optical mice have no mechanical and Optomechanical mice, but they are also more
expensive.

Sound Card:
A sound card (also known as an audio card) is a computer expansion card that facilitates
the input and output of audio signals to and from a computer under control of computer programs.

Typical uses of sound cards include providing the audio component for multimedia applications
such as music composition, editing video or audio, etc. Many computers have sound capabilities
built in, while others require additional expansion cards to provide for audio capability. A computer
sound card is used by a computer for music, sounds during applications and entertainment (TV,
movies and games).

\
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Remember a sound card by itself is not enough to hear sound. You will still need to purchase
some computer speakers or a headphone set. If you want to make use of the microphone feature
then you will need to buy a computer microphone and you should then be able to record sound
to your computer.

Microphones:

Microphone is a device that converts our voice (Sound waves) into analogous electrical waves.
They are usually called as mike. Moreover it is generally used for chatting on internet, recording
our voice in computer etc. The microphone pin can be connected in the CPU ports and can be
used accordingly.

Scanner:

The flatbed scanner is very much like a copy machine. It is a device that captures images from
photographic prints, posters, magazines pages, and similar sources for computer editing and
display. Scanners usually come with softwares, such as Adobe’s Photoshop product that lets you
resize and otherwise modify a captured image.

Getting started with Scanning process:

Scanning Instructions:

1. Turn on the scanner ensuring the glass surface is clean (no dust, dirt, fingerprints or smudges)
and then place your image in the corner anchor point ensuring it is straight.

2. Open the software used to scan images on your computer.

Fig: 1.5 Scanning Window

\
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3. One of the scanner settings in the software will be resolution or DPI. Change the scanning
resolution (D.P.I) for the output to what is required, for example, “300 dpi is good for a
photo print or an A4 print onto paper. 100 dpi is adequate for a draft print or document.

(This could be under advanced, configure, professional mode or something similar if on
PC.)

Scan the photo at its original size (100%). Use the bounding box to identify the outer area
— it’s a boundary line. Everything inside line will be scanned and the outside ignored.

4. If possible, preview the scan. There is usually a button that says ‘preview’ to see photo.
If it’s what you want then....

5. Press scan button to scan your image. Scanner should light up and start whirring! If so
you are in progress.

hp scanning

Seanning to Photoshap, .

1 w: i 5 |HesnvunnnusnnsssssB | Caricel l
v "x*""'.‘
Tk -

(A wert Colors
1 Dpescrzen

“©  Reset Tools

—

Scale 100% Neve Scan Accept

Fig : 1.6 Scanning Process

6. Save your photo as a JPEG(Joint Photographic Expert Group) in a folder. ‘My pictures’
or make a new folder.

25
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Fig: 1.7 Scanned file Saving Window

There, hopefully that means you have a way to access all your old photos digitally now. So
next step is to do something useful with them and get them out in the open for all to see.

Have think about the walls in your home.

JPEG Options X]

[T

_.J | oK |
Cancel

" Progressive

Siza

— Image Options
uality; [@ [ Low ~ -
Qualiy: |8 l & = v Preview
small file large file
¢ 7S ]
Format Optlons

& Baseline (“Staridard”)
" Baseline Optirmized

-

~14592K-/ s06es@ | 28.8Kbps.

Fig: 1.8 Image Options
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Webcam:

Webcam are video capturing devices connected to computers or computer networks, often
using USB or, if they connect to networks, ethernet or Wireless (Wi-Fi).They are well known
for their low cost and flexible application.

Joystick:

Joystick controls the movement of the pointer or some other display symbol. A joystick is similar
to mouse but the only difference is, with mouse the cursor stops moving as soon as movement of
mouse is stopped, but in joystick the movement continues in the direction in which joystick is
pointing.

Generally we use joystick to play games and rarely for CAD/CAM systems.

Graphics Tablet Input Devices:

A graphics tablet is a computer input device that allows one to hand-draw images and graphics,
similar to the way one draws images with pencil and paper. These tablets may also be used to
capture data or handwritten signatures.

Modem:

A modem is a device that allows your computer to communicate with the Internet and fax
machines.

There are several types of modems that serve different
purposes.

1. Dial-Up Modem

This is the most basic modem. It operates at up to 5 kilobytes per second and uses your
phone line. You can send and receive faxes with this type of modem.

2. DSL Modem

A DSL (Digital Subscriber Line) modem operates at up to 8 megabits per second. It sits between
your computer and a phone line. It can be connected to a router so that other computers on your
local network can access it.

3. Cable Modem

A cable modem connects to your cable provider’s network instead of a phone line. It has the
same basic properties as a DSL modem.

\
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4. Modem Cards

A laptop has external slots that can contain wired or wireless modems. Wireless modems may
use Wi-Fi or a cell phone network.

5. Internal High-Speed Modem

High-speed modems are typically external boxes, but you can find them in the internal variety for
desktop computers. They usually use a PCI Express slot on the motherboard.

Fig : 1.9 Washable Wireless Keyboard

Line Out (spoaker)
Gaming Controller Port

Fig : 1.10 Mouse Fig : 1.11 Sound Card

Fig : 1.12 Headphone Fig : 1.13 Scanner Fig : 1.14 Webcam
& Microphone
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Fig : 1.15 Joystick Fig : 1.16Graphic Tablet Fig : 1.17 Modem
Output Devices

Any Peripheral that presents output from the computer, such as screen or printer is known as
output Device.

An output device is any piece of computer hardware equipment the results of data processing
carried out by an information processing system to the outside world.

The Output devices which are in frequent use are:
Monitor, Printer, Speaker.

Monitor:

In computers, a monitor is a computer display where it allows us to see all the inputs, outputs and
other manipulations and also the related parts packaged in a physical unit that is separate from
other parts of the computer.

Notebook computers don’t have monitors because all the display and related parts are integrated
into the same physical unit with the rest of the computer. In practice, the terms monitor and
display are used interchangeably.

Printer:
Printers produce a permanent hard copy of the information on paper. It is a computer peripheral
that place text on papers. Here is the information about different types of printers you should be

aware of, they are:

Ink-jets (bubble-jets) printers spray ionized tiny drops of ink onto a page to create an image.
A standard ink-jet printer has a resolution of 300 dots per inch, although newer models have
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improved on that. As a rule color link-jet printers can also be used as a regular black and white
printer. This printer is very cost effective and so easily used in all kinds of situation.

Laser printers operate by shining a laser beam to produce an image, Laser printers print very
fast, and the supply cartridges work a long time. Color laser printers can also be used as a
regular black and white laser printer.

Multifunction printers: combine top-quality color ink-jet or laser printing with plain-paper and
PC faxing, color copying and color scanning, telephoning- all in one convenient, space-saving
machine. If you work from home or have a small office a multifunctional device may be ideal.

LED/LCD printers are types of electro photographic printers that are identical to laser printers
in most ways. Both LCD (liquid crystal display) and LED (light-emitting diode) printers use a
light source instead of a laser to create an image, these printers produce a very high quality text
and graphics print out.

Impact (Dot-matrix) printers these printers actually impact the page to print a character, much
like a typewriter. Dot-matrix printers vary in terms of speed and the number of pins they have.
They can run at a speed anywhere between 50 and 500 CPS (Characters per Second). The
number of pins, which can vary between 9 to 24, determines the quality of the print job.

Solid Ink printers are page printers that use solid wax ink. Solid-ink printers offer better color
consistency and reliability.

Dye Sublimation printers are professional devices widely used in demanding graphic arts and
photographic applications.

Portable printers are usually fairly lightweight and sometimes carry the option of using a battery
instead of drawing power from the computer.

Plotters are large-scale printers that are very accurate at reproducing line drawings. They are
commonly used for technical drawings such as engineering drawings or architectural blueprints.

Digital Photo printers Many middle range printers are now able to print photo quality images.
Usually an option with color printers, specialist photo print heads allows a greater resolution to
be achieved to improve photo image quality.

Network printer is a printer that provides output capabilities to all network users.

3D Printers The ZPrinter 310 System creates physical models directly from computer-aided
design system (“CAD ) and other digital data in hours instead of days. The printer is fast, versatile
and simple, allowing engineers to produce a range of concept models and functional test parts
quickly and inexpensively. The system is ideal for an office environment or educational institution,
providing product developers easy access to a 3D Printer.

\
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Speaker:

A device that converts analog audio signals into the equivalent air vibrations in order to make
audible sound. Although CRT usage has faded, speakers designed for computers are shielded to
avoid magnetic interference with the CRT’s magnetic coil.

Woofer:

Alow-frequency loudspeaker. A hi-fi speaker cabinet typically contains a low-frequency bass
speaker (woofer), a mid-frequency midrange speaker and a high-frequency treble speaker (the
tweeter). In a two-way system, only woofers and tweeters are used. However, there are countless
high-fidelity loudspeaker configurations on the market, many with more than one speaker of the
same type within the enclosure.

Subwoofer:

A speaker that reproduces the lower end of the audio spectrum. A subwoofer system typically
includes a crossover circuit that filters frequencies around 100Hz and under to the driver. Ina
home theater, the placement of front, center and surround speakers is critical to the listener,
but subwoofers are non-directional and can be located in a convenient spot, although corners
are not recommended.

Headphones:

Head is a device that converts our analogous electrical waves into voice (Sound waves). They
are usually called as Hands free. Moreover it is generally used for chatting on internet, hearing
music, speeches etc. The Headphone pin can be connected in the CPU ports and can be used
accordingly.

Fig : 1.18 Monitor  Fig: 1.19 Printer  Fig : 1.20 Speaker Fig : 1.21 Woofer
& Sub-woofer
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What is Operating system?

2. Operating System

When the computer starts, it starts the operating system that takes the control of the machine.
Operating system is an interface between the user and the hardware of the computer; it is a set of
programs that help in controlling and managing the hardware and the software resources of a
computer system, because almost all hardware connected to the computer needs software to be
installed with it in order to activate the hardware.

A good operating system has the following features:

1. Help inthe loading of programs and data from external sources into the internal  memory
before they are executed.

2. Help programs to perform input/output operations, such as;

Print or display the result of a program on the printer or the screen.

Store the output data or programs written on the computer in storage device.
Communicate the message from the system to the user through the VDU.
Accept input from the user through the keyboard or mouse.

Types of Operating system:

There are few main types of Operating systems which have its own utility value and it can be
applied as per the desired task.

Disk Operating System (DOS)
UNIX

LINUX

WINDOWS XP

Disk Operating System (DOS)

\
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It is a set of computer programs and also known as DOS (Disk Operating System). The main
functions of DOS are to manage disk files, allocate system resources according to the requirement.
DOS provides features essential to control hardware devices such as Keyboard, Screen, Disk
Devices, Printers, Modems and programs.

Basically, DOS is the medium through which the user and external devices attached to the system
communicate with the system. DOS translate the command issued by the user in the format that
is understandable by the computer and instruct computer to work

Fig: 2.1 Dos Window accordingly. It also translates the result and any error message in the
format for the user to understand.

How to load DOS into Computer?

The BOOT Record into the computer memory loads DOS. BOOT Record in turn is triggered
by ROM program already there in the computer.

The system start-up routine of ROM runs a reliability test called Power On Self Test (POST)
which initializes the chips and the standard equipment attached to the PC, and check whether
peripherals connected to the computer are working or not. Then it tests the RAM memory.
Once this process is over, the ROM bootstrap loader attempts to read the Boot record and if
successful, passes the control on to it. The instructions/programs in the boot record then load the
rest of the program. After the ROM boot strap loader turns the control over to boot record,

the boot tries to load the DOS into the memory.

Computer files in Dos:

A file may contain a program or any other kind of information. Generally, a file must be given a
name that can be used to identify it. DOS permits the user to assign a name consisting of two
parts to a file - primary and secondary names. Primary name can be of a maximum of eight
characters consisting of Characters, Alphabets, Number and Hyphen), and the Secondary

name should consist of three characters, which is optional. The primary name and the
secondary (or extension) name, if any, are to be separated by a dot (.)

Filename Primary Name Separator Secondary Name
Employee Employee
Employee.Exe Employee . Exe

\
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Directory structures in DOS:

The files in the computer come from various sources, there will be hundreds or even thousands of
files in the computer, which can make it difficult to locate specific files.

The names of all the files created in a disk are stored in its directory. Directory is just like a file
folder, which contain all the logically related files. DOS files are organized in a hierarchical or an
inverted tree-like structure. The general analogy is with a file cabinet containing a number of
drawers, which in turn may contain folders. The content of these folders is the needed information.

The file cabinet here is the ROOT DIRECTORY, the drawer is INDIVIDUAL DIRECTORY,
the folders are SUBDIRECTORY and the information in these folders may in turn be classified
as FILES.

Otherwise, the large number of files that get created for various purposes in a disk can make the
directory huge and difficult to view and manage. Therefore, DOS enables the user to organize
the files in a disk into directories and sub-directories in a hierarchical structure.

Using path to specify the location of files

A path is the route that leads from the root directory of a drive to the file you wanttouse.  For
example, to access the NOS.LET file in the LETTER subdirectory of NOS directory, DOS
must go from the ROOT (V) directory through the NOS directory to the LETTER directory, as
shown in the following figure:

To specify the same path at the command prompt, you would type it as shown in the following
illustration: C:\NOS\LETTER\NOS.LET

DIR COMMAND

The DIR command gives the list of is there on the disk that is mounted on the active drive.

\
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Syntax: C:\>> DIR A:\> DIR
CHANGINGADIRECTORY

Syntax: A :\> CHDIR {path} ora:\> CD {path}
MAKING OR CREATING DIRECTORY

As the number of files increases in a disk, a need is felt to organize them in a meaningful way by
creating sub-directories to store a group of logically related/similar files.

To create a directory, DOS provides the MKDIR (Make Directory) or MD command.
Syntax: A:>MKDIR [drive:] {pathname} or A:\>MD [drive:] {pathname}
DELETINGADIRECTORY

You may want to delete or remove a directory to simplify your directory structure. DOS provides
RD (Remove Directory) to delete a directory.

Example: A:> RD\ACCT\SALARY
Removes the SALARY sub-directory in ACCT directory.
COPYING FILES

To copy a file, DOS provides ‘COPY’ command. When you use ‘copy’ command, you must
use the following two parameters; the location and the name of the file you want to copy, or
the source; and the location and the file name to which you want to copy the file or the target
(destination). You separate the source and the destination or target with a space. The syntax of
the ‘COPY’ command is

COPY {source} {destination} or COPY [drive:] [path] [filename] [drive:] [path] [filename]

RENAMING FILES

To rename a file, DOS provides REN command.
Example: REN NOS.DOC NOS.MEM
DELETING FILES

This section explains how to delete or remove a file that is no longer required in the disk. DOS
provides DEL command, which means to delete.

\
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Syntax: DEL {drive:} {path} {filename}
PRINTINGAFILE

The PRINT command of DOS works more or less like TYPE command, but at the same time,
it enables the content of a text file to be printed on a paper.

Syntax: A:\>PRINT [drive:] {path} {filename}

UNIX Operating System

The UNIX system has been around for a long time, and many people may remember

itas
it existed in the previous decades. Many IT professionals who encountered UNIX systems in

the past found it uncompromising. While its power was impressive, its command-line interface
required technical competence, its syntax was not intuitive, and its interface was unfriendly.

Moreover, in the UNIX system’s early days, security was virtually nonexistent.
Subsequently, the UNIX system became the first operating system to suffer attacks mounted
over the nascent Internet. As the UNIX system matured, however, the organization of security
shifted from centralized to distributed authentication and authorization systems and Unix was
well powered with all security standards.

of the main UNIX commands

\
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Commands” Description Table | Options
| -a ||Disp1ays all files, including hidden files |
| -1 ||Disp1ays a detailed listing |
| -R ||Displays the files recursively (i.e. in the sub-directories) |

) | -d ||Displays only the directories and not their content |
Is 111§ts the content of a | S ||SOI"[ by size |
rectory

| -t ||Sor‘c by the last modification date |
| -t ||Sort by version |
| -X ||S011 by alphabetical order of the extension |
| -r ||Sort in reverse order |
| cd ||Return to the user's directory |

cd change directory | cd - ||Return to the previous directory |
| cd .. ||Return to the parent directory |

midie G ey

-f  Force the deletion
rmdir Deletes a directory » Recursive delete (i.e. in the directory and its
subdirectories)

cp ||Copy a file ||copy, Xcopy

mv ||move file ||move

m delete the file -f  Force t?le deletion

-R  Recursive delete
"Print working directory"

pwd Displays the full current directory path of the work in progress.

passwd ||changes the user password

cat ||C0ncatenates two files and displays the result on the standard output.

file displays the presumed type of the specified file

man help for the requested command

apropos

lpr ||prints the requested file

chmod ||changes the attribute of a file

clear ||Clears the lines displayed on the terminal

finger, who ||1ist of users online

traceroute ||traces the path between the local machine and the target machine

S 7,
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Linux Operating System

redhat Linux

Linux is an Operating system that was initially created as a hobby by a young student, Linus
Torvalds, at the University of Helsinki in Finland.

Apart from the fact that its freely distributed, Linux’s functionality, adaptability and robustness,
has made it the main alternative for proprietary Unix and Microsoft operating systems.

Basic Linux Commands

mkdir-make directories

Directories in Linux can be created using mkdir command. The command can be followed with
the names of the directories to be created. To create a directory named cities, type the following
command and press Enter key.

mkdir [OPTION] DIRECTORY
mkdir cities
You can create multiple directories with one mkdir command.
mkdir cities talukas villages
cd - change directories
Use cd to change directories. Type cd followed by the name of a directory to access that directory.
Keep in mind that you are always in a directory and can navigate to directories hierarchically
above or below.
cd cities
To again come back to home directory
cd..
In above command double dot (..) stands for the parent directory. Note that there should be one
space between cd command and double dot.
mv- Renaming files and /or moving files
The mv command can be used for renaming a file or directory and it can also be used to move a
file or group of files to a different directory.
_mv about cities talukas

\S
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mv Ahmedabad amdavad
pwd — Checking your present working directory
Once you are logged in you can move around from one directory to another, but at any point of
time, you will be located only in one directory. This directory is known as current directory. To
know your current working directory, type pwd command and current working directory will be
displayed.
pwd
rmdir - Remove an existing directory
The rmdir command is used to remove a directory. To remove villages directory type the following
command.
rmdir villages
rm— Removing a files
The rm command is used to delete one or more files.
rmabout_cities
chmod - change file access permissions
chmod [-r] permissions filenames
As an owner of a file, you can change the permissions of a file using chmod command.
cp - Copy files
cp myfile yourfile
Copy the files “myfile to the file “yourfile in the current working directory. This command will
create the file “yourfile ifit doesn’texist. It will normally overwrite it without warning if it exists.
cp myfile yourfile
more - Allows file contents or piped output to be sent to the screen one page at a time
more cities.txt
wc — Counting lines, words and characters in a file
cal - Prints a calendar for the specified month of'the specified year or entire year.
clear - Clears the terminal screen.
man — Linux offers an online help facility which can be accessed using the man command.
Date — you can display current system date with the date command.

/
.y

Windows

Professional
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Windows XP is an operating system produced by Microsoft for use on personal computers,
including home and business desktops, laptops, and media centers. It was released in 2001. The
name “XP is short for “eXPerience.

What are the advantages of Windows XP?

There are many advantages of windows XP a few of them are given below

1. It supports most of the hardware without need of external drivers.

2. It offers good GUI as compared to older versions.

3. It supports wireless networking

4. Many applications are developed for windows only and on other OS they do not work
5. Windows XP offers universal plug and play features

6. The availability of this is very high.

7. It offers universal solution to OS needs and there are no compatibility issues in this case.
8. Windows XP is colorful and user friendly as compared to other OS in market.

Starting with Windows XP:

Windows XP will test all the hardware components, load graphics files, font files etc. on your
computer. This is called booting.

Professional

Fig : 2.2 Introductory Screen of MS-Windows

Your desktop might show a different set of icons and background depending on the setup of your
computer but some items are common for all users.
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A typical desktop contains one or more icons and a taskbar :

e Aniconisa pretty small graphical picture. It represents elements of Windows Operating
System like files, folders, programs, commands etc.

e The taskbar is a long horizontal bar with buttons and icons. It usually appears at the
bottom of the screen. On the extreme left of a task bar is a start button, which helps to
start programs in Windows XP. On the extreme right is a Notification area which contains
very small icons for programs, along with a clock.

Windows and its Components :

¥ My Computer

Pl it Gew Fewoes Todk  Hep

3 O e Fodes  [T27]-

Files Stoved en This Compater

)' Kt Jenfs Docunenks

| Hard Dick Drives

g oSk g New Ve (E)
" Devices with Removable Storage

H S e 1] \‘é o oe ()

| Rewatieosk()

Fig : 2.3 My Computer- Screen

By double clicking the My Computer icon in the desktop, opens up the window which contains
the files, folders, drive or icon representing the shortcuts to them gets opened up in a new window.

Window Operations:

Windows operating system enables you to control the size and the position of the window by
performing certain operations like moving, resizing, minimizing, maximizing and close.

¢ Minimize: Clicking minimize button reduces the window to a button on the taskbar.
e Maximize: This button is used to enlarge the window to its full size.

e Restore: This button restores the window to its original size.
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e (Close: This button helps in closing of any opened window.

Windows XP allows you to see windows on your desktop together at the same time and that too
in well arranged manner, that you can easily manage multiple windows at a same time. It can be
achieved by three ways :

e (Cascade Windows: Adjusting all the windows such that they overlap, with their upper
left corners cascading from the upper left corner of the screen, down to the right.

e Tile Windows Horizontally: Adjusting all the windows one after another without any
overlap by extending it to its full width of the screen.

e Tile Windows Vertically: Adjusting all the windows one after another without any overlap
by extending it to its full height of the screen.

Arranging Icons on the Desktop:

The Icons in the desktop can be rearranged according to our liking.this can be done by two
following steps:

e Rightclick on the free space of the Desktop and you will find a pull down menu.

e Move the mouse pointer on ‘Arrange Icons by’ option in pull down menu and windows
displays a submenu.

The Arrange icons submenu has four options-Name, type, Size, Modified and auto arrange.
Creating Desktop shortcuts:

Creating a Shortcut to a Program or File

To create a shortcut on the desktop to a program or file, there are two possible methods to
choose from.

Method 1
1. Right-click an open area on the desktop, point to New, and then click Shortcut.
2. Click Browse.

3. Locate the program or file to which you want to create a shortcut, click the program or
file, click Open, and then click Next.

4. Type aname for the shortcut. If a Finish button appears at the bottom of the dialog box,
click it. If a Next button appears at the bottom of the dialog box, click it, click the icon
you want to use for the shortcut, and then click Finish.

\
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Method 2

1.

4.

Click Start, point to Programs, and then right-click the program you want to create the
shortcut to.

Click Create Shortcut.

The shortcut is now at the end of the Programs list. For example, if you created a shortcut
to Microsoft Word, to find that program, click Start, and then point to Programs. You
will find the shortcut, named “Microsoft Word (2) (without the quotation marks), at the
bottom of the Program list.

Drag the shortcut to the Desktop.

Creating a Shortcut to a Printer or Dial-Up Networking Connection

To create a shortcut on the desktop to a printer or Dial-Up Networking connection, follow these

steps:

1.

To create a shortcut to a printer, click Start, point to Settings, and then click Printers.
To create a shortcut to a Dial-Up Networking connection, click Start, point to Programs,
point to Accessories, and then click Dial-Up Networking.

Right-click the printer or Dial-Up Networking connection icon, drag it to an open area
on the desktop, and then click Create Shortcut(s) Here.

Creating Shortcuts to Other Objects

To create a shortcut on the desktop to other objects (such as a folder or computer), follow these

steps:

1.

2.
3.

Use My Computer or Windows Explorer to locate the object to which you want to
create a shortcut.

Right-click the object, and then click Create Shortcut.

Drag the new shortcut to an open area on the desktop.

Using Start menu:

Fig : 2.4 Start Menu-Screen
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When you click the Start button on the taskbar, Start menu appears. You can also display the
Start menu by pressing the WINDOWS key near alt button on you can press CTRL-ESC. The
Start menu contains everything you need to begin using windows. The start button helps to Start
programs, open files, Customize your system using Control Panel, get help on various topics of
windows XP using Help and Support, search for items on the computer or on the internet by
using Search and much more can be done with the help of Start button. The start button has a
push up menu that provides a list of options such as Log Off, Turn Off Computer, windows
Media player, My documents, My Pictures, my Music, Control panel, search, Run etc.

Using Control Panel:

= D W m @ B £

Koty Yook LhodeA Pt e Mutodesk Pt
Mo Vrar

v @ e H 9 = O

Wk Corcemons  Netved SsLDWIG  hans sraNadwy Fows Cpteee
Coters

2 @ 9 & ¥ 4

Fig : 2.5 Control Panel Window

The control Panel is used to control the computer system. Using it, you can control the
behavior of your mouse, keyboard, display, modem, printers etc. It also provides options to
customize the appearance and settings of computer, add or remove new programs, set up
network connections, create user accounts etc.

Let us have a look at a Control Panel
e Open Start menu by clicking the Start button from the task bar.
e Select control panel and click it.

To change the computer date or time:

>
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[ Double-click the Date and Time icon in the Control Panel Window and you will find date D]d
time Properties dialogue box

P Now you can make changes in the month, date, year and time as required.

P After adjusting the date ad time click OK button to save the settings or press CANCEL buttpn
to continue the previous date and time.

To ¢hange the background of the Desktop;
P Click the Desktop of the Display Properties dialog box.

P Select new backgrou8nds from the list of backgrounds provided and you will see its previewjin
the monitor shaped box on the dialogue window

P By clicking Position drop down list, where the three options Center Tile and Stretch are availabje.
You can try each of them to give different effects to chosen background.

p Click Apply button after selecting the background and you will find that background of ydur
Desktop has been changed then click OK button to conform it.

Logging Off and Quitting Windows XP:

As gpon as you finish working with Windows XP, you must switch off the computer and proper steps argjto
be fgllowed to completely shut down the computer. If you properly shut down the computer, then Operatihg
systgm first saves any Windows settings that you have changed and writes any information that is currei]1
storgd in memory to hard disk. If you turn off computer without shutting it down properly, you have risk
losirjg information.

Cligk the Start button. In a push up menu you will find two options Log Off and Turn Off computer.
Logoft:

Cligk Log off and you will get Log off Windows dialog box

7
S
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. Fig:2.6 Log Off Window - Screen

e LogOffisused when you don’t want to shut down the computer but closwe current
user’s session. Selecting Log Off will display Welcome screen with a login dialog box
asking to enter user name and password.

e Switching user will also allow you to switch to a different user. For example you are
typing adocument and you need to take some information from other login then you can
do this by Switch user.

Turn Off Computer:
By clicking turn off option from start menu Turn Off dialogue box will appear:

Turn off computer - y

-

Fig : 27 Turn Off Window — Screen
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You will be provided with three options:

Stand By: If you choose this option, everything in the computer memory is saved on the hard
disk. When you start the computer again all programs will be restored.

Turn off: Choosing this option will shut down Windows XP and within few seconds the monitor
will power off automatically and you can switch off your PC.

Restart: Choosing this option will shut down and start computer again within few seconds.
Login dialog box will appear.

\
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3. Installing New software

Introduction:

In order to use any software in the computer, it is necessary to install them. In this chapter
we would be looking as how to install new software, how to install operating system and
how to uninstall them. Before installing any new software or Operating system it must be
scanned for viruses, just to avoid viruses entering into our system.

e Some software can be installed easily by copying them, and pasting them in the
destination. Example: WordPress

e Some requires few installation procedures to install them and use them effectively.
Example: Gaming softwares, ASP.Net.

e Nowadays we can also download softwares freely from internet and install them in
our computer system example: Flash, Google talk, but additional attentions of virus
preventions are required in such case.

This chapter also explains about Uninstallation of software, you may get annoyed about why
we should uninstall softwares that are already installed? But, we require Uninstallation if the
software is attacked by some electronic infection (to avoid virus replication) or when the
software is not installed properly with all its components, so we require them to uninstall and
then install in a correct manner. So this chapter makes you familiar with all the concepts of
installing and uninstalling new software and operating system and this also will give you
knowledge about compressing files, how to create compressed files and how to unpack the
compressed files.

Install Shield:

Install Shield is primarily used for installation software for Microsoft Windows desktop and
server platforms, but it can also be used to manage software applications and packages on
avariety of handheld and mobile devices.

Installation:

Installation of a program is the act of putting the program onto a computer system so that it
can be executed.

Some software can be executed by simply copying it to computer and executing it with no
further ado; no installation procedure as such is required. Other programs are supplied in a
form not suitable for immediate execution, and require an installation procedure. Installation
may include unpacking of files supplied in a compressed form, copying them to suitable
locations, tailoring the software to suit the hardware and the user’s preferences, providing,
information about the program to the operating system, and so on. The installer may test for
system suitability and available mass storage space.

\
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Installation of Operating System:

Installation of MS-DOS:

MS-DOS is an operating system. If your computer already has an operating system such as
Windows XP, performing the below steps will erase it as well as any other programs currently
installed on the computer.
1. Insertthe first MS-DOS installation diskette into the computer and reboot it or turn it on.
If you do not have the MS-DOS diskettes you will be unable to install MS- DOS.
2. Ifthe MS-DOS setup screen appears when the computer starts press the F3 key two or
more times to exit from the setup.

Once at the A:\>MS-DOS prompt type fdisk and press enter.

4. Inthe fdisk screen delete any current partitions existing on the computer and then recreate
the partitions. Additional information about fdisk, including a fdisk simulation can be
found on our fdisk command page.

5. Once anew partition has been created exit out of fdisk and get back to the A:\> prompt.

At the prompt type format and press enter.

7. Once the hard disk drive has been formatted reboot the computer with the diskette still
in the drive and once back at the setup screen run through the setup of MS-DOS on the
computer.

(8]

a

Following the above steps will install MS-DOS in the computer. If successfully installed the
computer should be able to get to a MS-DOS prompt with no diskettes in the computer.

Install Windows XP:

This procedure demonstrates how to install Windows XP Professional. The procedure to install
Windows XP home edition is very similar to the professional edition. Since Windows XP Pro is
more advanced operating system, it will be used to demonstrate the installation procedure.

The best way to install Windows XP is to do a clean install. It

is not difficult to perform a clean installation. Before performing the installation check whether
Windows XP Compatibility List to ensure that your hardware is supported by XP. All versions of
Windows XP CD are bootable. In order to boot from CD/DVD-ROM setting of the boot
sequence is needed. Look for the boot sequence under BIOS setup and make sure that the first
boot device is set to CD/DVD-ROM. Then perform the following steps to install Windows XP:

\
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Step 1 - Start the PC and place Windows XP CD in CD/DVD-ROM drive. Then the PC should
automatically detect the CD and a message will be displayed saying “Press any key to boot from
CD . Soon as computer starts booting from the CD you will get the screen as shown on the right
side.

Fig : 3.1
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Step 2 - At this stage it is necessary to press F6 in order to install a third party Raid or SCSI
driver. If you are using an IDE Hard Drive then no need to press F6. If you are using a
Fig : 3.2

SCSI or SATA Hard drive then press F6 otherwise

Windows will not detect Hard Drive during the installation. Make sure that you have the
Raid drivers on a floppy disk. Normally the drivers are supplied on a CD which you can
copy to a floppy disk ready to be installed. If you are not sure how to do this then please
read your motherboard manuals for more information.

Step 3 - Press S to install additional device.
Fig:3.3

Step 4 — Then insert the floppy disk with the Raid or SCSI drivers, then press enter.

\
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Fig:3.4

Step 5 —alist of Raid drivers will be displayed for the HDD. Select the correct driver for the
device and press enter.

Fig : 3.5

Step 6 — Then a Windows XP Professional Setup screen will be displayed, there you have the
option to do anew Windows install, Repair previous install or quit. Since we are doing a new
install we just press Enter to continue.

Fig : 3.6

Step 7 - End User Licensing Agreement will then be presented. Press F8 to accept and continue
Fig 3.7

Step 8 - This step is very important. Here it is needed to create the partition where Windows
will be installed. If you have a brand new unformatted drive you will get a screen similar to
below. In our case the drive size is §190MB. We can choose to install Windows in this drive
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without creating a partition, hence use the entire size of the drive. If you wish to do this you
can just press enter and Windows will automatically partition and format the drive as one large
drive.
However for this demonstration as an example two partitions
Fig : 3.8
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are created. The first partition will be 6000MB (C: drive) and second partition would be 2180MB
(E: drive). By creating two partitions, we can use one partition to store Windows and Applications
and the other to store the personal data. So in the future if anything goes wrong with Windows
install such as virus or spyware we can re-install Windows on C: drive and our data on E: drive
will not be affected. In the same way different partition size can be selected as per the size of the
drive. For example if you have 500GB hard drive you can have two partitions of 250GB each.
Press C to create a partition.

Step 9 - Windows will show the total size of the hard drive and ask you how much you want to
allocate for the partition you are about to create. [ will choose 6000MB. You will then get the
screen below. Notice it shows C: Partition 1 followed by the size 6000 MB. This indicates the
partition has been created. We still have an unpartitioned space of 2189MB. Next highlight the
unpartitioned space by pressing down the arrow key. Then press C to create another partition.
You will see the total space available for the new partition. Just choose all the space left over, in
our case 2180MB.

Fig : 3.9

Step 10 - Now you will see both partitions listed. Partition 1 (C: Drive) 6000MB and
Partition 2 (E: Drive) 2180MB. You will also have 8MB of unpartitioned space. Don’t worry
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about that. Just leave it as it is. Windows normally has some unpartitioned space. You might
wonder what happened to D: drive. Windows has automatically allocated D: drive to CD/
DVD-ROM.Select Partition 1 (C: Drive) and press Enter.

Fg310
Step 11 - Choose format the partition using NTFS file system. This is the recommended file
system. If the hard drive has been formatted before then you can choose quick NTFS format.
We chose NTFS because it offers many security features, supports larger drive size, and bigger
size files.

FFig: 3.11
Step 12 - Windows will now start formatting drive C: and start copying setup files as shown on
the two images (Step12 (a), Step12 (b)) below:

Fig : 3.12 (a) Fig : 3.12 (b)
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Step 13 - After the setup has completed copying the files the computer will restart. Leave the
XP CD in the drive but this time DO NOT press any key when the message “Press any key to
boot from CD is displayed. In few seconds setup will continue. Windows XP Setup wizard
L\Wﬂl guide through the setup process of gathering information about the computer.
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Fig : 3.14

Step 15 - Type in your name and organization.
Fig : 3.15
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Step 16 - Enter your product key.

Step 17 - Name the computer, and enter an Administrator password. Don’t forget to write
down your Administrator password.
F Fig:3.17

Fig : 3.18
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Step 19 - For the network setting choose typical and press next.
Fig : 3.19

Step 20 - Choose workgroup or domain name. If you are not a member of a domain then leave
the default settings and press next. Windows will restart again and adjust the display.
Fig : 3.20
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Step 21 - Finally Windows will start and present you with a Welcome screen. Click next to
continue.
Fig:3.21
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Step 22 - Choose ‘help protect my PC by turning on automatic updates now’ and press next.
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Fig : 3.22
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Step 23 - Will this computer connect to the internet directly, or through a network? If you are
connected to a router or LAN then choose: ‘Yes, this computer will connect through a local
area network or home network’.

If you have dial up modem choose: ‘No, this computer will connect directly to the internet’.
Then click next.

Fig : 3.23
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Step 24 - Ready to activate Windows? Choose yes if you wish to active Windows over the
internet now. Choose no
if you want to activate Windows at a later stage.

Fig:3.24
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Step 25 - Add users that will sign on to this computer and click next.
Fig : 3.25
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Step 26 - You will get a Thank you screen to confirm setup is complete. Click finish.
Fig :3.26

Step 27 - Log in, to your PC for the first time.
Fig : 3.27

Step 28 - You now need to check the device manager to confirm that all the drivers have been
loaded or if there are any conflicts. From the start menu select Start -> Settings -> Control
Panel. Click on the System icon and then from the System Properties window select the
Hardware tab, then click on Device Manager.

>
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If there are any yellow exclamation mark “! next to any of the listed device, it means that no
drivers or incorrect drivers has been loaded for that device. In our case we have a Video Controller
(VGA card) which has no drivers installed.

N ww s | pta Wi

Fig : 3.28
Your hardware should come with manufacturer supplied drivers. You need to install these drivers
using the automatic setup program provided by the manufacturer or you need to manually install
these drivers. If you do not have the drivers, check the manufacturer’s website to download
them.

To install a driver manually use the following procedure:
(a) From the device manager double click on the device containing the exclamation mark.
(b) This would open a device properties window.

Fig : 3.29 Driver Installation - Screen
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(c) Click on the Driver tab.

(d) Click Update Driver button. The Wizard for updating device driver pops up as shown
below:
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You now get two options. The first option provides an automatic search for the required driver.
The second option allows you to specify the location of the driver. If you don’t know the location
of the driver chooses the automatic search which would find the required driver from the
manufacturer supplied CD or Floppy disk. Windows would install the required driver and may
ask you to restart the system for the changes to take affect. Use this procedure to install drivers
for all the devices that contain an exclamation mark. Windows is completely setup when there
are no more exclamation marks in the device manager.

Uninstallation - To remove an application from a computer

Uninstalling removes all files that were added to the computer when the application was initially
installed. In addition, it might also remove files that were subsequently generated by the application.

Anuninstaller, also called a deinstaller, is a computer program which is designed to remove all or
parts of a specific other program or application. It is the opposite of an installer, uninstall, when
referring to software, is the act of removing program files and folders from your hard disk and
removing related data from your registry so the software is no longer available. When referring to
adevice, it is the act of removing the corresponding device drivers from your hard disk and
physically removing the device from your computer.

Zip files:

Zip files are single files that contain one or more compressed files. Zip files make it easy to keep
related files together and make transporting, e-mailing, downloading and a storing data and
software faster and more efficient. The Zip format is the most popular compression format used
in the windows environment, and WinZip is the most popular compression utility.

Uses of Zip files:

Zip files compress data and therefore save time and space and make downloading software and
transferring e-mail attachments faster. Zip files will also assist you in:
¢ Distributing files on the Internet: Only one download is required to obtain all related
files, and file transfer is quicker because the archived files are compressed.
e Sending a group of related files to an associate: When you distribute a collection of
files as a single Zip file, you benefit from the file grouping as well as compression.
e Saving disk space: If you have large that are important but seldom used as large data
files, simply compress the files into a Zip file and then unzip (or “extract ) them only when
needed.
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Where does WinZip fit in?

To store in zip file, or to access the files in a Zip file, you need a compression utility such as
WinZip. WinZip makes it easy for Windows users to work Zip files. WinZip features a standard
Windows point-and-click drag-and-drop interface for viewing, running, extracting, adding,

deleting, and testing files in Zip files. Occasional and first users can choose to use the intuitive
WinZip Wizard.
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Software Installation:

Installing WinZip Software:
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Fig : 3.30 Winzip File Download — Screen
To install WinZip software go to www.winzip.com There options for downloading the software
will be given after clicking the download button to down load the software

. After clicking on the down load button Internet Explorer will give you a security warning
message asking “Do you want to run or save this file select RUN. After the file is
downloaded the Explorer will again give a security warning message stating that “The
publisher could not be verified. Are you sure you want to run this
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Fig : 3.31 Security Warning - Screen
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Installation.

e Then WinZip InstallShield wizard will appear window will appear in that click the next
button to install WinZip.

Fig : 3.32 Winzip InstallShield
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After the complete installation of the software press Finish button to exit.
Fig : 3.33 Winzip InstallShile

Opening Zip files:

After you have installed WinZip, you can open a zip file by double clicking it in your e-mail
attachment or explorer or by starting WinZip and choosing “Unzip or install from an existing Zip
file inthe WinZip Wizard.

To create a Zip file:

To can create a new Zip file, open WinZip Wizard mode. You will be asked “what do you want
todo? simply select “Create anew Zip file and click next. The WinZip Wizard will guide you
through the entire process.

Creating Zip file:

Select any folder or file which you require to compress.

Right click on the folder and select WinZip option from the pop up menu and you will be
displayed with submenus in that select Add to Zip files.

Then WinZip wizard will be opened which displays a Add Dialog box.

The Add dialog box contains the file name and the file path in the Add to Archive message
box.

Click add button in order to Zip the entire folder.

Then the WinZip wizard starts processing the file zipping.

Then the file will be displayed in a zipped form.

The Zipped files can be unzipped by right clicking them and selecting explores option from the
pop up options.

\
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4 .Viruses

What are they?

The computer virus is something of an information age marvel. A properly engineered virus can
have a devastating effect, disrupting productivity and can put important data in damage. Computer
virus are called viruses because they share some of the common traits

of biological viruses. A computer virus passes from computer to computer like a biological virus
that passes from person to person.

Types of viruses

The different forms of electronic infection are:
e Viruses —Avirus is a small piece of software that piggybacks on real programs.
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Fig : 4.1 Virus

e Email viruses —An email virus travels as an attachment to email messages and usually
replicates itself by automatically mailing itself to dozens of people in the victim’s email
address book.

Fig : 4.2 Email Viruses

ng Antilir
he Enter key to quit.

Boot sector virus — It infects the boot record on the hard disk and the floppy disk which is
used to start the computer. When the computer is turned on or restarted the virus is
automatically executed and starts affecting the computer.

Fig : 4.3 Boot Sector Virus
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e Macro virus — It is macro or script that attaches itself to a file or template. When the
file is loaded the instructions of the macro or script is executed automatically.
Fig : 4.4 Macro Virus

e Trojan horses- a Trojan horse is simply a computer program. The program claims to
do one thing (it may claim to be a game) but instead does damage when you run it (it may
erase your hard disk) Trojan horses have no way to replicate automatically.

Fig : 4.5 Trojan Horses

e  Worms—A worm is software that uses computer networks and security holes to replicate
itself. A copy of the worm scans the network for another machine that has a specific hole.
It copies itself to the new machine using the security hole, and then starts replicating from
there, as well.

Causes of Viruses:

The first factor for the virus spread was the spread of personal computers (PCs). During the
1980s, real computers started to spread to business and homes because of the popularity of
IBM PC.

The second factor was the use of computer bulletin boards. People could dial up a bulletin
board with a modem and down load programs of all types. Bulletin boards led to the precursor
of the virus known as the Trojan horse. A Trojan horse is a program with a cool-sounding name
and description. So you down load it, when you run the program, however, it does something
uncool system. Trojan horses only hit a small number of people because they are quickly
discovered, the injected programs are removed and word of the danger spreads among users.
The Third factor that led to creation of viruses was the floppy disk. In the 1980s, programs were
small, and you could fit them onto a floppy disk, so when you turned on your machine it would
load Operating System and everything else from the floppy disk. So if floppy disk is infected it
affects the total components of the computer.

Early viruses were pieces of codes attached to common program like a popular game or a
popular word processor. A person might download an infected game from a bulletin board and
run it. A virus like this is a small piece of code embedded in a larger program. When the user runs
L the large program, the virus loads itself into memory and looks around to see if'it can find any
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other programs on disk. Ifit can find one, it modifies the program to add the virus’s code into the
program. Then the virus launches the “real program . The user really has no idea that the virus
ever ran. Unfortunately, the virus has now reproduced itself, so two programs, are infected. The
next time the user launches either of those programs, they infect other programs, and the cycle
continues.

If one of the infected programs is given to another person on a floppy disk, or ifit is uploaded to
a bulletin board, then other programs also get infected.
This is how the Virus Spreads.

Virus evolution:

Viruses and worms get a lot of publicity, but they aren’t the only threats to your computer’s
health. Malware is just another name for software that has an evil intent. Here are some common
types of malware and what they might do to your infected computer:

SPYWARE...
«WHAT ON EARTH IS
THAT ?

e Ad ware puts ads on your screen
e Spy ware collects personal information about you, like your passwords or other
information you type into you computer.

e Malware it’s a program, file or code that performs malicious actions on the target
system without the users permission

e Hijackers turn your machine into a Zombie computer.

e Dialers force your computers to make phone calls and run up your phone bills.

Guarding against viruses:

Microsoft applications have a feature called Macro Viruses protection built into them to prevent
this sort of Virus. With Macro Virus protection turned on, the auto execute feature is disabled.
So when a document tries to auto-execute viral code, a dialog box pops up warning the user.
Unfortunately, many people don’t know what macros or macro viruses are, so they ignore the
pop up, so the virus runs anyway.
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You can protect yourself against viruses with few simple steps:

e Ifyouare truly worried about traditional viruses, you should be running a more secure
operating system like UNIX. You never hear about viruses on these operating systems
because the security features keep viruses away from your hard disk.

e Ifyou are using an unsecured operating system, then buying virus protection software is
anice safeguard.

e Ifyousimplyavoid programs from unknown sources (like the Internet), and instead stick
with commercial software purchased on CDs, you eliminate almost all of the risk from
traditional viruses.

¢ You should make sure that Macro Virus Protection is enabled in all Microsoft application
as mentioned previously.

e Nearly every program you buy today comes on a compact disc. Compact discs (CDs)
cannot be modified, and that makes viral infection of a CD unlikely, unless the manufacturer
permits a virus to be burned onto the CD during production. The programs are so big
that the only easy way to move them around is to buy the CD.

¢ Youshould never double —click on an e-mail attachment that contains an executable.
Attachments that come in as Word files (.Docs), spreadsheets (.XLS), images (.GIF (),
etc., are data files and they can do no damages. A file with an extension like EXE, COM
or VBS is an executable, and an executable can do any sort of damages it wants. The

only defense is never to run executable files that arrive via e-mail.

Antivirus Softwares:

S &

A ‘ “’

Antivirus Softwares are best remedies for preventing computers from virus attack and from
the after effects of virus attacks. Antivirus software packages also allows Demo versions
where we can use them freely for a particular time and if we are satisfied with them we can
buy the full version of it. Some antivirus are also available free of cost while some requires
payment. There are plenty of Antivirus Softwares available in market out of which very few of
them are mentioned
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Installation of Anti Virus Avast! Home Edition:

Fig : 4.6 Avast Antivirus home Setup - Screen

{® Avast! Home Edition is the free version of the well known antivirus. Here we have mentioned
the Avast Antivirus software as example for installation Avast is an extremely popular antivirus
counting over 80 million users worldwide in 2009.Before installing any antivirus, check whether
your computer is installed already with some other Antivirus, if so uninstall the antivirus that runs
on your PC and then download Avast Antivirus. It’s always recommended to download and
install the latest version. The setup file should be around 300 KB. After downloading the Software

your screen looks like Figurel.

Press “Run in Windows XP SP 3 (in Windows Vista or 7 this window will look different ) to

open the setup file.

Dpen File - Security Warning

Do you want to run this file?

Name: avast hg‘ e sebupiexe:
| Publsher ALWIL Software
Type; Application
From; €;\Documents and Settings}Administrater|Desktop

I Run l Cancel

IV Ay ash before opening this file

\While fites frcm thie Intermet can bz useful, (s file lupe <an
‘potentially hamy yatr computer. Dnly rin software fom publishers:
You tst; What's the tisk?

Fig : 4.7 Avast First Screen
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Here is the first window from the setup. Select your language ( default language is English ) and
choose “Next to start.

Fig : 4.8 Avast! Setup-Screen

You will see a window that will use your Internet Connection in order to download the necessary
files. If you are not connected to the Internet you will not be able to download them so make sure
that you are connected to the Internet and please wait until the files are being downloaded ( it
could take a couple of seconds or minutes or even more depending on your computer performance
and your Internet Connection ).

Fig : 4.9Avast!Downloading-Screen

If the files were successfully downloaded you should see the following window that says :
“Welcome to the avast! Setup program. This program will install avast! on your computer.
and it’s also recommended to exit all Windows programs before running this setup program.
Click on “Next button to continue.
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Fig : 4.10 Avast! Setup-Screen

Now you will see a “Read Me window that will display the antivirus version and that will tell
you what are the system requirements for a lot of Windows versions Click on the “Next button
to continue if you are sure that your computer has the necessary resources.

Fig : 4.11 Avast! Read me-Screen

The following is the “Licence Agreement window and you need to read the entire licence to
make sure that you agree with all terms listed there. If you agree with this licence agreement
choose the radio button called “7 agree and press on the “Next button.
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Fig : 4.12 Avast ! License Agreement - Screen

This window is called “Destination and you need to enter the path to where this antivirus will
install. you do not need to modify the default destination unless you want another place for the
installation. As you can see the default installation folder will be in “C:\Program Files\Alwil
Software\Avast4 .

Fig : 4.13 Avast ! Destination Directory-Screen
As you can see we are now at a window called “Configuration . This is the window that will
allow us to make a “Typical installation, a “Minimal anda “Custom installation. If you
need to change anything else ( this is for advanced users ) you need to choose “Custom . If
there is no change press 7Typical and click on the “Next button to continue.
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Fig : 4.14 Avast!Configuration -Screen

Now we have another confirmation window for the previous one. It’s called “Installation
information and says that the setup will install the following components:

Ifeverything is OK, choose the “Next button. If you need to change something press the “Back
button and go back and change anything you want but you will need to choose “Custom type.

Fig : 4.15 Avast ! Installation I nformation- Screen
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Please be patient as the antivirus will install the necessary files on your computer. When it will
finish it will appear a small window that will ask you : “Do you wish to schedule a boot-time
antivirus scan of your local hard drives? The scan will be performed after your computer
is restarted. choose “Yes ifyouhave some time for a scan of your hard drives. If you’re in a
hurry and you are sure that your computer is clean you can choose “No . For example let us
choose “Yes”

Fig : 4.16 Avast ! Installation Progress -Screen
Finally we can see a message in this window that says “Setup finished and we are almost
ready but wait, we need to restart the computer. Choose “Restart and make sure to save your
work since your computer will restart right away. Click on “Finish button.

Fig : 4.17 Avast ! Setup Finished - Screen

If you chosed in the previous window to schedule a boot-time antivirus scan of your local hard
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drives when your PC will start you will see a blue window like the one in the following picture.
Let the screen to scan all of your hard drives. At the end it will display the report.

Fig : 4.18 Avast ! scaning —Screen
Supposing that the scan has finished when your desktop will start you should see a notification
window that tells you more things about Avast Antivirus.
And there are two links, the first one will take you to the registration page and the second one
will give you more information about the professional edition. Since this article is focused only on
the installation skip the registration process for now ( in maximum 60 days

Fig : 4.19 Avast ! Welcome-Screen
you will need to register this antivirus ) and click on “OK button to close this window.
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For the first time, a small blue icon will appear on our launch bar and says something like that:
“avast!Resident Protection - The blue avast! icon in the notification are of your desktop is
used to report the status of avast! resident protection. When crossed-out, the protection is
inactive. When gray, it is

Fig : 4.20 Avast ! Resident Protection -Screen

waiting for something. And finally when blue, you are protected. 1t will appear a second
informative icon and it will close by itself but you can also close them manually.

Avast Antivirus Free has been installed on your computer. How to access the “control center
called “On-Access Protection Control and how to “Start avast! Antivirus . Let’s access
the “On-Access Protection Control , to do so do a right-click with your mouse on the blue,
avast icon located on the right side of your launch bar and a small window will open. From there
as choose the first option called “On-Access Protection Control .

Fig : 4.21 Avast ! Access - Screen

\
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A new window will open called “Resident Protection . From here you can adjust the level of
your protection from “Normal to “High ,italso allows youto “Pause the resident protection
and also to “Terminate . Down this window is a small button called “Details... if'youwill click
on this button this window will become larger and it will show you more options to choose from.

Fig : 4.22 Avast ! Resident Protection -Screen

Let’s repeat the same action: do a right-click with your mouse on the blue, avast icon located on
the right side of your launch bar and a small window will open. From there choose the second
option called “Start avast! Antivirus like in the following picture : And here it is, the simple and
intuitive Avast Antivirus interface.

Fig : 4.23 Avast ! Antivirus Start-Screen

\
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5. The Internet

Whatitis?

The Internet, sometimes called simply “the Net, is a worldwide system of computer networks-
anetwork of networks in which users at any one computer can, if they have permission, get
information from any other computer (and sometimes talk directly to users at other computers).
Today, the Internet is a public, cooperative, and self-sustaining facility accessible to hundreds of
millions of people worldwide. The internet can be easily explained as a group of computers
connected together through a network. Physically, the Internet uses a portion of the total resources
of the currently existing public telecommunication networks. Technically, what distinguishes the
Internet is its use of a set of protocols called TCP/IP (for Transmission Control Protocol/ Internet
Protocol).

What it can provide (mainly WORLD WIDE WEB)

The most widely used part of the internet is the World Wide Web (WWW)), it is a way of
accessing information over the medium of the internet.

Its outstanding feature is hypertext, a method of instant cross referencing. In most Web sites,
certain words or phrases appear in text of a different color than the rest; often this text is underlined.
When you select one of these words or phrases, you will be transferred to the site or page that is
relevant to this word or phrase. Sometimes there are buttons, images, or portions of images that
are “clickable. If you move the pointer over a spot on Web site and the pointer changes into a
hand, this indicates that you can click and be transferred to another site. The Web services,
which use HTTP (Hypertext Transfer Protocol to allow applications to communicate in order to
exchange business logic, use the Web to share information. The Web also utilizes browsers, such
as Internet Explorer or Firefox, to access Web documents called Web pages that are linked to
each other via Hyperlinks. Web documents also contain graphics, sounds, text and video.

Hypertext and navigating hypertext:

Hypertext is text displayed on a computer or other electronic device with references to other text
that reader can access immediately with the help of hyperlinks provided.

Usually this link to relevant web page can be accessed by a mouse click or keypress sequence.
Apart from running text, hypertext may contain tables, images and other presentational devices.
Hypertext is the underlying concept defining the structure of the World Wide Web, making it an
easy to use and flexible format to share information over the Internet.

URLS:

The Uniform Resource Locator (URL) is a global address of documents and other resources
available on the World Wide Web. URL is divided in two parts. One is protocol and another is
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DNS(Domain Name System).Most of the web documents can be seen in the following form.
“protocol://hostname:port/path”

Hostname is a name of domain or web server, which stores web page. Port is an access point for
getting a particular service. It is always in number form. If port number is not given, default value
is taken for particular service. On user’s machine, path shows location of webpage.

The first part of the address is called a protocol identifier and it indicates what protocol to use
and the second part is called a resource name and it specifies the IP address or the domain name
where the resource is located. The protocol identifier and the resource identifier name are separated
by a colon and two forward slashes.

Example: http://www.yahoo.com:80/intro.html

protocol web host domain port file name

How to access the Internet:

There are four ingredients needed to access the Internet (1) an ISP, (2) a modem, a web browser
and (4) an email.

The Internet Service Provider (ISP):

The access to the Internet is through an Internet service provider, who can provide you the
service of accessing internet facility in your computer. They offer you an unlimited access for a
fixed rate per month.

The most popular Internet service providers are:

ISPs having all-India licence include:

BSNL cMc RPG Infotech =l Sivenm
Communications
Sify Siti Cable Network Gateway Systems (India) gorlq Fieme Mrierms
ervices
VSNL Guj Info Petro IAIUGEs (ESFeris Astro India Networks

Communications

Primus

Reliance

Data Infosys
HCL Infinet
Bharti Infotel
BG Broad India

Trak Online Net India

Tata Teleservices
(Maharashtra)

Harthway Cable

Telecommunications India

GTL

Primenet Global

Pacific Internet India

Swiftmail Communications

Spectra Net

Comsat Max

ERNET India

Jumpp India

Tata Internet Services
In2Cable (India)

Estel Communication

Reach Network India

Gujarat Narmada Valley
Fertilizers Corporation

RailTel Corporation
L&T Finance

Tata Power Broadband

Reliance Engineering
Associates

Bharti Aquanet

i2i Enterprise

HCL Comnet Systems and
Services
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The Modem:
Depending on the kind of services you have you will need a unit of hardware called a “Modem
for internet connection. (For further details regarding Modem refer Chapterl).
Browsing the Web:
A Computer with Microsoft windows Operating system comes with a Internet Explorer web
browser by default. The Mac Operating system provides Safari as default. The users can also
choose a different browser such as Firefox (www.mozilla.org), Opera (www.opera.com) and
Google Chrome (www.Google.com) which offers additional features and are not as subject to
attack by hackers.
Sending E-Mail:
The computer by default comes with an e-mail program to send and receive mail. Windows
comes with Outlook, and the Mac comes with Mail, although many users choose Eudora or
Thunderbird, other popular clients like: Blue Mail, Gmail, rediff mail, Hotmail, mail.com,
MS Outlook, Yahoo Mail, Sify.com,
Here is an example of how to mail a person by sending a mail with an attachment.
Before sending any mail first we must create an email-id for us this email id is like the address of
the person to send and receive the email. Every email user will have a email address different
from each other. The first part of the mail ID will have name or any identifiers related to the
person and the second part will have a Special character (@ and then with the address of the mail
program that you use.
Example:

e ab 12@gmail.com

e abc 12(@yahoo.com

To create an Email account:

Gmail is web mail offered by Google that has many beneficial features for all of its users. Gmail
offers less spam, a ton of space and even mobile Gmail. You can access your email from your

7
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phone at any given time and with the large space, you never have to worry about constantly
cleaning out your inbox. You can take your time and do it when you want because you won’t run
out of room. Here are the steps to creating an email account with Gmail so you can experience it
first-hand.

Instructions

Fig : 5.1 Sign UP for gmail - Screen
Step 1: Go to Gmail’s homepage. (link at bottom) On the right side of the page, underneath
the user sign-in you will see “Sign Up For Gmail. Click on that.

Step 2: Now it’s time to create your account. You will be asked to fill in the required information
in order to create your account. Start with your first and last name.

Step 3: Choose your desired login name (email address) and click on “Check Availability to see
ifthat name is already chosen. When a name you choose is not available, you will be given similar
names to choose from that are available.

Chioase 3 pasneel e

Re-eater psscwced t

Detwist Homapags S0t Guoge as oy el hamipage.
SOCUMITY QUESHION; ~oss sor s

Answer:
Recovery omall:  beeet

Fig : 5.2 Gmail Information Window-Screen
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You can either choose one of those suggested or keep trying your own until you create one that
is not taken.

Step 4: Choose your password. When you key the password you want, you will be shown how
strong your chosen password is. Try to get it as strong as you can so you do not have to worry
about someone trying to get into your account.

Locaon
Word Verification: Typs t
picture

Terms of Service:

Fig : 5.3 Selection of Password Gmail-Screen

Step 5: Choose a security question. The security question will be asked when you forget your
password. This keeps other people from trying to access your account so make sure you
choose an answer account so make sure you choose an answer to the question you pick, that
only you know.

Step 6: Type the characters given without any mistake and they are not case sensitive.

Step 7 : Read the “Terms of Service, then click on “I Accept, Create My Account if you do
accept the terms. At this point, you have successfully created your account with Gmail and can
get started right away.

Fig : 5.4 Word Verification Screen of Gmail
To send a mail with attachments:

Email attachments are the electronic equivalent of using a paperclip to attach something to an
old-fashion paper letter. Just about anything can be attached to an email, but there are a few
cautions.
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Send files in a format that the recipient can read.

Don’t send LARGE files.

Explain, in the body of your text, that there is an attachment and what it’s about.
Subject column should not be left blank.

After you have scanned and saved your image to the hard drive, do the following to attach it to
your out-going email:

Example:

Unemployment is a great issue that affects the growth of our country, even though we have many
good brains in India, our country suffers a lot economically due to brain drain, and this happens
because of unemployment.

Fig : 5.5 Gmail First Screen
Here is a good method for getting jobs by mailing the your resumes to the top rated corporate
and industries.

Now let us take an example of how to send a mail with resume attached in it and its body
designed in a professional manner to apply for the particular job. Here let’s take www.Gmail.com
as an example of e-mail program to send mail.

1. Assoon as we type the address (www.gmail.comp) in the address bar the figurel will be
displayed in the browser.

2. Inorder to send a mail we must first have a Mail account, to create a new account click on
the button create an account. This would display a form to be filled, fill your basic details
and then accept the terms and conditions after reading then

click on create button, if every details are correct your new account will get opened.
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1. Then type your user name and password whenever you open your account.
2. The Gmail will give you three welcome messages by default. To create a new mail, click on
the compose mail button on the upper left corner of the window.
Fig : 5.6 Gmail Mail Inbox-Screen

BN FP RLm ECEEG EXRI B et eitag =

A new screen will appear where you will create your mail.

In the To: field type the email address of the person to whom the resume is to be sent.

If you want you can add CC and BCC to your mail.

In the subject column type the main subject of your mail. Example: “Applying for the post
of Computer operator”.

7. You can also attach your resume by pressing the “Attach a file button.

Sk w
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Fig : 5.7 New mail Sending Box
8. This button opens a “Choose a file window where you can choose your resume from the
place you have stored it.

RESUME

9. Bydouble clicking file (RESUME) we can attach the file to our mail.

10. After attaching the file from desktop to mail we can create the content of the mail, in order to
apply for the job and we have to mention about the attachment also.

11. Ttis better to paste a copy of the attachment in the body of the mail because sometimes if the
file is not attached properly the recipient cannot open it.

12. Your screen looks like this:

13. Now the e-mail is complete and you can send it by pressing the Send button.

Fig : 5.8 Attachment Screen
14. We can also receive mails, save mails, discard it delete it etc.

o PLETTUTE FEGSE BITT s =

Fig : 5.9 Save File —Screen in Gmail
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Online chat with webcam

Fig : 5.10 Yahoo Home Page
Use Your Webcam in Yahoo Messenger
1. To chat on the internet using webcam we must first download any chatting program
available from the internet. There are many chat programs which are available for text
chat, voice chat and video chat, such as Google talk, yahoo messenger, etc. ..
2. Inorder to use these programs we must first download them from their websites, for
example lets use yahoo messenger, it can downloaded from www.yahoo.com.

3. Headto the Yahoo home page, turn on Yahoo Messenger using the ‘Messenger’ link
and log in using your account name and password. You’ll need to create an account if
you haven’t done so already (see Resources below).

4. Click the ‘Messenger’ followed by the “My Webcam’ option. This will load your
webcam, and is among the ways you can get your webcam to begin broadcasting.

5. Click on a contacts menu and select contact list from the drop down options, this opens
a list of your contacts with the webcam active.

Fig : 5.11 Yahoo Messenger Login & Webcam —Screen
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6. Click the ‘View Webcam’ link while talking to others in IM. This will allow you to see
their webcams.

File  Webeam  Help Fil

,‘ Pause

Broadcasting - 0 Viewer(s) Broadeasting - 0 Vieweris)

Fig : 5.12 Online Video Chatting

1. Use the ‘Super Webcam’ mode when you want to send and receive high-quality images
and feeds. Broadband makes it possible to see one another in very high resolution,
although even with high-end broadband your computer may slow down a bit because of
the amount of memory and processing power this requires.

2. Click “Webcam’ followed by the “Who’s Watching Me’ button to see which of your
friends is receiving your webcam’s feed.

Searching for information on the internet:

Most information is found on the Internet by utilizing a search engines. A search engine is a web
service that uses web robots to query millions of pages on the Internet and creates an index of
those web pages. Users can then use these services to quickly and easily find the information
they may be looking for.

When searching for information on the Internet keep the below things in mind.

Surround searches in quotes

If you are searching for multiple common words such as computer and help, itis a good
idea to place quotes around the full search to get better results. For example, “computers
help”.

e Beaware of stop words

Many search engines will strip out common words they refer to as stop words for each search
that is performed. For example, instead of searching for why does my computer not boot, it’d
search for documents with computer and boot. To help prevent these from being stripped
L surround the search with quotes.
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e Familiarize yourself with Booleans

Many search engines allow Booleans, which can prevent results you many not want from being
displayed. Although common Booleans include “and , “or , and/or “not most search engines
have replaced these keywords with symbols. For example, if you want to find computer’s help
but didn’t want to return any results for Linux computer help you’d type computer help -Linux
the -Linux indicates to exclude any results containing the word Linux.

e Know what features are available

Many search engines allow for additional syntax to help limit your search strings. For
example, Google enables users to search for links to a particular page by typing “link: and
many other keywords at the beginning of the search query. For example, to see who is linked to
Computer Hope you’d type: link:http://www.computerhope.com.

e Try alternative search engines

Finally, if you continue to not find what you are looking for, try a different search engine. A listing
of search engines can be found on our network search engine section. Some popular search
engines are : Google, Altavista, Hotbot, Infoseek . Below is the Home page of Google Search

engine.

Fig : 5.13 Google Home page
Advanced search operators include
Include search or “+” Search
The common words, such as where, the how, and, other digits and letters are ignored by Google
during searching because it slows down the searching. However, if the common words are essential
for getting the result, then by putting + in front of words will search the pages including the word
which we have used after +.
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Use of +the Advanced Search
Language Tools

[ Google SearchJ [ I'm Feeling Lucky l

Synonym Search

If we want to search the search term along with synonyms, we should put tilde sign (“~ )
immediately in front of our search term. For example, how to search for food facts and nutrition
and cooking information:

~food ~facts Advanced Search
S Language Tools

Google Search J I I'm Feeling Lucky |

“OR” Search
To find pages that include either of two search terms, we need to write OR between the terms.
For example, we want to search hotels in either Gujarat or Delhi :

Hotels in Gujarat or Delhi Advanced Search
D ' Language Tools

Google Search ] [ I'm Feeling Lucky ’

Domain Search

If we want to search within specific website, we should write search term followed by the word
“site and a colon followed by the domain name. For example, we want to search for admission
information on the JACPC website:

Admigsion site:jacpe.org ’f’;ﬁ’“ 83;93 %‘;a]rch
. anguace [00ls

Google Search | | I'm Feeling Lucky ’

Range Search
We can search for the results containing numbers in a given range. For example, if we want to
search for TV costs in the range Rs. 10,000 to Rs. 30,000 :
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TV Rs.10,000 Rs 30,000 Advanced Search
Language Tools

lGaogle Search | ‘ I'm Feeling Lucky ’

Truncation (Use of wildcards)
Truncations are special symbols, which allow searching the terms arising from the same root. For
example, comput™® will retrieve results computers, computing, computing and computerization.

comput® Advanced Search
Language Tools

I Google Search | I I'm Feeling LuckyJ

Phrase Searching

Phrase search is made by writing double quotation mark. It searches for a particular phrase like
“role of computers in Libraries will retrieve results only about the role of computers in libraries
instead of looking for keywords —role, computers and libraries separately.

rale of computers in libraries" Advanced Search
Language Tools

Google Search ] \ I'm Feeling Lucky

Downloading the softwares from the Internet:

It’s easy to download a file from the Internet. But be careful! Do not randomly download files,
and never download a file you did not request. Make sure you only download files from people
and organizations you trust.

Example if you want to download software from internet you can go to original website
of the particular software you want to download and then click the graphical image
or the link that begins the download. Sometimes, clicking the link starts the download
immediately, and sometimes you're taken to another page. If the Information Bar
warning appears, click the Close button.

This protects you from downloading anything dangerous. If there is no warning message then we
can proceed with the downloading process. Either you have a Broadband or ADSL internet
connection, when you try to download large files — programs, music, videos etc you can encounter
downloading problems such as interruptions or low speed this can be due to the internet connection
speed you have or the memory existing in your computer. Downloading Softwares or any required
files from internet has many advantages but additional care is required to avoid virus attacks.

7
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Uses of Internet:

Various websites are available on net which assist us in all our day to day activities of life. From
Farmers to Technocrats internet technology has revolutionized the access of information in different
categories ranging from fertilizer availability, improvement in quality of crops, increasing sales,
availability of Bank loans, distance learning for rural residents, new pensionable schemes for senior
citizens, revised pay scales, reservation status & booking of'rail, air etc., health guidance etc.
http://agri.ap.nic.in/- agricultural Website that helps in Quality control of the soil,
plant protection, soil management, fertilizers to be used, etc.
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www.skdrpindia.org/Scientific%20farming.htm- This website is useful for the farmers
to take care of crops using scientific farming method.
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www.bankofindia.com — This website helps vou for bank loans for house, land.vehicle,

education, personal loan etc.
This also has information about ebanking, new account creation etc.

s ifos
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http://www.education.nic.in/dist inst.asp- This website helps youngsters in rural areas

to go in for distance Education for higher studies if there is no higher education
facility available in their locality.
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List of Institutions Offering Courses on Distance Mode and Open Universities In India
(As in January 2001)
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www.good-tutorials.com-This is an online tutorial were we can learn technical topics

online itself, free of cost.
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Blow an Image Away with a Custom Wind
Effect
Flash » Effacts — about 3
In this futorial, we wil create a custom class which
breaks a picturs into a housand pieces and simulates
a wind bowing them away

51 cicks Ocomments Osaves share report

KingDog W
Optimizing Your Acﬂonchipt Code

Flash » Actionscript — aboct 3 how's ago
57" Tibs howto optmze your ActionScript 3.0 coce

15 cicks 0 comments 0 savas_share repart

www.w3schools.com- This is an online tutorial website were we can learn technical

topics online itself, free of cost.
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THE LARGEST WEB DEVELOPER SITE ON THE NET

Full Web Building Tutorlals
- ALL FREE!

HTML Tutorials ) Building veb Building RECFERENCES
Laam HTM = HTML 4.0
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- o HTML and XHTML Al HTML Tags and Almbu(-ﬂ
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Laam XSLT P = HTML ASCH Codes
Leam X5L-FD Quick and Easy Learning !
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Leam Schema and hendy format
Leam XForms
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EXAMPLES
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Server Scripting g,pian amyehng”
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http://www.training.com/web/in/home- these are Online certificate course website
were we can complete the course by etraining and get the certificate online.
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http://www.indiaedu.com- This website helps us in both distance learning, online

certificate courses, online degree, etc. This is one stop solution for all education
related queries

Qe ¥ (2 Jlsmh S vot @) 3+ aw s
Wz o ntsecicen s @0 =
) - weacom S et - B W sconyy soven (G sptchd [ e o+ (D) webpas (] Tedic tesrwis - (04 spasotyoiosnves - [l 250
12) = ot corsas crien Ve D v BN G & Grs @ )

& ercters Blreavrts  Fumente @ ctose
( * India Education Gougle

(=]
Maww | CAT Preperstiers | MIA Abered |

Educational Resources ‘

for class X and class XIl students, IIT,
1M, MBA Aspirants:

' Web & www indhiaedn com




f

http://persmin.gov.in/ - Ministry of personnel, public grievances and pensions

, Public Grievances and Perisjons - Mozilla Fi
Bk Edt Wew Hidory Eockneks ook teb

O - c 3 o (0 = e J
1] Most Vicked @ Getthig Siértad 1 Latesteadives | | Clstomzelinks || Free Hobmal | | Windows Harketolace | Windows Medis | | Wivdows
o! -2 - v} ceachwer < 1J - Dk senin (2 vivet - € ansows - 8 spore - e - O 1ohe - (@ voves - 9

COVERNMENT

L I\f[inis!ry of Personnel,Public Grievances and Pensions S .

an'hle P Hon'ble MO
WHAT I8 NEW?

— Aevised Frinted List of Questions Adrmitted in Lok Sabha

.‘ ‘Search Your Circular )

for 20,3.2010 x -

25 : b [ ax
—= Provisional List of Questions Admitted in Lok Sabha for “
03,9000 .Phota Gallary...
—= Filling up the post of Daputy. Directan{Admn, ) 1n ATIMS like Dalhy Official Diractory
Institution-Fatna under the Ministry of Hesith & Family
Walfare.

itor Ng
Lipos

hetpiffp sy nhatobaleryin /Py

o B o

http://india.gov.in/govt/paycommission.php - Sixth Central Pay Commission

3 $ixth Central Pay Commission

Employnes Cornpr
Gk Db Mew Hidor Eochneke Tsob  teb

Government: Mational Porfal of India - Mozills Firefox

e = € X W X hépdindiogev.infont/peyccaminscn.php - (s
1] Most Visked @ Gettiig Started [ LatestHeadies | | Customzelinks || Free Hobmal || Wiridows Marketolace | Wirdows Media | | Windows.
S -2 - v| b ceamchwes - 13 - M senin £ vivet - €F anows - @ spons - ) moe - O dobe - G Moves - 3>

Ghip tz main zontent | Skip ta nauiganan | Azeazeibilmy Opsiane

,};‘ o Cibizans
Business
- o Ovarcens
L =1 ]
Vo are here: Home + Government » Employess Cormer » Sixth Central Pay Commission ' :°‘7";'";’?"'
1 ¥now tndia
“Suckos
[Sixth Central Pay Commission| : D:,m:,m
> I Dacuments
Implementation Recent Davelopments ' ;,;m, o
Diseiaian of the Gavirnmant an Sith * Full Download: i
Cantral bay Cammicsion £ P Rapiort (266 - 3.2 MB) s
Racommandations: | 1 bAnows {2te - 3,3 MB; 11 1 Tenders
* Errata to tha Reporr (66 KB) ' Sesreh ¢
* Revisin of Pay soales of amployess of d 't

Autonomous bodies, etd, (9aa 6 1M

Ciﬂg

* Placsment of Group D in PB-1

Com: » Rusulution cuntaining Goveriment's (e Bl Sl
TEpoct decision on Sixih CPC Regort (2081 Running Allowaness snd PLE How do I ?
. (Revicad Pay) Rules 2008 (3.7 ME) (34 ica) 24
1 » - BaEle Pav-OENARIGH Saaieh for Urdore and Acte
P8 [Pay) Amendment Rulss, 2008 (1 MB) 25 In the ravised schame of pay Reipe S Coriiral Acts end
+ IFS (Pay) Stoona Amendment Rules, 2006 (1 MB) 23 2ol e iz oe shall U tatins o viariou
* LA (PaY). 2N Amendrmant Rules, 2000 (1.1 MD] o For CiviTiaing rThs s of
* Oftice Mamarandum - 1 (1.3 1By 29 pay in the par band snd grade
» jcw Marnarandur - 11 {349 K8) 28 pay.
» Revision of Pay of the Chawpersons and Members of the Regulatory For Defence Forces
Authoritias/Bodias (286 KB) &3 Personnell The sum of pay n

tha paf band, grads pay and
# Group pay (where
applicabla), Militars Servica

Clarifiastions on CC8 (Revised Fav) Rules, 2008 (432 KBI

Alloveances (undated)
Uone

96




fa

http://www.irctc.co.in/ - Railway

3 IRCTC Online Passenper Reservation System - Moziila Firefox
B Edt Wew Hory Eockneds Took  Heb

@ = € X o & Hepe ooy

L) Most Wisked @ Getting Stértsd | Letestieadives | | CustomeeLinks || Free Hobmad || Windows Markstglace | Windows Medis | | Wivdows

oS! -.!-| V4 cemchweb - 19 - W 5enin 2 vived - €3 anowrs - B spurs - § e - O ohs - @ vaves -

e T
" Indlan Rallway mmm Corporation Limited

e of b Ersen sy e

Train Reservation Hotels Tourist Trains Tour Packages ‘ Book Cabs

]

e Logh Fro dgerts

Help 2 Info Enqurnas Lavalty Progratm Spenial Offars IRCTC Zons Mobile Zone Cataring

C et Apperion
ki B

IRCTC kil Acp¥eston (rgnsy)

Hiwhay botiang on e by

. B oo [k RCIC Crine Faczan, 0 2 st ofie

J PNR Stat Mozilla fox | o)
G Edt Yew Hgory Bockneds Jook Heb

@-c @ {3

- v 2l
| Most Visked @ Getting Startmd | Latestimadives | | Clstomze links || Free Hotmal | | Windons Markstgiace | Windos Media | | Windows
oS! -2 -‘ v‘ b oceamchwen - 13 - M sonin 52 vivet - €J ansoars - @ spore - ) mobe - (Faohs - (o roves - B
g Fee At s Fro 05hing & peg-g wand

7

: EXbharat i

assenge; ® us 3 5
Fassangsreuerene Stat | {dmatrimony.com |

Enter: the PR for rour booking below to gst the current status, You will find it on the top left carnar of the toket,
(R |

S WigesCholes | Safe % Secuie

PLAY FREE

ONLINE GAMES!

97



G )
http://www.jetairways.com/ - Air Ticket Booking

EER

Gk ER Yew Hador Bocknerks ook Heb

al

1] Most visied @ Gettng Strted | Lstest Meadives | | QistomzsLinks || Free Hobmal | | Windows Marketolzce | Windows Meda | | Windows.

! -2 - ot

- M snin B2 vimet - € anooas - @ spors - 4 manie - (P a0 - (L voves - P

India's finest international airline.
Giving the warld o battar choice in the skiss

Pigaze calect your country of residence

e Nadt Couber |
hboes Vour Latgaga 8

[AGsrnamber me selackon

If your country of residence
pheake sslactthc o

repe - Durtn

nitud Stakes o

wrand | Thislend | de

For a saamisss crline nxpenence plsase daists all your nache: and cosking, Clidk hars for mors nformation,

1%

Uone

R ?eLA® s

http://finance.indiamart.com/ - Investment

 India Finanee and Investment Guide, India, Futures and Options Live Quote - Mozilla Firefox

Gk Edt Wew Haory Bockiieks Isok Eeb
QF-c x ¢la - 5
L8] Most isind @ Gelting Stertsd | Latest Headives | | Clstomzelinks || Free Hobmal || Wiidows Markstglace | Windows Meds | | Windows
I o = -
oS! -2 - |t ceachwer - 1F - M sonin B2 vivar - € angowes - @B sporte - F moxe - (P ok - (o rioves - W
. i = =T ~
India Finance =5 *-; !,V‘\mdlaman >
& Investment Guide s Y T + 03
R
BSE | NSE Mutual Funds Commaodity F&O | Exim Policy | Tax Guide Investmont Guide | Goeneral Info]
J ! Soerch !
[53 GetFree Finance Widgers
Ads by Google
ux E-Books
for Yerace | 3%, Lustom | a4 E-bockswit Searh
+ BSE Top Gainers Facllity
BSE Top Garnons awy IaveCeu Com
* BSE Top Losars - CNALT
¢ « Gragh - Fertrightly i@ Stock Recommendation 2019
: Just Pay B2 TO0QYT & 226 Midcapsgrowing int
wultibanger eyersdey |
SR B ]
Eotar:Cavhpeiny:Haco oad - 3
= Agsisls o in Rlimgliting andineormny T
cornputslionfmanageimant
Mutual by Euturus & Outions o -
Insra Ray Trading Tips
hermes + Mutual Funds Naws Indax Futures Trada on sure calls in Inradayup o 0%
" n - sccuracy
* Qpen Endad * Latest Nav's * Index Qorions e SEpHIRG e
r Commodity Prices
Toal Box
Mutiral Fund search * &ara Froducts o
& schame Hame ¥ R v
< A >

98



G )
http://www.indianholiday.com/tourist-attractions/gujarat/museums/

3 Museums in Gujarat, Gajarat museums, - Mozilla Firefox
Gk Edt \ew Hgory Eockieds ook Heb

@ -c x i
L8] Most Visked @ Getting Stértsd | Latestieadives | | Clstomze Links || Free Hobmad | | Winidows Marketglzce | Windows Media || Widows

o -2 -| v| b ceachwer < 13 - B sonin 5 viver - 6 anows - 8D spors - § e - (F aobs - (@roves -
[Lsoorch |

India‘s [ eading tour aperator since 1990, Indian Holiday Pvt.Ltd.

|

| B G = unnmu.‘m
TRajastian & HimeckalPracesh 4
u Delhi u Darjecling /Xaliwpgsg

Gujerat Tour Packages

Cities in Guiorat Museums in Gujarat

ours to Ahmedabad

® Tuurs 1o Vadodsia
mo

e pE
this magrificant land of varlous tustoms, (tusds and mperal fguras, Gujarat is the
westarnmost stebe of India snd i3 racognized for £sindusties and Gowing scoamy.
anather jews in IO touris industry, The various sites of tourist
N tiraction atthis placs trawe honis of tnunsts from dfferant parts of the country ==
® Hatels in Gandh - i i
. N:::I, :,. pj;?,‘lmv wall 35 the world, Guiarat has a lona histary of struaale and turbuance that can be
® Hatels in Surat best falt whan cns visits the musaums in Gujarat.
® Hatels in vadodara
mare,, Thare !a'munv mussums snd gelenes n Cu]!r:('vvat hmlue the nehi culture and
heritage of this place. you can also get & gimpse of the earlier rulers’ lives & these
'““""";'::::m:’::"’;‘v'n Gujarat musaums, Thesa mussums arg the true traasura troves of Gujarat. Dut of the
Gliatat i several musaums ¥ Guiarat, the Maharais Fateh Sinch Museum, Vadodara is @
o Pussuns in Gujarst  (OtADIS nama Thi< is huilt in tha fdo Saracanic fackion of archisrhue and was oncs

Hotels in Guieret
® Hotels in Ahrwdabad

® Holy Places in Guiarse D12 abode of the Gaskwad family. This multipurpose musaum showcases the rich sollaon of the easures of arstwhile
® Gardens in Gujarst Gk tarnily who livad here,
& Basshee In Gujarie

® Wildife in Gujarst Baroda Museum and At Galleey, Vadodara & aleo a popular museuny which is locatad at Sayaji Bagh. It Is home o sevaral
Fairs and Festivals in Gujarat COlSCHIONS of the Europaan At and also the personal belongings of Maharaia Savaii Ran Gaskwad. This musaum hous
sorms Roman s Gresk sodphirss basdes several other atices that = from dsis. These arfides arm aenerally macs
Shopping in Gujarat wood, ory, bronze a indude SOme pottery-works.
Done.

5 & Gorminct Tadlar I M n Gk, B2 Moccatt e

3 1818 antique cain and lots more - Lucknow - Art - Cellectibles - antique coin 1818 - Mozilla Firefox
G Edk Wew Halory Bocknes Tsok bHeb

@ -cxa

- - J-
10] Most Vidked @ Gelting Strted | Latest Hemadves | | ClstomesLinks || Free Hobmal || Windows Marketplace | Windows Meds | | Windows
S -2 -[—v‘ b ocemchwed - 0 - M sonin 5 rime - B ancows - @B spore - ) moxe - (P dobe - (f voves - 2
1618 anvidguie coln ard WES more - Lucknow - antigue win 1818 A
0 L+icknow Free classifieds My OLX | Signin or Register | Erglish T

wwobein

WJ,hpm Foe Szl - k- Callectbles
ks nindia - Art- Colectibles in Uttar Fradesh - Art- Colectiies n Lucknow - 1618 antigue oun and bt maee

P BL‘A‘ o L R e P
China bottle factory 2 I The-SaleRoom.com

Redch buyers in 150 Countries High

Ve are glass f: 1. wholesat 3
‘& are glass batile manufacturer, \mur'v)em; r:(umunyaunmeﬂxmem

Kincts of glass botle - wasy oriopstones

Bid Live & Auction Rooms from Your Computer -

o Realktims Audio & Visual - vavy The-3aBRoom

Lecation: Lucknaw, Utrar Praciesh Indiz

®
°
@ Date Posted: May &

TR 4 Price: § 12.000 USD

pls call me if intrested 9452100429

User Information Ad Options




(e N\
http://www.healthguidance.org/- Health Guidance
OEEC %t .
|45] Most Vicked @ Geiting Stcted i Latest Headives | | Clstomze Links || Free Hobmal | | Winidows Marketplace ) Yiinckws Media | | Wivdows
v b emchwsh - 13 - Mk snin 5 vimet - 6 anonaes - @ spore - ) maie - (P aobe - (L roves - P
3 Cenestue Disoraers L]
Recent Topics and Headlines
Oumtreodys- . |8 2Neudtotis, + me? i!l’m:m
various Websites assisting in accessing information in daily routine
schedule :
e www.eprarthana.com/ - EPrarthana is the only web site that allows you to order Pooja’s
/ Archana’s ... Krishna, probably the most important of the ten incarnations of Vishnu, ...
e http://www.iloveindia.com/spirituality/sloka/vishnu-sloka.html-Shlok of different God’s
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e www.timesofindia.indiatimes.com/ - Times of India brings the Latest & Top Breaking
News on Politics and Current Affairs in India & around the World, Cricket, Sports,
Business, Bollywood News ...
e www.exercise.about.com - Learn about exercise, how to lose weight and how to get
fit and healthy. You’ll find weight loss advice, free cardio, strength training, flexibility; ...
e www.auto.indiamart.com - Indian Commercial Vehicles - Information on commercial
vehicles in India, Light Commercial vehicles, heavy commercial vehicles, emergency
and multi utility ...
\ J

100



www.diethealthclub.com/ - This will ensure that one gets the maximum recommended

nutrition from the food group; besides the food variety will make for an interesting
meal. ...

www.websearch.about.com/od/searchtipoftheday/qt/freemovie.htm - Find free

movie downloads, download a movie player, watch an online movie, or catch the latest
movie premieres with my list of the best places to find free ...

www.songs.pk/ - Latest Bollywood Movie Songs ... Free Image Hosting - How Earn

Money Online ? ... Copyrights Reserved By Songs.PK |

www.sanjeevkapoor.com/ - RECIPE CONTEST Put on your apron and dish out

something yummy! ... Glossary - English to Hindi. Glossary of Cooking Method ...

www.ebay.in/ - eBay.in is /ndia s most popular online shopping mall providing free
online ... Use of this Web site constitutes acceptance of the eBay User Agreement and

www.livemocha.com/ -Learn languages online at your own pace with fun language

lessons ... Courses in 36 different languages. Over 160 hours of lessons for each ...

www.webindia123.com/Sports/index.htm-India-Sports-
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lawn tennis, table tennis, handball, ...

www.espnstar.com/ - Source for the latest live football scores, soccer news and results.
Get your football information and soccer match updates here at ESPN STAR Sports.
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Google Earth : Google Earth lets you fly anywhere on Earth to view satellite imagery, maps,
terrain and 3D buildings from galaxies in outer space to the canyons of the ocean. You can
explore rich geographical content, save your toured places and share with others.

Fig : 5.14 Earth -Screen
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Fig : 5.16 Google Earth-India Gate-Screen
(B) Computer Softwares to help in daily activities of life:

“Computers are transforming society. Time is collapsing. Distance is no longer an
obstacle. Crossing oceans takes only a mouse click.”

Virtually, computers which pressure most people’s life are considered as the most important
technological achievement of the current century. Using computers, we can make or solve most
of difficult things which are hardly completed without their hands. Because of these different
varieties of abilities, computers have been creating many noticeable achievements in most of
societies especially in fields like medicine, education, and usual life.

Daily actives of our life has become very easy, as we even don’t have to take the pains of
travelling to post office and post a letter as we have many text editing softwares available at home
such as Microsoft word etc. .. from where we can type the letter and mail the person from the
place where we are sited with help of internet. In the same way computer softwares have changed
our lifestyle drastically and has given us many comforts through technologies.

Nowadays Computer softwares has also given us the chances of entertainment at home itself
with good gaming concepts and mind blowing gaming softwares. Apart from this we have the
options of watching latest 3D and 4D pictures at home itself. The most of the primary desktop
application software which are built in helps us in doing magical word documents, high speed
calculations, memory management and contact list maintenance without giving much pressure to
our brains.

\
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6. Primary desktop applications MS Office and Microsoft

windows accessories

Introduction:

Primary desktop applications refer to applications running in a desktop (or laptop) computer in
contrast to Web-based applications over the Internet. Since the advent of the Web, developers
have been trying to make Web applications as interactive and responsive as applications running
within the client locally or in a client/server environment over the local network. The desktop
applications help a lot in day today activities of life. This chapter also includes information about
few accessories available with Microsoft windows operating system.

Primary desktop applications for MS- office:

Cla

iorosaft el el
Momﬁice Microsoft Office is an office suite of interrelated desktop

applications, servers and services for the Microsoft Windows and Mac OS X operating
systems. Initially a Microsoft Office package contained Microsoft Word, Microsoft Excel,
and Microsoft PowerPoint. Additionally, a “Pro (Professional) version of Office included
Microsoft Access and Schedule Plus, and Microsoft office also offers Microsoft
Outlook for Email users.

Microsoft Windows versions:

The Microsoft Office for Windows 1.0 started in October 1990 as a bundle of three applications
designed for Microsoft Windows 3.0: Microsoft Word for Windows 1.1, Microsoft Excel for
Windows 2.0, and Microsoft PowerPoint for Windows 2.0.

The Microsoft Office for Windows 1.5 updated the suite with Microsoft Excel 3.0.

The Microsoft Office for Windows 1.6 added Microsoft Mail for PC Networks 2.1 to the
bundle.

The Microsoft Office for Windows 3.0, released in August 1992, contained Word 2.0, Excel
4.0, PowerPoint 3.0 and Mail 3.0.

In 1994, Microsoft Office 4.0 was released containing Word 6.0, Excel 5.0, PowerPoint 4.0,
Mail, and Access. Word was called Word 6.0

\

104



7

Microsoft Office 95 was released in August 1995. Again, the version numbers were altered to
create parity across the suite — every program was called version 7.0 meaning all but Word
missed out versions.

Microsoft Office 97 (Office 8.0), a major milestone release which included hundreds of new
features and improvements, introduced command bars, a paradigm in which menus and toolbars
were made more similar in capability and visual design. Office 97 also featured Natural Language
Systems and grammar checking. Office 97 was the first version of Office to include the Office
Assistant.

Microsoft Office 2000 (Office 9.0) introduced adaptive menus, where little-used options were
hidden from the user. It also introduced a new security feature, built around digital signatures, to
diminish the threat of macro viruses.

Microsoft Office XP (Office 10.0 or Office 2002) was released in conjunction with Windows
XP, and was a major upgrade with numerous enhancements and changes over Office 2000.
Office XP introduced the Safe Mode feature, which allows applications such as Outlook to boot
when it might otherwise fail. Safe Mode enables Office to detect and either repair or bypass the
source of the problem, such as a corrupted registry or a faulty add-in. Smart tag is a technology
introduced with Office XP. Some smart tags operate based on user activity, such as helping with
typing errors. These smart tags are supplied with the products, and are not programmable In
Office XP, custom smart tags could work only in Word and Excel. Microsoft Office XP includes
integrated voice command and text dictation capabilities, as well as handwriting recognition.
Microsoft Office 2003 (Office 11.0) was released in 2003. It features a new logo. Two new
applications made their debut in Office 2003: Microsoft InfoPath and OneNote. It is the first
version to use Windows XP style icons. Outlook 2003 provides improved functionality in many
areas, the key benefit of Outlook 2003 is the improved junk mail filter.

Microsoft Office 2007 (Office 12.0) was released in 2007 and is the most current retail version.
It includes number of new features, the most notable of which is the entirely new graphical user
interface called the Fluent User Interface .

Microsoft Office 2010 (Office 14.0) is under development with a planned release date of June
15,2010. Microsoft Office 2010 is a productivity suite for Microsoft Windows. Office 2010
includes extended file compatibility, user interface updates, and a refined user experience. A new
feature in Microsoft Office 2010 is the Social Connector. This allows users to write emails while
keeping track of their family, friends and colleagues by viewing status updates and past
communication history with the individual.

Microsoft word:

One of the most common uses of computers is in handling office activities. It is observed that
word processing, data processing, and communication are the most common activities occurring
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in the offices. Nowadays, computers are used to handle effectively these activities in offices and
also desktop applications in home.

Word processing generally refers to the use of computers to create, view, edit, store, retrieve,
format, manipulate and print various kinds of documents. These documents can be letters, reports,
these, manuscripts of a book, etc.
Word processing software is a collection of programs used for preparing documents, it generally
deals with managing cursor positions, insertions, deletions, and saving, among a wide range of
other ‘text manipulation’ activities.

Need of word processing:

There are many problems that can occur in the absence of computer software. For Example if
we use a manual typewriter for typing a document, and if we find any mistakes after typing the
document, we have to retype the document. This is very tedious task, so we have many such
problems in the absence of a word processor.

Word processing helps us in solving the above mentioned problems very effectively. we may
verify the document for its correctness and modify it any number of times before printing the
document, so we can avoid the process of retyping and we may also save the document in the
computer’s memory for its future use. We can also check spellings and grammar automatically
using modern word processor, which is not possible in conventional typing.

Creating and Editing a Document:

Opening Microsoft Word:

To run Word on your computer: “Start >>“Programs >>“Microsoft Office >>
“Microsoft Office Word 2003. If there is an icon of Microsoft Word available on your

[RASATATIL A

Windows Update

y @) Accessories

[T Programs
T) Adobe 4
.;' Documents » i) Macromedia 4
B . Settigs . [T) Microsoft Office ¥ |7 Microsoft OFfice Tools
(7)) Network Associates » | #| Microsoft Office Access 2003
4 Search » ) Startup » |[38] Microsoft OFfice Excel 2003
[T) Utilities P |&%| Microsoft Office InfoPath 2003
@) repandSupport g o dperfect Office 2000 b [@] Microsoft Office PowerPoint 2003
77 Run... Actobat Distiler 5.0 |B] microsoft OFfice Publisher 2003
[2} Adobe Acrobat 5.0 W] Microsoft Office Word 2003
a Shut Down... & Internet Explorer

Q' Netscape 7.0

@ 0 @ g word_-_introd... [ &) Windows Medi,.. | @Rutgers Writin. ..

Fig : 6.1 Steps to open MS-Word
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(a

desktop (shaped like a square with a “W in the middle), you can open up the
program by double-clicking it, as well.

The Basics components of the Word Window

Let’s briefly review the basic parts of the Word 2003 window before we move onto word

processing.

Shown below is the Microsoft Word default window. When Word is launched, a new blank
document, or default window, opens in Print Layout view. Although window elements are fully
explained in our Windows course, here is a brief explanation of the Word window.

Tile Bar  Menu Ba Siandard Teolbar Formatting Toolbar fetp

B e T el | -
Lldid g o ae d ol a Bis vemrne oo p R EE . s ew Dl Al
104 . N s

Sorcll Bar —

Office Assistant

Fig : 6.2 Basic components of word screen

Title Bar : Displays the document name followed by a program name.

Menu Bar : Contains a list of options to manage and customize documents.

Standard Toolbar : Contains shortcut buttons for the most popular commands.

Formatting Toolbar : Contains buttons used for formatting.

Ruler : Used to set margins, indents, and tabs.

Insertion Point : The location where the next character appears.

End-of-Document Marker : Indicates the end of the document.

Help : Provides quick access to Help topics.

Scroll bars : Used to view parts of the document.
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Status Bar : Displays position of the insertion point and working mode buttons.
Task Pane : Provides easy access to commonly used menus, buttons and tools.

View Buttons : Changes the layout view of the document to Normal View, Web Layout
View, Reading Layout View, Print Layout View, or Outline View.

Office Assistant : Links to the Microsoft Office Help feature.

How to create a attractive word document, shown as below :

T8 Vande Mataram - Micrasefl Ward X
pe Bt Yew Fe Fame Tove Tabe Wedw e Taeagasinfw 258

RS ] RS TR AE kAT . AT NS

4 omd +Cem e petlonkoon 02 o) B 2 L=

Vande Mataram!
Sujalam suphalam, malayaja shitalam,
Shasyashyamalam, Mataram!
Shubhrajyotsna pulakitayaminim,
Phullakusumita drumadala shobhinim,
Suhasinim, sumadhura bhashinim,
Sukhadam, varadam, Mataram!
Saptakotikantha kalakala ninada karale
Dvisaptakoti bhujair dhrita-khara karavale
Abala kena ma eta bale
Bahubala dharinim, namami tarinim,
Ripudalavarinim Mataram!
Tumi vidya, tumi dharma,
Tumi hridi, tumi marma,
Tvam hi pranah sharire!
Bahute tumi ma shakti,
Hridaye tumi ma bhakti,
Tomarayipratima gari mandire mandire!
Tvam hi Durga dashapraharana dharini,
Kamala, Kamaladalaviharini,
Vani, vidyadayini namami tvam,
Namami Kamalam, amalam, atulam,
Sujalam, suphalam, Mataram,
Vande Mataram!
Shyamalam, saralam, susmitam, bhushitam,
Dharanim, bharanim, Mataram!

= Shri Bankimchandra Chattyopadhay

0 Friey dedlop i 3 nooalanon] & Suremishas

Fig : 6.3 MS word-Screen
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There are a number of important components in the opening screen of MS word, and the name
of the currently opened screen will be displayed in the Title bar of the window and the name of
the above window is Document1- Microsoft Word. The next line of the opening screen contains
the Menu bar. The menu bar contains several menu items, for example, File, Edit, View, Insert,
Format, Tools, Tables, windows and Help, and corresponding pull down menus can be used by
licking the particular menu button. The two lines below the menu bar displays two different tool
bars. The first tool bar is called standard tool bar, the second tool bar is called formatting tool
bar. We also see the ruler bar that is useful for setting margins for our document. The window
below the ruler bar is generally known as the document window. We can use it for typing text of
our document. MS word shows a vertical and a horizontal scroll bar to scroll up and down the
document.

The last line of the document is the status bar that contains useful information about our document.

Creating a Document:

Creating a document in MS Word is a very simple. When we start MS Word, it automatically
creates anew document. It is given a name Document! by default. We can directly start typing
the text after seeing the opening screen of MS Word.

Editing a Document:

The process of making changes in a document is generally known as editing. We may want to
make modification in the documents for the purpose of correcting mistakes. During the process
of editing, we may want to add or delete a particular text in the document and thus the mistakes
in the document are corrected by performing the operation of adding, deleting, or overtyping the
text in the document. This can be done with the help of insert delete and backspace keys in the
keyboard.

Saving a Document for future use:

You may follow any of the following steps to save a word document:
e Select the Save command from the file menu.
e Press the Ctrl+S keys
¢ Click the save button on the Standard toolbar.

Cut, Copy, Paste:

During the process of editing, many times we need to delete selected text within the document.
Sometimes, we need to use the same text at several locations in the document. Moreover, we
may require moving entire paragraphs or selected text from one location of the documents to the
other location of the document. Most of the word processor nowadays provides useful features
to meet these requirements. For example, MS Word provides the Cut, Copy, Paste commands
to delete the selected text, copy the selected text in the memory, and paste the selected text from
memory to desired location in the document any number of times.

| The following steps assist you in usage of cut, copy, paste command immediately:
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Cut command:
1. Select the text to be deleted. You may use either the mouse or the keyboard to select the
desired text.
2. Delete the selected text by clicking the Cut button on the standard toolbar or by pressing
Ctrl+X or right click select cut from the pop-up menu.
Copy Command:
1. Select the text to be copied, by using either mouse or keyboard to select desired text.
2. Copy the selected text by clicking the Copy button on the standard toolbar or press
Ctrl+C in the keyboard or right click and select copy from the pop-up menu.
Paste Command:
The paste operation is performed after using either the Cut or Copy commands. The paste
commands copies command copies the content of the clipboard at the current location of the
cursor. We may paste the selected text to a document from the special memory called Clipboard
using the Paste command by Clicking the Paste on the Standard toolbar or by pressing Ctrl+V
or right click select paste from the pop-up menu.

Formatting Text and paragraph:

The Text can be formatted in variety of ways using M'S Word. It is possible to apply various text
styles to the selected text of a document in MS Word. For Example, we may apply styles like
Bold, Underline, Italics etc.

»
]
ATy
]
“'vl‘
M

ﬁ Normal - TimesNewRoman -« 12 « | B 7 U JE == =

Do i

Fig : 6.4 Formatting Toolbar

We generally use the following steps to apply a desired style:

o Select the text to be formatted either using keyboard or a mouse.

e Apply the appropriate formatting command.
MS word also allows us to format the text by making it bold, by underlining it and by making it in
Italics style etc.

To make a word in bold style:
e Select the text and click the B button available in the Formatting toolbar or select the
word and press Ctrl+B in the keyboard.(for Example “Vande Mataram!” In the
screenshot)

To underline a particular Text:
Select the text to be underlined and then press the U button available in the Formatting toolbar
or press Ctrl+U in the Keyboard.
To make the text in italic style:
o Select the text to be italics and then press the /button available in the Formatting toolbar
or press Ctrl+] in the Keyboard.
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Apart from these formations MS Word also allows us to give different font size and Font for
different text. The text can also be decorated with different font colors by font color button in the
formatting toolbar.

Example:

IncrepiBLE INDIA

The above text is with font size 14, font Georgia, given in bold, italics and underlined with mixed
colors of our Indian flag.

In the same way we can change the font size and color and formatting to any number of times we
require.

Formatting Paragraphs:

Formatting a paragraph in MS Word id possible in several ways. We may align the paragraph
left, Right, justify by selecting the required text. For formatting a paragraph we should first select
the paragraph by triple clicking it & then Press Ctrl+L —for left alignment, Ctrl+R- for right align
and Ctrl+J-for justify the text or press FormatParagrath—> Alignment and select any one effect
from drop down box.

We can arrange the left and the right margin of the paragraph by using indent button in the
formatting toolbar or by selecting margin indentations from Format—>paragraph—>indents and
spacing after this word will show a dialog box with field where we can adjust our indentation
numbers. We can also add bullets and numbers to in between paragraphs using bullets button
and numbering button in the formatting toolbar.

Working with Tables:

Powerful facilities for working with tables are provided by MS Word. It is possible to create
tables consisting of any number of rows and columns. Moreover we can type text in any cells and
we can also format it using formatting toolbar.

Creating Tables:

Generally, we use the Table menu to create a table.

Table—>insert->table will open insert table dialog box where we can select the number of rows
and columns of the table and press ok after selection.

Insert Table @

Ta&lsses
flomzer of calumrs: 4
Nuricer of coms:

AukaFE brhavice
(&) Fived colmn width: Aute
(L AUCOEIL b corfents
() Aot bo windaw

it BTt Fig : 6.5 Insert Table Window

| Rernambar clmenslors for new tables

[ or [ cnd
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If we select a table with 3 rows and 2 columns it will be displayed as below:

Country Capital
India New Delhi
United States Washington, D.C

We can also insert and delete rows with the help of table menu in the menu bar.

Drawing objects and pictures:

Drawing - X
Draw= i |Autoshapes> N\ N1 O ] M 3 Gl Wl S -Z-A-S=2 0 F

Fig : 6.6 Drawing Toolbar
Generally we use drawing tool bar to draw various shapes. In the drawing toolbar we have

various shapes available, we can draw a line using line tool, we can use arrows using arrow tool.
And there are many types of auto shapes like rectangle oval square are available in the drawing
toolbar. It also consists of text box tool to include text between the shapes. The Drawing toolbar
also has an excellent feature called Word art which is a collection of different types of word art
gallery, where a good number of word art styles are available, for example “National song”
mentioned in the screenshot. The formatting toolbar also allows you to insert diagrams, pictures
(for example national flag picture in the screenshot) organizational chart, clip Art, pictures, 3D
style shapes etc.

Drawing a text box:

One of the the useful tool available on the drawing toolbar is text box. We may create a text box
by clicking the text Box button on the Drawing toolbar. Any type of text can be created and
formatted in the text box by following the general methods.

Moreover we can also add picture files drawings in the text boxes.

Printing, Spell Check, Grammar:

Print a Document:

First open the document that is to be printed. Printing can be done in any three of the following
ways:

e Click the Print button available on the standard tool bar.

e  Open the file menu, and then select Print from the file menu.

e Hold Ctrl and then press P

The following print window will appear by making the necessary changes press ok button to
L print the document.
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Fig : 6.7 Print Dialogue Box
Checking spelling and grammar:

The errors may occur while we type a document. The MS Word software can check spelling as
we type text in a document. In order to check spelling of the words, MS Word uses its own
dictionary containing commonly used words, if did not find the word that is typed in the dictionary
then it will underline the word by a weavy red line. Now there are two options either we can
correct the word by ourselves or we can or we can ask MS Word help to give some suggestions.
The suggestions will be provided by MS Word when we right click the red underlined word or

Press F7 key or Tools—>spelling and Grammar command or | % | click on spelling and grammar

button from format menu.
The spell check correction can be enabled or disabled by us; this will check and correct the
grammar and spelling as we type the document.

Fig : 6.8 Spelling and Grammar Checking Window
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Mail merge and its Uses:

Mail Merge is one of the most powerful features of modern word processors including MS
Word. We generally use the mail merge features when we need to send the same letter to several
persons. The major content of the letters to be mailed remains the same, although we may
require inserting personal information like name, address, city in each letter, at appropriate place.
We may use mail merge to generate these kinds of letters very quickly and effectively, which is
explain below:

Creating the main document

On the menu bar, click on Tools. From the pull down menu, select Letters & Mailings, then
select Mail Merge... A task pane will appear on the right of the word document. Under
Select document type, choose one of the following types of documents:

o Letters
e E-mail Message
e Envelopes
o Labels
e Directory
Click on Next: Starting document at the bottom of the task pane

Selecting the starting document

The two most common types of document are letters and labels.
Letters:

Under Select starting document, select one of the three options:

e Use the current document will allow you to start from the current document shown
on the screen.

o Start from a template will allow you to start from a ready-to-use form that can be
modified.

1. Click Start from a template.
2. Click Select template...

3. Onthe Mail Merge tab in the Select Template dialog box, select the
template you want, and then click OK.

o Start from existing document will allow you to work on an existing mail merge
document.

1. Click Start from the existing document.
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2. Inthe Start from existing box, select the document you want, and then click

Open... If you do not see the document, click More files..., and then click
Open...

3. Inthe Open dialog box, locate the document you want, and then click Open.
Click on Next: Select recipients at the bottom of the task pane
Labels:
Change document layout:
1. Click on Label options..., the following dialog box will appear.

2. You may choose a specific type of label by Label products and Product number.

Label Options @

Printer information
() Dot matrix e,
(= Laser and ink jet Tray: |Default tray (Default tray) |

tabel nformstion

Label products: | Avery standard v
Praduct number: :
TR |.abel Infarmation

|2162 Mini - Address | Typsi Address

2163 Mini - shipping Heighit: {4

2164 - Shipping s "

2180 Mini - File Folder Width: 2,63

2181 Minl - File Folder | Page size:  Mini{4 Y4 x 5in)
2186 Miri - Diskette el

Details, ., | I haw Labsl, ., | L OK ] | Cancel

Fig : 6.9 Label Options Window
3. You can adjust the height and width of the label by clicking on Details...

Start from Existing: Choose this option if you have saved an existing label document in
Word format.

Click on Next: Select recipients on the bottom of the task pane

Start from Existing: Choose this option if you have saved an existing label document in
Word format.

Click on Next: Select recipients on the bottom of the task pane
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Selecting recipients
The process of selecting recipients is identical for creating Letters and Labels. Under Select
recipients, select one of the three options:
o Use an existing list will allow you to use files and addresses from a file or database.
1. To find an already existing file, select Browse... and navigate your way to the
file.
2. Ifyourdata source is an Excel worksheet that has data on multiple tabs, select
the tab containing the data you want. Click OK.
3. All the entries in the data source will now appear in the Mail Merge
Recipients window, where you can edit the list of recipients. Click OK when
finished.
To change the file click on Select a different list...
5. Toeditthe list click on Edit recipient list... (data source)

New Address List @

Enter Address infarmation P
Tite ||
Firsk Narie i
L ast Name:

Company Mame:
Address Une 1 7
Addrgss Lne 2

cry |

Chobm

v

[ MewEnty | [ DekteEntry | [ EndEntry.. | (Flter and Zort., | [ Custonizs... |

el Entries

View Entry Number 1

Iotal entries n kst 1

Cancal ]

Fig : 6.10 Address List Box

Creating a simple new address list will allow you to create a new contact list.
1. Under Select recipients, click Type a new list.
2. Click Create..., the following window will appear.

3. In the New Address List window, type the data you want to include under Enter
Address information; for example, title, names, and address information. You
do not have to fill in every field. If you want to edit the field names, click on
Customize... button, and the Customize Address List window will appear.
Add, delete or rename any field name as you want.4. To make another entry,
click New Entry.
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5. Repeat steps 3 and 4 until you’ve added all  the entries you want, and then click
Close.

6. In the Save Address List window, type a name for the data list in the File name
field, and select a folder to save the list in. By default, the address list is saved in the My
Data Sources folder. It is best to keep the file there since  Microsoft Word by default

looks for data in that folder, so you won’t have to navigate through files and folders to
locate it.

7. Click Save

Customize Address List E]
Fiokd Names
f e,
‘FIM Mariz
Lest Nae o Ee—
| Compeny Name | DQelete |
| Adcress Line | PHCSE
| Adcress Line 2 | Renere |
PCity S
| state
L Z1P Covde
fCountry
| Home Phone
Witk Fhone [ Movelp |
| E-mai Adcress jiloietp 3
| Mova Down. |
— x| e |

Fig : 6.11 Customize Address List Box

8. The contacts in the new list will appear in the Mail Merge Recipients window
where you can edit the list.

In the Mail Merge Recipients window, select the recipients you want by checking the
boxes next to the recipients. To sort the list, click the column heading of the item you want to sort

by. Tofilteritemsin the list click the arrow next to the column heading of the item you
want to filter by and select any of the following;
Tosort the bst, dids the spprocnate coumn headng. To nartow don the iecpisnts disclayed by »
specific crberia, such s by city, clich Boe arrow ce 2t to bie colurn heading, Use the chede hoves o
buttons bo =dd or remoxe raspents from the mal rergs,
List of recplents!
v Lest Name v FrstNare ¥ Addrzssline 1 v Addrecslne2
o (06 Certrsl Stras:
M shmos e 75 Harper Strast
[ ]
ESIR TR €T
" Fimd.., valdate | ——
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Blanks display all the records in which the corresponding field is blank.

o Nonblanks display all the records in which the corresponding field contains information.
If your data source contains records that share the same information, and there are ten or
fewer unique values in the column, you can filter by specific information.

o Ifthe arrow next to any column heading is blue, that category is screening out names. To
display all the recipients again, click and blue arrows and select All.

Fig : 6.12 Mail Merge Recipients Box
To check all names in your recipients list, click Select All. To uncheck all names, click Clear
All
Click OK to return to the Mail Merge Wizard.
If you are creating a form letter, click on Next: Write your letter.
If you are creating a label, click on Next: Arrange your labels.
Formatting letter and label
If you are creating a form letter, type the text that you want to appear in every form letter.
Insert merge fields where you want to merge names, addresses, and other data from the data
source (i.e. recipient list) by clicking anywhere you want in the main document to insert the
field. Then click on More Items and insert individual field. You may also use Address block
and Greeting line. More details will be found below.

If you are creating a label, you may use Address block or More Items to edit the label. If
you want every label to appear in the same format, click Updating all labels under
Replicate Labels.

e Address block

1. Click Address block...

2. Inthe Insert Address Block window, select the address elements you want
to include and the formats you want, and then click OK.

3. Ifthe Match Fields dialog box appears, Microsoft Word may have been
unable to find some of the information it needs for the address block. Click the
arrow next to not matched, and then select the field from your data source
that corresponds to the field required for the mail merge.

e Greeting line
1. Click Greeting line...
2. Selectthe greeting line format (salutation, name format, and following punctuation.)
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3. Select the text you want to appear in cases where Microsoft Word can’t
interpret the recipient’s name.

4. Click OK.

5. Ifthe Match Fields window appears, Word may have been unable to find
some of the information it needs for the greeting line. Click the arrow next to
not matched, and then select the field from your data source that
corresponds to the field required for the mail merge.

e More Items
1. Click More items...
2. Select one of the following:

(a) Address Fields will allow you to select from address fields that will automatically map
to corresponding fields in your data source, even if the data source’s fields don’t have
the same name as your fields.

(b) Database Fields will allow you to select from fields that always take data directly
from a column in a database.

3. In the Fields window, click the field you want.
4. Click Insert, and then click Close.

5. If the Match Fields window appears, Microsoft Word may have been unable to find
some of the information it needs to insert the field. Click the arrow next to not
matched, and then select the field from your data source that corresponds to the field
required for the mail merge.

If you are creating a form letter, click Next: Preview your letters.

If you are creating a label, click Next: Preview your labels.
Preview letters and Labels

e To preview the items in order, click the arrows under the Preview your letters/
labels heading.

o To locate a specific item, click Find a recipient..., and then enter the criteria in the
Find field.

o To change the list of recipients, click Edit recipient list..., and make your changes in
the Mail Merge Recipients window.
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Click on Next: Complete the Merge at the bottom of the task pane
Complete the merge
Edit Individual letters/labels
e Click Edit individual letters/labels...
e Inthe Merge to New Document window, select the records you want to merge.
e Click OK.
e Microsoft Word will create new merged document.

o To personalize individual documents, scroll to the information you want to edit, and
make your changes.

e Print or save the document just as you would any regular document.
Print the letters/labels

o Ifyoupersonalized the items and the merged document is active on the File menu, click
Print.

o Ifyou want to print directly from the mail merge task pane, click Print... under the
Merge heading. In the Merge to Printer window, select the options you want, and
print.

Save the merged letters/labels

Under most circumstances, you do not need to save the merged document. It is simpler and
more useful to save the main document and merge it again if you need another copy. Below are
examples of times when you might wish to save the merged document:

e You wish to keep an archived copy of mailings, including to whom they were sent.

e You have personalized individual letters or labels within the merge, and want to save
those changes.

If you do wish to save the merged document, collect the merged files into a single document by
clicking Edit individual letters/labels. In the Merge to New Document window, select one
of the following:

o Tomerge all the documents, click All

o Tomerge only the document that you see in the document window, click Current record.
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e To merge arange of documents, click From, and then type the record numbers in the
From and To boxes.

Click OK.

Microsoft Word will open one new document that contains all the individual letters. Save the
document just as you would any regular document.

MS Excel:

Microsoft Excel (full name Microsoft Office Excel) is a spreadsheet application written and
distributed by Microsoft for Microsoft Windows and Mac OS X. It features calculation, graphing
tools, pivot tables and a macro programming language called VBA (Visual Basic for Applications).
Excel is an electronic spreadsheet program that can be used for storing, organizing and manipulating
data.

Uses of MS Excel:

Excel replaces manual spreadsheets designed on a paper. It is very important and effective tool
used to perform calculations, store data in memory of the computer and display information or
results on the screen in desired manner. Excel also provides quick and efficient methods to
analyze the data. Unlike manual spreadsheets, it is quite easy to update data once entered in
spreadsheet program. Besides, when any value is changed, the spreadsheet program automatically
recalculates results on the basis of new value.

Introduction to spreadsheet:

Spreadsheet is a simple sheet consisting of rows and columns. The horizontal rows are identified
by numbers (1,2,3,...) and the vertical columns with letters of the alphabet (A,B,C,...). For
columns beyond 26, columns are identified by two or more letters such as AA, AB, AC, etc.
Basically, spreadsheets are used to work with lists of data. Using spreadsheet one can store,
view and analyze the data in a well organized manner.

Starting Excel:
In order to open MS Excel:
Start >> Programs >> Microsoft Office >> Microsoft Office Excel 2003
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Fig : 6.13 Steps to open MS-Excel
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Fig : 6.14 MS-Excel Opening Screen

In the title bar the name of the workbook will be given as Excel-Book1.By default any Excel
workbook consists of three worksheets. We can add more number of worksheets as we require.
The name of the sheets is given as sheet], sheet2, sheet3 and so on. The sheet that is currently
used called as active sheet. Each sheet has 65,536 columns and 256 rows. The intersection of
the rows and the column is known as the cell. The main utility of the Excel is used for a calculation
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that leads to more than 50 pages and for table formation and data analysis. Each cell is identified
by a specific cell address and the cell address is formed by combination the particular row
header and the column header. Example the address of the cell which is a combination of row 3
and column B is B3.

We can use tab button in the key board in order to move around the worksheet or we can use the
arrow keys to move to the adjacent cells in any direction.

You will notice a number of toolbars with many more options

included.
Standard Toolbar:
HRNEA" RN RN« W EEW - R AN

Fig : 6.15 Standard Toolbar

1. New: This command will Create a new, blank spreadsheet

2. Open: This command will Open a previously saved spreadsheet

3. Save: This command will Save your current spreadsheet

4. Permission: You can create content with restricted permission using Information
Rights.

5. Print: This command will Prints the current document.

6. Print Preview: Preview the potential print of the current document.

7. Research: Microsoft has enabled Information Rights Management (IRM) within the
New version of Excel, which can help protect sensitive documents from being copied
or forwarded. Click this for more information and options.

8. Copy: Copies the current selection to the clipboard, which can then be pasted else

where in the document.

9. Paste: Takes the current clipboard contents and inserts them.

10. Undo: Undoes the last action in the document, reverting “back astep in time.

11. Insert Hyperlink: Inserts a hyperlink to an Internet location.

12. AutoSum: A drop-down menu of available mathematical operations to perform.

13. Sort Ascending: Sorts the current selection in ascending order.

14. Chart Wizard: Opens the “Chart Wizard, which will walk you through the creation
of a chart/ diagram using the currently selected information.

15. Microsoft Excel Help: Brings up the Excel Help window, which will allow you to
type in a key-word for more information, or click anything on screen to directly bring
up further information on that subject.

16. More Options: There are a variety of extra options you can call or add to the toolbar,
such as Spell Check, Sort Descending, Cut, Redo, etc. By clicking the triangle, you
can access these options; at the same time, you can drag this toolbar outwards more to
make more available space for these options directly on the toolbar.
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Formatting Toolbar:
: Anal 710 ~|Blg|§§§@|$°/u|§;il_--';»-&v é
1 8 8406 6 760 9N ®w Y ® W
Fig : 6.16 Formatting Toolbar

1. Font: This command will Change the font of the selected cell(s).

2. Size: This command will Change the font size of the selection.

3. Bold: This command will Put the selection in bold face.

4. Italics: Italicize the selection.

5. Underline: This command will underline the selection.

6. Align Left: This command will align the current selection to the left.

7. Center: This command will align the current selection to the center.

8. Align Right: This command will align the current selection to the right.

9. Merge & Center: This command Combine two selected cells into one new cell that
spans the width of both and center the contents of this new cell.

10. Currency Style: This command will Change the style in which currency is displayed.

11. Percent Style: This command will Change the style in which percents are displayed.

12. Decrease Indent: This command will decrease the indent of a cell by approximately

one character.

13. Border: This command add or alter the style of borders to format a cell.

14. Fill Color: This command will select a color to fill the background of a cell.

15. Font Color: This command will select a color to apply on the selected text.

—
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Fig : 6.17 Name Box & Cell

Cells can contain text, numbers, or formulas (don’t worry about formulas quite yet). To refer to
aparticular cell, you call it by its column letter, and then by its row letter. For example, the cell in
the uppermost left corner would be “A1. The current cell(s) will always be listed in the “Name
Box, which appears on the left below the toolbars.
Navigating the Spreadsheet:
You canuse the “Up, “Down, “Left, “Right, to move (one cell atatime)
throughout the spreadsheet. You can also simply click the cursor into a cell). The
AN SN R =NA N AAR - NS TN N

e width: 800 (61 pixels) |

| C D E | F
This text ig too long!

Fig : 6.18 Navigation Bar
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“tab button will move one cell to the right. The “Enter button will confirm the

entered information and move one cell down. If you enter text or numbers that span further than
the column allows, simply place your cursor on the line dividing two columns next to their respective
letters, and drag to the right or left until the desired width is achieved. You can also double-click
this dividing line to have Excel automatically choose the best width.

A Simple Spreadsheet:
A | B | ¢ | D |
1 Grade 1 Grade 2 Grade 3
2 |Student 1 93 100 a0
3 |Student 2 70 a0 85
4 |Student 3 90 100 100
5 |Student 4 g6 a8 90
6 |Student5 0 0 0

Fig : 6.19 Simple Spreadsheet

This is what a basic spreadsheet look like, keeping track of the grades for five
students. As you’ll notice, numbers automatically align to the right, while text
automatically aligns to the left. Room has been allowed at the top and the left for
column and row headings, which have been placed in bold.

Simple Formulas:
E2 v fe =(B2+C2+D2)/3
A I B I = I D I = |
1 Grade 1 Grade 2 Grade 3
2 |Student 1 98 100 BUI 92.67!
3 |Student 2 78 90 85
4 |Student 3 a0 100 100
5 |Student 4 o6 fatal 90
b |Student5h ] 0 0
Fig : 6.20 Formula of Average — Screen
E2 v £ =(B2+C2+D2)3
A | B [ ¢ [ b [ET]
| 1 | Grade 1 Grade 2 Grade 3
2 |Student 1 98 100 80) 92.67
3 [Student 2 78 S0 85] 84 .33
4 [Student3 90 100 100} 96.67
5 |Student 4 86 fatal 90 st}
6 |Student 5 0 0 0 0
7| —
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“02.67 was not entered as the contents for cell “E2. The “formulabar has the

following entered into it:

=(B2+C2+D2)/3

By following the normal order of operations, the contents of the three cells in parenthesis (B2,
C2, and D2) are all added to each other, and then divided by 3. This gives an average of the
three grades, which is then shown in the cell “E2 (where the formula was entered). If you
wanted to do the same for students 2 through 5, you would enter in similar formulas for each cell
from “E3 to“E6 replacing the column and row numbers where appropriate.

An easy method to replicate formulas is to select the cell which contains the original formula
(“E2 inthis case), click the bottom right corner of the selection box, and drag down several
rows (to “E6 in this example). The formula will be copied down in each cell, and will change
itselfto reflect each new row.

You can add more functions by selecting Insert=>Function 2>Max

In the same way you can insert Statistical, Financial, Date & Time, Math & Trig. , Financial etc.

Inserl Function

Search for & function:

Type a brief description of what you want to da and then Go
i fs

Or select a catagory: | Statistical v

Select-a function:

LOGINY A
| LOGNORMDIST
| MAKA 1
MEDIAN
MIN
MINA adl|
Max(number1,number2,..)
Returns the largest value in & set of values, Ignores logical values and text,

Halp oni this function L ok | [ Ccancal }

Fig: 6.21 Function Dialogue Box

'Book1

m Format Tools Dat

Ll Rows ]% Fig : 6.22 Insert Rows/Columns
Columns

Insert Rows & Columns:

\
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You may find that you need to insert a new, blank row where there isn’t a blank row any more.
To insert a new blank row, place your cursor directly below where you would like a new row.
Select Insert >> Rows.
To insert a new column, place the cursor in a cell directly to the right of where you would like the
column. Select Insert >> Columns.
Inserting and renaming a worksheet:

e Torename a worksheet double click the name tab and type the new name.

e Alternate you can right click the sheet tab and rename it.
We can also insert, delete, move, copy, etc by right clicking the sheet and selecting the options.

| Data | window _Help
3l ot |

—

Sorting:
Fig : 6.22 Data Sort Menu
One of Excel’s powerful features is its ability to sort, while still retaining the relationships among
information. For example, let’s take our student grade example

o
Sort by
| O ascendin
{Column E) v| & a
" (%) Descending
Then by
Grade 3 | O Ascending
Then by
v.f (%) Ascending
(O bescending
My data range has
(%) Header row () Mo header row
[ Options. .. ] [ OK ] [ Cancel ]

Fig : 6.23 Sort Dialogue Box
from above. What if we wanted to sort the grades in descending order? First, let’s
select the information we want to sort.
Now let’s select the “Sort  option from the “Data menu.

\
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Anew window will appear asking how you would like to sort the information. Let’s

E2 v A& =(B2+C2+D2)/3

A | B | ¢ | D | E|
1 Grade 1 _Grade 2 Grade 3
2 |Student 1 98 100 80 9267
3 |Student 2 78 90 85 B84.33
4 |Student 3 90 100 100 96.67
5 |Student 4 86 a8 g0 88
& [Student5 0 0 0 0

sort it by the average grade, which is in Column E; be sure to set by “Descending

order. If there were other criteria you wished to sort by as secondary measures, you could do so;
let’s select “Then by as “Grade 3 just for the practice of doing so

(“Descending order, as well).

E2 v A =(B2+C2+D2)/3

A B @ b B e
1 Grade 1 Grade 2  Grade 3
2 |Student 3 90 100 100 96.67
3 |Student 1 98 100 80 9267
4 |Student 4 86 88 90 88
5 |Student 2 78 90 85 8433
6 |Student 5 0 0 0 0

Fig : 6.24 Sorted List
Excel will sort your information with the specifications you entered. The results
should look something like this:
Pivot Table:

PivotTable and PivotChart Wizard - Step 1 of 3 L.?_JW
- ‘Whereis the data that you Want by analyzs?

(XiMicrosaft Office Excel list or database!

) Extemnal datasource

() Multiple consalidation rarigas

) another PivotTable report or PivotChart report

What kind of report do you wank to creata?
(&) PivotTable
C PivotChart report (with PivotTable report)

Cancql Bac) [ Next > ][ Elnvos‘h l

Fig : 6.25 Pivot Table Wizard

f
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f

Say you have a list of data as given in the worksheet. Open the worksheet now, the data

GG ||

save the girl chili

Rural Residents Survival SKkill Jobs(Sales Report-2010)
Sales in

Job Description State quantity

Kites Gujarat 10000

Pickles Gujarat 15000
Madhya

Woolen Sweaters Pradesh 12000

Paper Flowers Maharashtra | 18500

Glass Painting Frames | Gujarat 8500

Candles Maharashtra | 14500

Rakhis Gujarat 25000

Imetation Jwellary Rajasthan 12000

PivotTable and PivotChart Wizard -Step 2013 [

Vithere is the data that you want b Lse?
Range: PRSI ﬁ.: l Browse: |
Caneel cBark | | Mexts Frish |

Fig : 6.26 PivotTable Data Range
To create a Pivot Table, first highlight any cell in the data, then click on the menu Data -

PivotTable and Pivot Chart Report... You should see the following dialog.
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PivotTable and PivotChart Wizard - Step 3 of 3 2y

Whete da you want ta put the PivotTable repore?

(%) Mew warksheet
O Existing workshest

> —

——

(Click Finish to treate-your PivotTable report.

LLayout... ]] Cptions. ] [ Cancel ][ <Back: ] izt V,

Fig : 6.27 PivotTable Result Sheet selection Window

The Pivot Table Wizard dialog appears. For now, you want to analyze the data contained
in the Excel list, so click the Next button. This sends you to the next dialog, which shows
the range containing the data you wish to analyze. Excel automatically selects all the data

in a contiguous range about the highlighted cell that means this step is all done for you so
just click next.

PivotTable and PivotCharl Wizard - Layout

:l - o] |".' o Congtruct your PivokTabls report by
=ob dragging the fleld buttons on the right
i to the disgram on the left.

fab vescl
5aks in ql‘

[[pace | CoM

g

HOW. DALA

Fig : 6.28 PivotTable Layout Dialogue Box
The third dialog asks whether you want to put the pivot table on the existing worksheet

are on a new sheet. Do not click “Finish yet - select “New Worksheet then click the
Layout button.

The Layout dialog shows the headings across the top of your Excel list as buttons, which you can
use in your Pivot Table.
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PivotTable and PivotChart Wizard - Layout E]

Sk
! a— B =t Congthact your Potl able report by
> = dragging tre fiald butters an the right
to the diagram on the left

EAGE lab Cescr] COLUMN "

= [ = 0l e ﬂ'] COl

—  EEEEEREE '

of Sales In g4 ‘

W DaTA
[ I o J[ cored

Fig : 6.29 PivotTable Final Selection Layout Dialogue Box

You can click-and-drag the buttons on the right of the form to any of three areas on the Pivot
Table. The Page area will be explained later. For now, drag “State to the Row area, “Job
Description to the Column area, and “Sales to the Data area. Your dialog should look like this;
Click Ok, then click Finish. You now have a Pivot Table that summarizes your data.

Sum of Sales in
quantity State
Madhya Grand
Job Description Guijarat Pradesh Maharashtra Rajasthan Total
Candles 14500 14500
Flower Making 18500 18500
Glass Painting Frames 8500 8500
Imetation Jwellary 12000 12000
Kite Making 10000 10000
Pickles 15000 15000
Rakhi 25000 25000
Woolen Sweters 12000 12000
Grand Total 58500 12000 33000 12000 115500
Cell Formatting:

You may notice that, by default, Excel will leave as many decimal points as possible
within the cell’s width restraints; as you increase the cell’s width, the number of
decimal points increases.

A | B | ¢ | D | E |
1 Grade 1 Grade 2 Grade 3
2 |Student 3 g0 100 100 96.6666667
3 |Student 1 98 100 80 92 6EEERET
4 |Student 4 a6 fais) S0 88
5 |Student 2 78 90 B85 B84.3333333
6 |Student5 0 ] ] 0

Fig : 6.30 Formatted Sheet

¢
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Select “Cells from the “Format menu. A new window will appear with a wide variety of ways
in which to customize your spreadsheets.

For example, if we wanted to set the percentages fixed to only two decimal points, you can make
this selection under the “Number  category within the “Number tab. You can also set the formatting
for things such as the date, time, currency, etc. The “Font tab will also allow you to change the
default font used on the spreadsheet. The other tabs provide even more ways to customize your
spreadsheet and its appearance; experiment with the settings to see what works best for you.
Chart Wizard:

Excel allows you to create basic —to — intermediate charts based off of information

and data within your spreadsheets. Let’s create a column chart from the student

grade data from before. First, highlight the data.

A | B | ¢ | D | E
1 Grade 1 Grade 2 Grade 3
2 |Student 3 90 100 100 96 . 6EEEEEET
3 |Student 1 98 100 a0 92 6EERREET
4 |Student 4 Faa) aa 90 aa
5 |Student 2 78 90 85 84.33333333
B |Student b 0 0 0 D-

Fig : 6.31 Data for Chart

Next, select “Chart from the “Insert menu.

Chart Wizard - Step 1 of 4 - Chart Type &

Standard Types | Custom Types

Chart type: Chart sub-type:

[nd Column ~
5 ntf it

»2 Line
et Book1
ez %Y (Scakter) ﬂ I l =

A

'@‘DZ;M m |“|L|| JERl 5
iy Radr 2OWS
& Surface |
25 Bubble v 4 Columns

Insert | Format  Toole  Da

Clustered Column, Compares values across Worksheet
categories, - - Lamaa .
1
Wil Chert.., \
[ Press and Hold to Yiew Sample |
(o) (o]

Fig : 6.32 Insert Chart Menu
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A new window will appear asking which type of chart you would like to create. For this example,
let’s do a basic pie chart. Select “Column from the “Chart Type on the left side, and pick the
first sub-type on the right (a normal, 2D column chart).

Fig : 6.33 Chart Type Selection Box

Chart Wizard - Step 2 of 4 - Chart Source Data ij
Data Range Series

0

0o

Grede s Grede 2 Grads

Qatarange: | =Sheet1AS1:4ESS é]
Series in: @ Rows

O Columrs

[ cancel ][ <pock [ pe> ][ Bosh |

Fig : 6.34 Chart Source Data Box
Click “Next. Inthis window, you’ll be asked to select your “datarange ; this is the area of your
spreadsheet that you wish to generate a chart from. Since you’ve already selected the area
before, it should already be entered into the appropriate area. “Series in allows you to choose
by which value you want to arrange the chart. Let’s arrange it by rows; this will break it down by
“Grade (suchasTest 1, Test 2, etc.) and comparing the student scores next to each other.

‘Chart Wizard - Step 3 of 4 - Chart Options L_?_J

Titles |  Axes Gridlines. | Legend | Datalabels | PataTable |
Chart title:
Comparing Students Scores Comparing Students Scores

Categary (x) aiis: 120

o Student
® Student 1
O Student
0 Student
| Student 5|

Yalus () axis:

Grade ! Grade2 Graded

[ cancel |[ <gack [ mext> | [ Fnsh |

Click “Next. In step three you can give the chart a name (“Chart Title ), label the X and/or Y
axis, etc.
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Click “Next. The final step will ask whether you want the chart as an object in your current
spreadsheet or in a new one; generally, you will place it within the same spreadsheet.
Click “Finish, and your chart will appear in your spreadsheet!

Fig : 6.35 Chart Options Box

(C hart Wizard - Step 4 of 4 - Chart Location
Place chart:
l._l_ O Asnewsheet:  Chartl
i () As abject in: Sheeti ZJ
[ Cancel ] [ < Back ] Me

Click “Finish, and your chart will appear in your spreadsheet!
Fig : 6.36 Chart Location Box

B Microsoft Excel - Book1
i8] He Edt Vew Inset Format ook Chat  Window Help
RGN WENES =N Ra R % - ol |Gl @ Eéf‘"a'

Chan 1 v 5~
A = | € [ D E I=E={=0

1 Grade 1 Grade 2 Grade 3 |

2 [Student3 90 100 100 956666566

3 |Student 1 98 100 80 92 66665667

4 |Student 4 86 88 90 88
|5 |Student 2 78 90 85 84.33333333

6 (Student 5 0 0 0 0

7
i L]

9 Comparing Students Scores

10

11

12 120

7:3 100 4
15 a0 @ Student 3
16 | 5 m Student 1
17 60 A O Student 4
18 9
T 0. O Student 2
o m Student 5
20 20

21
% 0 , : .

2d el G 2

5 Grade 1 Grade2 Grade3

25 n

Fig : 6.37 Column Chart - Screen
Pie Chart:
The above comparison of students score can also be displayed with the help of Pie Chart.

\>
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Student 1

@ Grade 1
m Grade 2
O Grade 3

Fig : 6.38 Pie Chart - Screen
Saving a workbook:
To save the workbook for future use:
e Select File from menu bar and then click Save As.
e Or press the save button in the standard toolbar.

d MS Access:

Microsoft Access is a computer application
used to create and manage computer-based databases on desktop computers and/or on connected
computers (a network). Microsoft Access can be used for personal information management
(PIM), in a small business to organize and manage data, or in an enterprise to communicate with
servers.

What is a database? It is an organized collection of data. A database management system
(DBMS) such as Access, FileMaker Pro, Oracle or SQL Server provides you with the software
tools youneed to organize that data in a flexible manner. Microsoft Access provides users with
one of the simplest and most flexible DBMS solutions on the market today. Regular users of
Microsoft products will enjoy the familiar Windows “look and feel as well as the tight integration
with other Microsoft Office family products. Further, let’s first examine three of the major
components of Access that most database users will encounter - tables, queries, forms.

Tables:

\>
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MS Access Utility:

Microsoft Access is available with the Microsoft Office Professional suite of business products
therefore no additional database software is required if your company purchases computers with
this suite of products already installed.

Microsoft Access 2007 database is likely to be available and supported for years to
come because Microsoft is the premier software company in the world.

MS Access is the most widely used desktop database system in the world.

If database support is important to you then Access may be your best choice since
Access has more support and development consultants than any other desktop database
system.

Microsoft Access is significantly cheaper to implement and maintain compared to larger
database systems such as Oracle or SQL Server.

Microsoft Access consulting rates are typically lower for Access consultants compared
to Oracle or SQL Server consultants.

Fairly complex databases can be setup and running in 1/2 the time and cost of other large
database systems (the simpler the database the greater the cost advantage).

Microsoft Access integrates well with the other members of the Microsoft Office suite of
products (Excel, Word, Outlook, etc.).

Other software manufacturers are more likely to provide interfaces to MS Access than
any other desktop database system.

When designed correctly, Access databases can be ported (usually with some difficulty)
to SQL Server or Oracle. This is important if you want to start small or develop a pilot
database system and then migrate to the larger database management systems.

A Microsoft Access system can be placed on a website for access for remote users.
Simple screens can be developed within Access, Data Access Pages. Or full control and
functionality can be implemented using Active Server Page (ASP) programming. Note
that you still have the same simultaneous connection limitations described above.

Starting with MS Access:

Fig : 6.39 Steps to open MS-Access
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Creating a data table.
To create a data table we need to position ourselves in the database window with the Tables
object selected, if we click on the New button  <{pjei

It opens a window with the various available ways of creating a new table:
e Datasheet view consists of directly introducing the data into the table, and

according to the value introduced into the column determines the type of data that
the column has.

e Design view is the method we will detail in this unit.

e Table wizard guides us step by step in the creation of the table using a
predetermined sample table.

e Import table consists of creating a new table from an existing one in another
database.

e Link table consists of creating a reference to another table stored in a different

database.
Next we will explain the way to create a table in design view. This method consists in defining
the structure of the table i.e define the different columns that it will contain as well as other

considerations such as codes, validation rules etc...

[ Microsoft Office Access 2009 - [AULACLIC - Data. .. | =) 03
‘M1 Fle Edt View Insert Tools  Window Help -8 X
SHR Mo Wie N 7 e . R

([H@pen &L Desion TiNew | | 2o T

s

Obpcts || [Erastetable st et
Tables I BI] Creats table by using wizard
EI:] Create table by entering data

EH  Quetiss
Forms
B Reports
ﬁ‘] Pages
2 Macros
&

Modules

Graups

-

Ready NLIM

Fig: 6.40 Create Table Design window
Another way to arrive at the design view is from the Database window with the Tables object
selected then double clicking on the option Create table in Design

\
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In the title bar we have the name of the table (as we have still not assigned a name to the table,
Access has assigned a default name Tablel.

Next we have a grid where we define the columns (fields) that compose the table using a line
for each column, so in the first row of the grid we will define the first column of the table, in the
second row of the grid we will define the second column of the table and so on and so on.

At the bottom left we have two tabs (General and Lookup) to define the properties of the
field i.e additional characteristics of the column we are defining.

And on the right we have a box with text to help us with what we need to accomplish.
Creating data tables (II)

We will fill in the grid defining each of the columns that compose the table:

e bit
| FisldName |  DataType | Description ~|
P | aulaclic_riumber Number Client's numbst (=]
aulaclic_name Text Client's name
aulaclic_date DatefTime First date o
Field Properties
General | Lapkup
Field Size Long Integer
Farmat
Decimal Places Auto
Input Mask The size and type of numbers to
Capticn ‘ enterin the field, The most
Default Yalug 0 common settings are Double and
Validation Rule Lona Integer. IF joiring this feld
validation Text to 3 Autohumber Field In & tmany-
Required INa ta-one refationship, this field
Indexed Na must be Long Integer.
Smart Tags

Fig : 6.41 Table Design & Field Properties Box
In the first row write the name of the first field, and by pressing the ENTER key we move to
Data Type column, which by defect will be Text. Should we choose to change the type of
data, click on the arrow of the drop down list and select another type.

AV_l

Memo

Number
DatefTime
Currency
Autohumber
YesiNo

CLE Object
Hyperlink
Lookup Wizard.,

'When creating a table, one will need to specify what kinds of data are to be

stored in this field.
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The different kinds of Access 2003 data are:

Text: allows for the storage of any kind of data, characters, digits and special characters. It has
a defect length of 50 characters with a maximum length of 255. It is normally used to store data
such as names, addresses, or any number not used in calculations, like telephone numbers or
zip codes.

Memo
Number
Diate/Time
currency
AutoNumber
Yes{No

OLE Object
Hyperink
Lookup Wizard, .,

Fig : 6.42 Data Type Selection Box

Memo: is used for texts of more than 255 characters such as comments or explanations. It has
amaximum length of 65.536 characters. Access recommends that to store formatted text or
large documents, rather to create an OLE Object field than a Memo field. In Access2003 it is
possible to arrange or group in a Memo field, but Access only uses the first 255 characters
when it arranges or groups in a Memo field.

Number: for numerical data used in mathematical calculations. Within the number type we are
able to specify the size property of the field. The types Byte, Integer and Long Integer allow
the storage of numbers without decimals; the types Single, Double and Decimal allow decimals;
the type Replication ID is used for auto numerical codes in replication databases.

Date/Time: for the introduction of date and time from the year 100 to 9999.

Currency: For monetary values and numerical data used in mathematical calculations in which
the data involved contains between one and four decimals. The accuracy is up to 15 digits to
the left of the decimal separator and up to 4 digits to the right of the same. Access recommends
the use of Currency type to avoid the rounding off of numbers in calculus. A Currency field
has an accuracy of up to 15 digits to the left of the decimal separator and 4 digits to the right. A
Currency field occupies 8 bytes of space on disc.

Autonumber: aunique sequential number (increasing one by one), or an aleatory number that
Access assigns every time it adds a new record to a table. Autonumber fields can not be
updated.

Yes/No: Yes and No values, and fields that contain one of two values (Yes/No, True/False or
Acivated/Disactivated).

OLE Object: an object such as a Microsoft Excel spreadsheet, a Microsoft Word document,
graphics, images, sounds, or other binaries.

Hyperlink: text or a combination of text and numbers stored as text and used as a hyperlink
address. A Hyperlink is a text or graphic that you click to go to a file, a location in a file, a web
page on the Internet, or a web page on an intranet. Another possibility exists which is the
Lookup wizard... which creates a field that allows you to choose a value from a list. Access
can fill the list with values from a table or with values you type.
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When we choose a type for the data, at the bottom of the window, the Field properties
section is activated so as to be able to indicate more characteristics for the field,

Press ENTER next to go to the third column of the grid.

It is not necessary to use this column as it only serves to write comments; usually a description
of'the field for the person who will be introducing data so as to know what to write, this comment
will appear on the status bar on the data page.

Repeat the process until all the fields (columns) in the table have been defined.

The primary key
Before saving the table we need to assign a primary key.
The primary key provides a unique value for each row in the table and serves to identify
the records in such a way that with this key we can be sure of not mistaking the record being
identified. In a table we can not define more than one primary key, but we can have a multiple-
field primary key (one primary key defined on several fields.
To assign a primary key to a field follow these instructions:

e Click on the name of'the field that will be the primary key.

e Click on the Primary key button § on the toolbar.

e On the left of the field name will appear a key indicating to us that this field is the

primary key of the table.
e Ifwe wantto define a multiple-field primary key (based on various fields), hold
down the Ctrl key and click on all those fields, then click on the button.

Important: Remember that a field or group of fields forming the primary key of a table cannot contain
null values and neither have two rows in the table with the same value in the primary key fields.
Saving a table.
To save a table we need to:

¢ (o to the File menu and select Save.

e Orclick on the Save button on the toolbar.
As our table does still not have a name, the following dialogue box will appear:

Table Name: | oK J
Taeint m——— Fig : 6.43 Save Table Dialogue Box

Cancel

Write the name of the table. Click on the OK button.
If we have not assigned a primary key before saving  the table, a dialogue box will
appear advising us of this, and asking whether we would like Access to create one like the
below figure:

\
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There is no primary key defined.

primary key for vou to define a relationship between this table and other tables in the
database.,
Da you want ko create-a primary key nowy

'E Although & primary key isn't required, it's highly recommended. A table must have a
L4

[ Yes | 1 Na ' [Cancel |

Fig : 6.44 Primary Key Dialogue Box

If we decide Yes, it will create a Autonumber field and will define it as the primary key.

If we decide No, the table is saved without a primary key, a primary key is convenient but not
obligatory.
Closing a table.

To close a table, follow these steps:

¢ Go to the File menu and select the Close option.

e Or, click in the Close button in the Database window.
We can also create relationships between the tables that are of same category

Creating the first relationship
To create relationships in Access2003 firstly we need to position ourself in the Relationships
window, we can opt for:

Database window, drop down Tools menu, and select Relationships... option, or, Click on
the button on the toolbar.

Fig : 6.45 Relationship Menu

The Show table dialogue box will appear:
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e (Click on one of the tables required in the relationship and click on the Add button; or
double-click the name of'the table.

e Repeat the previous step to add the second table, and so on.

«  Finallyclick on the Close button to] 23! finish adding tables.

Tables | Queries | Both 7 |Il
Custnmers ' | Clase l

Invoices
States
Tabletl

Fig : 6.46 Selection of Table for Relationship
Now the Relationships window will appear with the tables added before.

25 Relationships =Joks
|~
iMamber . Number
iName Date
IId Customer
1Street
!City
lZu:tCodE
State
v
<l >

Fig : 6.47 Relationship Window
To create the relationship:

Drag the field of the principal table to the equivalent field in the related table. In our case drag
Number (in Customers table) to Customer (in Invoices table).

Normally you drag the primary key of the primary table.

To relate tables with two or more fields, first select the fields mantaining CTRL key down, and
then drag them.
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The Edit relationships dialogue box appears next:

Edit Relationships Z
TablejQusry; Related TablefQuery;
G |
Number | & | Customer |~ Lﬁj
= | Join Type..
| W
s .y
[_1Enforce Referential Intagrity @
Relationship Type: Cne-To-Many

Fig : 6.48 Edit Relationship Dialogue Box

At the top should be the names of the related tables (Customers and Invoices) and below this
the names of the related fields (Number and Customer). Observe! they always have to be the
same kinds of fields containing the same types of information.

Observe at the bottom the Relationship type assigned depends on the charateristics of the
related fields (in our case One-to-Many)

Activate the Enforce Referential integrity by clicking on it.

If desired, the boxes Cascade Update Related Fields and Cascade Delete Related
Records can be activated.

To terminate, click on the Create button.
The relationship is created and will appear in the Relationships window.

25 Relationships .=

Fig : 6.49 Relationship created Window

7
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MS Outlook:

Microsoft Outlook is the email client included with the Microsoft Office suite. It is designed to
operate as an independent personal information manager, as an Internet mail client, or in conjunction
with the Microsoft Exchange Server for group scheduling, email, and task management. It manages
email, calendars, contacts, tasks, to-do lists, and documents or files on the hard drive, a journal
and web browsing. Outlook helps you communicate through email, phone support, and group
scheduling capabilities. Outlook also helps you share information by means of public folders,
forms, and Internet connectivity.

The information can be found easily with Windows shortcuts, which let you navigate to any
private, public, or file system folders. Outlook Journal helps you find a document based on
creation date and name. Outlook lets you arrange information any way you want to see it. You
can apply any of Outlook’s standard five views to information, or you can customize a view using
the Field Chooser and Group by Box features.

Azl ~

Fig : 6.50 MS-Outlook - Screen

Starting with MS outlook:

Step 1
To begin using Microsoft Outlook, simply click on the “Start button, choose “All Programs
and navigate to the Office 2003 folder.
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Step 2

Click on the “Microsoft Office Outlook 2003 icon to launch the program. When the program

window is displayed, click on the “View menu and select the “Navigation Pane to make sure

that it is displayed correctly.

Step 3

To create new messages, proceed to the next step. To retrieve messages, jump to Step 6. For

adding attachments, go to Step 8. If you want to access contacts, skip to Step 12.

Step 4

Select the Click the new button available on the toolbar options. Click the intended recipient’s

name on the left side and click the “To option to copy it into the “To field of the message.

Step 5

Type the preferred message subject in the corresponding box. The white space is where the

body of the message can be typed in. When finished, simply click on the “Send button and your

message is on its way. You can also check for spelling errors before sending by choosing the

“Tools menu and clicking on the “Spelling option.

Step 6

In retrieving messages, click on the “Tools menu, select the “Send/Receive category, and choose

“Send/Receive All . You can alternatively click on the “Send/Receive tool.

Step 7

After receiving the messages, simply click on it to display its contents in the reading pane. Double

clicking a message will open its contents in a separate window.

Step 8

To add an attachment to a message, click the “Insert File button on the toolbar.

Step 9

Browse for the file to be attached, click on the file, and click the “Insert button. Remember to

limit the size of the file in order to avoid any potential problems during transmission.

Step 10

To save areceived file attachment, double click the message and select the “File menu and click

on the “Save Attachments option. Click the “OK button.

Step 11

Choose the folder where the file will be saved and click the “OK  button. You can choose to

modify the name of the file to be saved.

Step 12

To access your contacts list, click on “Go and selectthe “Contacts option. Click on the “Actions

and choose the “New Contact category to add a new contact to your list.

Step 13

Click on the appropriate fields to input relevant details into the Contact Card. Click the “Save

button and close the window.

Step 14

To edit the Contact Details, double click the contact to open the Contact window. Make the
(_appropriate changes to the correct fields. Click on the “Save and “Close option.

\
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Most Important accessories available with Windows operating system
by default:

MS Calculator:

Windows Calculator, commonly known as Calculator from the application’s title bar, is a calculation
application included in all versions of the Microsoft Windows operating system. It can be activated
by the command “calc on most Windows systems.

Fig : 6.51 Calculator
By default, the application is in the “Standard mode, and functions as a four-function calculator.
More advanced functions are available in “Scientific mode, including logarithms, numerical base
conversions, some logical operators, operator precedence, radian, degree and gradians support
as well as simple single-variable statistical functions. It does not provide support for user-defined
functions, complex numbers, and storage variables for intermediate results

How to use Microsoft Calculator:

The Microsoft calculator performs the same functions as any actual, physical calculator.

To use a Microsoft Calculator:

Step 1-Click the left mouse button on the “Start button on your computer desktop.

Step 2-Move the pointer so that “Programs is highlighted.

Step 3-Move the pointer so that “Accessories is highlighted.

Step 4-Click the left mouse button on “Calculator .

Step 5-Use the left mouse button to click on the calculator’s numbers and math function buttons
in the same way that you would use an actual calculator that you could hold in your hands. You
can also type in the numbers on your

Address Book:

Windows Address Book is a component of Microsoft Windows that lets users keep a single list
of contacts that can be shared by multiple programs. It is most commonly used by Outlook
Express. The Address Book provides a convenient place to store contact information for easy
retrieval by programs such as Microsoft Outlook Express. It also features access to Internet
directory services, which you can use to look up people and businesses on the Internet. You’ll

N
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find that the following features help you organize all your contact information into the most usable
form for you.

Store important information about the people and groups who are important to you

With your Address Book, you have a place to store e-mail addresses, home and work addresses,
phone and fax numbers, digital IDs, conferencing information, instant messaging addresses, and
personal information such as birthdays or anniversaries. You can also store individual and business
Internet addresses, and link directly to them from the Address Book.

Find people and businesses by using Internet directory services

Directory services are powerful search tools that enable you to look up names and addresses on
the Internet. The Address Book supports Lightweight Directory Access Protocol (LDAP) for
using Internet directory services.

Create groups of contacts for mailing lists

You can create groups of contacts to make it easy to send e-mail to a set of people, such as
business associates, relatives, or friends. Any time you want to send e-mail to everyone in the
group, just use the group name instead of entering each contact individually. Creating groups is
also a good way to organize a large Address Book.

Share your Address Book with other users

By creating an identity for every person who uses the Address Book, each user can organize
contacts into his own folder. In addition, each user can put contacts into a Shared Contacts
folder so that other identities can use them.

Import names from your other address books

Moving forward with Outlook Express doesn’t mean leaving your old address book information
behind. You can import your personal address books from numerous popular e-mail programs.

Send and receive business cards

Business cards are the new way to send contact information electronically. When you create a
business card in the Address Book, the contact information is stored in vCard format, so it can
be exchanged between different programs (such as e-mail, address books, and personal planners),
and between different digital devices (such as desktop computers, laptops or portable computers,
personal digital assistants, and telephony equipment).

Print all or part of your Address Book and take it with you

We can also print our Address Book to add to our personal planner. With three page styles to

N
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choose from, we can print all contact information, only business information, or only phone
numbers, for any or all contacts.

(C) Today, computers are used in a Career courses — Add more mileage
to your career

Computer Science or Information Technology is the fastest growing career

field in India Imost every aspect of our lives. Computers are used in car engines,
microwave ovens, watches, telephones, mainframe computers in government and

industry, and supercomputers expanding the frontiers of science and technology.

As a result, the computer industry is one of the fastest growing segments of our
economy. Now more than ever, there is a demand for trained professionals with the
scientific and technical training necessary to perform effectively on the job. Now is

the time to plan your future in computing.

Most professionals in the computing industry have at least an undergraduate degree
in mathematics, computer science, computer engineering, software engineering,

information systems, or electrical engineering. Many have advanced degrees.

Now, with the convenience of online colleges that offer online computer degree
programs, more people are being trained for a career in computers from the
convenience of their homes. Colleges and online schools offer a variety of degree

and certification programs in computing.
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7. Text editing softwares, Desktop publishing Softwares and
Language Softwares

Text Editing Software

A text editor is a type of program used for editing plain files. Text editors are often provided
with operating systems or software development packages, and can be used to change
configuration files and programming language source code. It is a computer program that lets a
user enter, change, store, and usually print text. Typically, a text editor provides an “empty

display screen with a fixed-line length and visible line numbers. You can then fill the lines in with
text, line by line. A special command line lets you move to anew page, scroll forward or backward,
make global changes in the document, save the document, and perform other actions. After

saving a document, you can then print it or display it.

WordPad

WordPad is a basic word processor and a text editor that is included with almost all versions of
Microsoft Windows from Windows 95 upwards. It is more advanced than Notepad but simpler
than Microsoft Works Word Processor and Microsoft Word. It replaced Microsoft Write.

Microsoft Word is able to create, edit, and save their documents as a plain-text file (.txt), Rich
Text Format (.rtf), and Word for Windows 6.0 (.doc) format.

Features

WordPad can format and print text, but lacks intermediate features such as a spell checker,
thesaurus, and support for tables, graphics, books or manuscripts.

WordPad natively supports the Rich Text Format. WordPad for Windows XP added full Unicode
support, enabling WordPad to support multiple languages. It can open Microsoft Word (versions
6.0-2003) files, although it opens newer versions of the .DOC format with incorrect formatting.
Microsoft has updated the user interface for WordPad in Windows 7, giving it an office 2007-
style ribbon that replaces the application menu and toolbars. Other bundled Windows applications
such as Paint have had similar changes of

Fig : 7.1 WordPad-Screen
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To create a Document using WordPad:

Step 1

Launch WordPad on the computer by bringing up the “Start menu and selecting “All Programs.
From here select “Accessories-> WordPad. The program will open to a new document window
with a standard text field. The flashing cursor in the field indicates where the text will appear
when typed.

Step 2

Set the desired formatting for the text in the dropdowns above the ruler. Here you can choose
font, style, size and other options for your text. More comprehensive text formatting can be done
from the “Format selection in the Toolbar.

Step 3
Type the text. You can adjust the indentation on your text by clicking and dragging the lower
carrot with the square below it on the left-hand side of the ruler.

Step 4
Highlight any text that you would like to re-format or format differently by clicking and dragging
along it and adjusting the format fields as necessary.

Step 5
Save your document by selecting “File->Save from the Toolbar. Enter a name and location for
the file and click “Save.

Notepad:

Notepad is a simple text editor for Microsoft Windows. It has been included in all versions of
Microsoft Windows since Windows 1.0 in 1985.

Notepad is acommon text-only (plain text) editor. The resulting files—typically saved with the
Ixt extension—have no format tags or styles, making the program suitable for editing system files
that are to be used in a DOS environment.

Notepad supports both left-to-right and right-to-left based languages, and one can alternate
between these viewing formats by using the right or left Ctrl+Shift keys to go to right-to-left
format or left-to-right format, respectively.

\
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One notable feature of notepad is that it does not support formatting of any kind if text/rich text
is copied from a web page and pasted into it a notepad does not support formatting of any
picture or graphics or 3D pictures in it.

Early version of the notepad offered only the most basic function, such as finding text. Newer
versions of Windows include an updated version of Notepad with a search and replace function.
Up to Windows 95, Fixedsys was the only available font for Notepad. Windows 4.0 and 98
introduced the ability to change this font. In Windows 2000 and XP the default font was changed
to Lucida Console.

Up to Windows Me, there were almost no keyboard shortcuts and no line counting feature. Starting
with Windows 2000, shortcut for common tasks like new, open and save were added, as well as a
status bar with a line counter is available(only when the word wrap is disabled.

Notepad has a built - in simple logging function, which simply inserts a new timestamp each time the
file is opened. To activate this feature, the first line of the text file must be “.LOG without quotes.

[T —— EE%
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GREAT LEADERS OF INDIA

India is a land of great political leaders who ruled the country effectively and also by
protecting its national interest, It was not an easy task to accomplish, keeping in view
the changes taking place in the world political scenario. Leaders like Pandit Jawaharlal
Nehru. Lal Bahadur Shastri and Indira Gandhi Bose played an indispensable role in
changing the perspective of world towards India. The manner, in which issues like border
disputes, Kashmir and growing shortage of food grains were handled, they really
deserve an honor. The far-sightedness and pragmatic characteristics of the leaders can
be assumed from the fact that they framed the Constitution of India by inducting the
best possible clauses of the world. They led the country from the front, without being
showing any inclination to either of the power blocs. To know more about the political
leadlers of India, read the brief biography of the Indian political leaders.

Fig : 7.2 Notepad -Screen

User Interface

Notepad has one of the simplest user interfaces of any Internet Web authoring tools. Other
Web tools have overly-complex interfaces that hamper your use of the software.

The menus are logically laid out, conforming to all standards in design, so you can understand
them before you ever use Notepad. The five menus provide you with more than all the options
you need to create and edit the finest HTML code.

Notepad has the same interface for all versions of Windows, so moving over to the latest
version of Windows should not hamper the HTML code creation. The editing window is
designed to provide the user with the maximum view of the HTML or JavaScript code,
consisting of just two simple to use scroll bars and a menu line.

Notepad also has the facility to wrap your HTML text over to the next line, making it easy to
read and edit.

Compatibility with Web standards

The Notepad web authoring tool is compatible with every single standard of Internet presentation
medium yet devised. As a bonus, Notepad is also compatible with all future developments in
HTML and any other Web based presentation medium. This functionality is included as standard,
and at no extra cost.
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Small memory footprint

Notepad was designed to have a very small application footprint, taking up as little space as
possible in your computer’s memory, and a minimum of disk space. In fact, when you install
Notepad, you will not even notice the disk space decrease.

When you use other Web authoring tools and HTML “editors , large chunks of memory and
system resources are consumed, and sometimes not even returned when closing the
applications down. This means that you often cannot run a web tool and a Web browser at the
same time, because of memory constraints.

Notepad can be run in the background, no matter how little memory you have available. If you
can run a web browser, you can run Notepad simultaneously.

Clear presentation of HTML

Notepad gives you clear, easy to read and full HTML. There is no code hidden, and you have
control over all parts of the HTML code.

JavaScript is also fully supported by Notepad. All parts of the JavaScript are fully available
through Notepad, without the need of complex tools.

Desktop Publishing softwares:

It creates publication documents on a computer for either large scale publishing or small scale
local multifunction peripheral output and distribution. The desktop publishing software include
software for making greeting cards, calendars, banners, news letters and other crafty print projects
as well as all the peripheral programs for handing fonts, graphics, and later Web design. It also
resulted in a wider range of low-cost, easy-to-use software that didn’t require traditional design
and prepress skills to understand and use. There are many companies that create Desktop

publishing software:

Adobe - Adobe FrameMaker, Adobe InDesign, Adobe PageMaker
Corel - Corel Ventura

Microsoft - MS Office Publisher

Quark - Quark express

- Serif PagePlus

\S
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Adobe PageMaker:

PageMaker is a desktop publishing (DTP) application that allows you to create publications
such as brochures, newsletters, letterhead and more. Its specialty is combining text (created in a
word processing program such as Word or WordPerfect), and images (created in an image
program such as Photoshop or Illustrator) together in a professional-looking document. In addition,
you can easily convert the completed project into Portable Document Format (PDF) so you can
use it electronically.
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Fig : 7.3 Adobe PageMaker - Screen

To open Adobe PageMaker:

On the PC computers:

START > PROGRAMS > ADOBE > ADOBE PAGEMAKER 6.5 > ADOBE PAGEMAKER
6.5

On the Macintosh computers:

APPLE > APPLICATIONS > ADOBE PAGEMAKER 6.5

The Menus

7 Adobe PageMaker 6.5 - [Untitled-1]

Eﬂ. 3. it '

Fig : 7.4 MenuBar
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The following is a list of the menus located on the horizontal toolbar and a brief description
of'the items contained in that menu item.

File—Create a new file, open an existing file, select a recent file, save, save as, revert, place,
acquire, export, manage links, change document or printer settings,and change the preferences.
Place is used to link files from an outside source, 1.¢., graphics or text. When the original files are
changed, linked files will automatically change. Acquire is similar to import.

Edit—Contains the Cut/Copy/Paste functions, select functions, Edit Story and Edit Original.
Editing story is a separate function that is active when editing text from a word processing
application. When you are in edit story mode, the menu changes and return to layout select Edit
Layout.

Layout—Contains Go to Page, Insert/Remove page, Sort Pages, Go back/forward, Column
Guides, Copy Master Guides and Auto flow.

Type—Change Font, Size, Leading, Type Style, Expert Tracking, Horizontal Scale, Character/
Paragraph/Indents & Tabs/Hyphenation properties, Alignment, Style and Define Styles.

Element—Change Fill, Stroke properties, Frame properties, Arrange how objects/ Text are
stacked, Align objects, Text wrap, Group, Ungroup, Lock position, Unlock, Mask, Unmask,
Image Properties, Polygon Settings, Round Corners, Link info, Link Options, Non-Printing and
Remove Transformation.

Utilities—Plug-In options used to perform various tasks. Plug-Ins can vary depending on how
PageMaker was loaded. Find, Find Next, Change, and Spelling are used when in Edit Story
mode.

View—Zoom options, Ruler options, Guides, and Grids. There are several preset magnifications
in PageMaker, which allow you to view your work, the page or the desktop with simple shortcut
keys.

e The default view is “Fit in Window. The shortcut for this view is Ctrl +0

e Tozoom in to your work you would use “Actual size. The shortcut for this view is Ctrl
+ 1 (one)

e The final preset view is “Entire Pasteboard. The Pasteboard is the complete work area,
similar to a drafting table. All the elements you want to bring onto your document can be
placed on the pasteboard and later added to your document. The items on the pasteboard
will NOT print but are available for all pages. This makes designing your document
easier. -
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Window—When an option is picked, a palette is displayed for the corresponding choice.
Help—This menu provides the help search engine. It also provides a shortcut key menu that can

be printed.

Toolbox and Palettes

Once you begin a new file, this is the default view for your brochure.
There are three default palettes in PageMaker.

- The Toolbox Palette

Fig : 7.5 ToolBar
The Color/Style Palette
- The Control Palette

Toolbox
The Toolbox palette is where you will find the tools you will use in PageMaker:

1.

e S A

9.

Pointer tool—select, move and resize text boxes and graphics
Rotate tool—used to select and rotate text boxes and graphics
Line tool—used to draw straight lines in any direction
Rectangle tool—used to draw rectangles and squares

Ellipse tool—used to draw ellipses and circles

Polygon tool—used to draw polygon shapes

Hand tool—used to navigate the desktop and test hyperlinks
Text tool—used to type, select and edit text

Crop tool—used to trim graphics

10. Constrained line tool—used to draw vertical or horizontal lines.
11. Magnify tool—used to magnify or reduce the area viewed
12. Frames—used to draw placeholders for text or graphics

\>
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Color/Style Palette
The Color/Style Palette actually contains two palettes:
The Color Palette is used to apply colors or to view the color of selected text or objects. To
change the color of an object, select the object, select stroke, fill or both then select the color.
You can add additional colors to your selection by loading the colors or selecting a color palette
on the color options.

Fig : 7.6 Color Palette
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The Style Palette is used to determine the style of a paragraph and to apply or change the style of
text. Styles can be part of PageMaker or they can be imported from a word-processing application
(Indicated by the floppy).

Fig : 7.7 Style Palette

Control Palette
There are 4 types of control palettes:
1. The default control palette is the location view.

|

2. When you are using the text tool, the palette changes to character view. In this view
you can change fonts, size, leading, and other text options.

Times New Raman | |

3. To view the paragraph options, select the paragraph icon. In this view you can change
the alignment, indent and other paragraph options.

\>
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4. When an object is selected the palette changes to object view. This view gives you
options
to change aspects of the object.

-
% 2000 P o oo

Fig : 7.9 Document Setup - Screen
To create a Simple Brochure using PageMaker:

1. Decide on a design. Most brochures that are printed on 8 /2-by-11 inch paper use three
columns. If you use legal-sized paper, you will have room for four columns. If you will be
using photographs, graphics or charts in your copy, decide if you want the text to wrap
around the photo. Choose fonts for texts and headlines. You may want to experiment with
several sample designs to decide which layout works best for your brochure.

1. Click on the PageMaker icon on your desktop, then select “File and “New to open a new
document. The document setup box will pop up. Enter the number of pages youneed. For a
brochure, you will select two pages, as the brochure will ultimately be printed on both sides
of'the paper. Margins can also be set in this box. You will probably want to select somewhat
narrow margins, to make the most of the space available.

—Bﬁ 2. Choose “Layout and “Column Guides to create the brochure’s
R
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columns. A box will open and prompt you to enter the number of columns you desire. You will
also need to enter a number for the amount of space you would like between the columns.
Smaller numbers will create less space between the columns, while larger numbers will give
you more space.

Fig : 7.10 Left & Right
Margin - Screen

3. Select your layout options on the master page to ensure a uniform look on both pages of
your brochure. Any design specifications selected on the master page will automatically carry
over to subsequent pages. If you lay out the master page with three columns with .3 inches
between columns, the next page will automatically contain these features. Click onthe “L  at
the bottom left of the screen to access this area.

4. Usethe“Place function to place your text on the page. Select “Type and then “Alignment
to set the alignment for your brochure. Experiment with left-aligned and justified text to
determine which looks best.

5. Use“Place toimport photographs and position them on the page. Choose how text will
appear near photos by selecting “Element and “Text Wrap. Click on the photograph first
before attempting to select a wrap choice.

6. Proofread your brochure and print out both pages. Using a glue stick to glue the pages
together will give you an idea of how the finished project will look. Make sure that no text
extends into the folds. Then Save your project.

MS Publisher:

Microsoft Publisher, officially Microsoft Office Publisher, is a desktop publishing application
from Microsoft.

Microsoft Publisher is a full-featured desktop publishing program that helps you design and
publish professional print and Web-based materials with ease. Using Publisher’s familiar interface,
you can precisely lay out blocks of text, graphics, calendars, order forms, and more, while
Publisher’s many built-in designs help you to quickly create a professional publication in a matter
of minutes. Publisher 2003 also moves into two entirely new areas of design. The first is data-
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driven publications. This uses the new Catalog Merge command to combine pictures and text
from a data source to produce anything from an address book or directory through to a product
catalogue. The second is e-mail publications. Publisher 2003 offers six different HTML-based
e-mail publication types matching each of the 45 master styles. It is an entry-level application,
differing from Microsoft Word in that the emphasis is placed on page layout and design rather
than text composition and proofing.Its Improved DTP features include better control over images
and pages.

What’s new in Publisher 2003?

Publisher 2003 includes additional publication types and designs, which you can print, publish to
the Web, or distribute via e-mail. These options are available from the task pane, which makes it
easy to get started immediately. Other enhancements for increasing efficiency include a new page
sorter, which lets you use shortcut menus and drag-and-drop functionality to rename, insert,
delete, and rearrange pages, and the new Find and Replace task pane, which lets you quickly
search and replace text throughout the publication. Enhanced formatting options and layout features
let you design publications with more precision and flexibility.

The Design Checker and Graphics Manager automatically check the status of the publication
prior to distribution, so that problems can be quickly caught and solved. The Easy Web Site
Builder automatically creates a custom web site based on the site goals you define, and added
Web page types as specified. Anew Web editing environment called Web mode provides options
specific to Web pages, ensuring your publications are optimized for the Web. In addition, new e-
mail wizards help you design publications specifically for e-mail distribution.
Starting Microsoft Publisher:

1. Click the start button on the Windows task bar

2. Point to all programs.

3. Select Microsoft office.

4. From that submenu select Microsoft Office Publisher 2003.

The Publisher toolbars and task menus

While all of Publisher’s commands are contained in the menu bar at the top of the window, most
of your tasks can be accomplished using the toolbars and task pane menus. Publisher’s toolbars,
which group together shortcuts to command commands, are virtually identical to those included
in other Office applications. You can click a toolbar button to quickly apply formatting, save or
print a publication, copy or paste text, or accomplish another of a variety of tasks. To show or
hide a toolbar, open the View menu, select Toolbars, and then select the toolbar you want to
show or hide. The most frequently used toolbars are the Standard toolbar, the Formatting
toolbar, and the Objects toolbar. The Standard toolbar contains buttons for opening, saving,
printing, and editing publications. The Zoom box and magnifying glass buttons at the end of the
toolbar let you change the display size of the publication.

\
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Fig : 7.11 Standard Toolbar

The Formatting toolbar contains buttons and drop-down menus for applying formatting to
text, paragraphs, and objects.
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Fig : 7.12 Formatting Toolbar

The Objects toolbar, which is displayed vertically along the left side of the Publisher window,
provides buttons for inserting the objects you’ll include in your publication. These include text
boxes, picture boxes, lines, shapes, and Design Gallery objects. Publisher uses a task pane,
located on the left side of the window, to group common options, as well as to replace many
standard dialogs, As you select options from the task pane, you can see your changes immediately
applied to the publication.

Ruler Guides—A ruler guide is horizontal or vertical guide that you can move to any point on
the ruler.

Ruler Marks feature is turned on, objects you place near a ruler guide will automatically
snap into alignment.

Creating a Publication - Creating a new publication using the wizards

 New Publication v x

New from a design
» Publcebiors for Prot

> Deagoes
» Blznk Pubkatons

New
) Bk prot oubleaton
] EBlankweb Page
2] Fromensdeg pubicaion.

upen

e,

Publisher provides a large variety of pre-built designs for each publication type. To quickly
create a new publication, all you have to do is select the design and replace the placeholder text
and graphics:

\
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1. From the File menu, select New.

2. In the New Publication task pane, select a publication type from the New from a
design list:

For Example, let’s take a newsletter designed for print. Later, we’ll show you how to design a
newsletter for e-mail distribution, as well. Select Publications for Print.

This expands the list to display design categories:

Fig : 7.13 New
Publication Window

It also opens the Quick Designs preview gallery, which displays designs you can use for your
publication:

The preview gallery displays designs for the category selected in the New from a design list.
1. Scroll through the list of design categories and select Newsletters.
The Quick Publications preview gallery displays thumbnails for newsletter designs.

Scroll through the gallery. When you find a design you like, click it.

Postcards
Progams
g

fewfromadesin. Quisk Pubiicaticns
» Publications for Print A L 1 | [sesssss

Quizk Pubicaticrs B —
Advertisemants u u n
Award Cortificebos Heading Heading S {raiing
Banners == 3 — — =]
Brochurcs X —
Business Cards
Busingss Forrs Al el oz e
Calzndars
Catzloge —
Envelopes \
Flyers u
Gift Cartificazes NEapinG HEADING
Greetng cards emen ===
Impert Word Documents
Irvitation Cerds — e
Lakels
Letierhzad
Manus a1 bl I—
Hewsletters B ﬂ u a
Paper Folding krogects H"‘“nfa m s ""m'

Fig : 7.14 Design Options Fig : 7.15 Quick Publications
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Fig : 7.16 Personal Information Window

The first time you use the design gallery, Publisher prompts you to enter personal
information, which it can automatically include in the publications:

1. Enter the information and click OK. You can always change the information later.

 Newsleties Options > x
. S 7 2
7 Newsletter Options
@] Page Contere
¥ Fublication Dssigis
i Cobr Schemes
A4 Fonl: Schemes
One- or two-sided printing

|

®
1 2

Customer address.

Inchids Hane

Fig : 7.17 Newsletter Options
The publication is displayed in the main window:

The task pane now displays design options for your newsletter: As you select different options,
you can see them applied to the newsletter in the main window. The first option is specific to the
type of publication design you’ve chosen. Since we’ve chosen a newsletter design, the first
option is Newsletter Options. When you include a customer address, Publisher adds mailing
address elements to the publication. For the newsletter, let’s leave the options as they are: two-
sided printing with no customer address.
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Fig : 7.18 Color Schemes

Web page, newsletter, and catalog designs include a Page Content option. For newsletters,
click Page Content to select a column style. For the example newsletter, we’ll keep the
default option (3 columns). If you don’t like the newsletter design you chose from the preview
gallery, click Publication Designs to choose a new one again.

To change the color scheme for the newsletter, click Color Schemes.

The current color scheme is Meadow; this was defined in the Personal Information dialog
earlier. For our newsletter, let’s Pebbles instead.

To change the font scheme for the newsletter, click Font Schemes.

Let’s select
Online, because it has the general look. We can always change individual fonts whenever required.

1. Once the design is adjusted, you can complete the publication by replacing the text and
graphics Publisher has included.

MS Publisher also allows us to insert and delete pages using the menus available in the menu bar.
Add text

In Microsoft Publisher, text is contained in text boxes, which you arrange on the pages of
your publication. When you use one of Publisher’s built-in designs, Publisher adds placeholder
textboxes, with content that you can change or delete.
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If you’re working with a blank page, you can add your own text by adding a text box of

the general dimensions you need:
1. On the Objects toolbar at the left side of the Publisher window, click the Text Box

| button. The mouse icon changes to a cross hair: + then drag mouse where the text

box is needed.

A new text box appears:

e

»  Type inside the text box to add the text you want.

Fig : 7.19 Text Box
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| e by Wt e Bty Wt orent W o] Dot

Using text boxes, you can precisely control

B S et ot Wiwd S zaes Paes ] Dz Tacts Woed Bsentd

the size, location, and appearance of all the individual text elements in the publications.

Import text

If your publication will contain long blocks of text, such as articles, you can compose the
text for your publication in Microsoft Word, and then import it into a new publication. Make
sure your Word document is saved. In the Publisher task pane, click the Other Task
Panes arrow button and, from the menu that appears, select New Publication.
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Fig : 7.20 Import Word Documents

In the New Publication task pane, select Publications for Print and then Import Word
Documents:

Fig : 7.21 Newsletter Options Window
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Fig : 7.21 Newsletter Options Window

Select a design from the Import Word Documents preview gallery to the right:

The Import Word Document dialog opens, Navigate to the document you want to import, and then
selectitand click OK.

Import Ward Nacument E
Leokin: | (23 My Newsketters vy @-A|1Q ¥ =5 Tods -
3 ] 5% rief hiszoryi.coc

Destiop

e T menbs

8
My Cameuter
__;' Fie pame: [

My Nebwork, :
Hazes Flesofbme: |\ard pocuments (*.doc;* ) v Canel

Fig : 7.22 Import Word Document
The document is converted to Publisher:

You can now use the Word Import Options task pane to define the formatting options you want
to use for the publication:

\>
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Fig : 7.24 Word Import Options

OUR OOQAYY HTOET

Fig : 7.25 Text Boxes - Screen
Select text boxes

Text boxes, as well as other types of object frames (such as picture boxes), are displayed
with dashed borders. You can select a text box to format it, move it, resize it, or delete it.
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Open the Format Text Box dialog from format menu dialog.
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Fig : 7.26 Format Text Box
Columns @
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Fig : 7.27 Columns Box Window
Select the Text Box tab and click the Columns button.
\ J
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Inside Story Headline

Yo catch the wadsr'c
atinntion, phca an
interecting <anbenca or
‘quote from the story here”

Inside Story Headline

Fig : 7.28 Columns Dialog —Screen
The Columns dialog opens. Enter the number of columns you want, and the spacing that
should appear between the columns. Click OK to close the Format Text Box dialog.

The text box is now split into columns of equal width.

Fig : 7.29 Master Page Window

Create and use a master page

Every publication includes a master page, which contains elements of the design that are
repeated throughout the publication. These may include text boxes, pictures, headers, footers,
and layout guides. Master pages provide one place where you can update all common
elements; this way, you don’t have to change them on all the pages in the publication.

To view the master page for the publication, open the View menu and select Master Page.
The master page is displayed in the main workspace window:
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Fig : 7.30 Edit Master PageWindow
Add elements to the master page the same way you would to publication pages.

You can add new master pages using the Edit Master Pages toolbar, which floats over the
master page:

New Master Page

Page ID {1 character); | g

Description:
["1Two-page master

Lo ][ camcel |

Fig : 7.31 New Master Page Dialog Box

To create anew master page:

Click the New Master Page | ] button on the Edit Master Pages button. This button is
also available on the task pane.

The New Master Page dialog opens.

: Anply Mastes Page. T
Selsit a naster pegs to ool to publication
Dages 2 & 3.

Pages

Fig : 7.32 Apply Master Page
In the Page ID field, enter a one-character master page identifier.
Enter a description for the master page.

For print publications, select the Two-page master check box if you want to
create a two-page spread.

Click OK.

¢
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Once you’ve created and designed your master pages, you need to apply them to the various
pages of your publication. To do so, close the master pages by selecting (unchecking) Master
Page from the View menu.

When you return to the publication, the Apply Master Page task pane should appear:

To apply one master page to a range of pages in your publication:

In the Apply Master Page task pane, click the Apply to Page Range button.

Apply Master Page @

Select a master page:
| Ej Master A (Master Page-A) v
gy to - |
(%) Al pages
{)Pages from; |1 to: |4

() Clrrent page(s)

l OK | | Cancel

Fig:7.33 Apply Master Page Dialog Box
The Apply Master Page dialog opens.

Select the master page you want to apply from the drop-down menu.

Under Apply to, select Pages, and then enter the page range. To apply the master page to all the
pages in your publication, select All pages instead.

Click OK.

Publisher also allows us to edit publishing, Find and replace text, Check spelling, Format
the text in the publication, Apply schemes like font scheme, color scheme using format
menu, we can also insert symbols in the publication using insert menu, Create tables,
paragraphs, bullets.

The MS publisher can also help us in adding clipart and graphic pictures in it and also allows
to format them by rotating, cropping etc.

The feature wrap text around allows us to wrap the text around the pictures which gives a
professional look to the publication.
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Fig : 7.34 Design Checker Dialog Box
Preparing for Distribution
Check the design of a publication

Publisher’s Design Checker automatically checks your publication for design problems,
which in some cases you can have Publisher automatically fix:

1. Select Design Checker from the task pane menu, or from the Publisher Tools menu.

Publisher automatically checks the design of the publication and lists the results in the task
pane:

Select an item to fix

Ohject is not wisible i
!j (Page 1) nkg

5o ko this Tkem

Fix: Bring Object to Front

Mever Run this Check Again

Explain, ..

Objact has transparency
{Page 1)
Fig : 7.35 Select an item to fix
1. Foreachitem in the list:

Click the down arrow next to the item to open a menu of available options.
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a. Select Go to this Item to go to the page and manually fix the problem, or
select Publisher’s suggested solution, if one is available.

Select Never Run this Check Again to prevent Publisher from checking for this type of problem
again.

Select Explain to get more information about the problem.

1. When you’ve finished, click the Close Design Checker button.

Verify pictures

The Graphics Manager lets you check the status of the pictures in your publication. This is
particularly useful for Web publications, since Publisher will notify you of missing links.

1. Select Graphics Manager from the task pane menu, or from the Publisher Tools
menu.

W Hebmth G ephis Maisgss

Fig : 7.36 Graphics Manager

Publisher automatically checks the status of the graphics in the publication and lists the results
in the task pane:

1. To quickly find graphics with missing links, select Status from the Sort by drop-down
menu.
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2. Select an item in the list to go to the graphic and fix it manually, or click the down
arrow next to the item and select Find the Linked Picture to fix the broken link.

Advanced Print Settings %

Seperations Pagecettngs | Graphys and Ferks

output: (R v

(1P composts M by defack

Print plate Fracuercy Argle

Fig : 7.37 Advanced Print Setup Box

Preview and print a publication

To preview your publication prior to printing it, open the File menu and select Print Preview.
The newsletter opens in a preview window. Click the Close button to close the window, or the

Print 4§ button to print the publication.

To print the publication, click the Print button in the Print Preview window or on the Publisher
Standard toolbar.

To define advanced print settings:
From the File menu, select Print.

1. Inthe Printdialog, click Advanced Print Settings.
The Advanced Print Settings dialog opens.

1. Select the options you want and click OK.

Create a newsletter to email

Using Publisher, you can design a professional-looking HTML-based newsletter to send in the
body of an e-mail. Publisher includes a number of Web-based designs that are specially formatted
to fit the size of an e-mail message. To use one of these:
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1. Select New from the File menu, or select New Publication from the task pane menu.

2. Inthe New Publication task pane, select Web Sites and E-mail, then E-mail, and
then Newsletter.

Select a design from the Newsletter preview gallery.

2. Use the task pane to select design options for the newsletter.

—

Fig : 7.38 Newsletter to email

To preview your newsletter prior to sending it, open the File menu and select Send E-Mail, and
then E-Mail Preview. The newsletter is displayed in a new browser window.

To send the newsletter:
1. From the File menu, select Send E-Mail, and then Send This Page as Message.

The page appears in the body of a new message, with the task pane to the left. You can use the
task pane to make changes to the appearance of the newsletter before you send it.

1. Enter your recipient’s e-mail address and a subject.

2. Click Send.
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Language softwares:

What is language software?

Language softwares are generally available for creating long documents in our own regional
language and they help us with multiple font styles, font size, font modules, spell checks etc.
Even though there are varied variety of language software available we would like to mention
three popular softwares used commonly among people.

Shree-Lipi software
Indic

Sulekh

Baraha

Shree-Lipi software:

Shree-Lipi Soft and Shree-Lipi Pearl are multilingual packages. There are language special
packages, which give more stress on a particular script, while still supporting the other scripts.
These multilingual packages are: Dev Ratna for Hindi and Marathi (as well as Konkani, Nepalese),
Gurjari for Gujarati, Gurumukhi for Punjabi, Banga Ratna for Bengali, Ashamiya Manik
for Assamese and Manipuri, Utkal for Oriya, Tamil Vairam for Tamil, Kannada Ratna for
Kannada, Telugu Ratna for Telugu, Kairali for Malayalam and Shree-Lipi DG for Devnagri
and Gujarati. The main difference in these packages is number of fonts in each package.

Font and Font Tools

Shree-Lipi is truly the richest package for Indian language fonts. For example, Dev Ratna
package contains 838 Modular, 296 ITR Devnagari Fonts, and additional 4400 Dev Bahar
fonts. Following are the number of fonts for every package

Following are the other highlights:

e Additional stylized 4400 Dev Bahar fonts in Dev Ratna and 3100 Guj Bahar fonts in
Gurjari

e Two completely new font layouts ShreeLipi-Ex (16 bit fonts) and ShreeLipi-7 (8 bit
fonts) will help user to overcome many difficulties faced while using Windows
applications

o Fonts with decorative shiroresha for Devnagari, Bengali, Assamese and Manipuri - to
be used in invitations

o Fonts with decorative pullis for Tamil

o Avishkar Font Styler to make the fonts thin, fat, slanted etc.
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Modular Font Manager to install / remove fonts easily

File Compatibility - facility to use documents of other window based packages in
Patrika & vice versa in formats like MS Word (DOC), RTF, TEXT, ISCII, PCISCII,
Shree-Lipi editor, HTML, iLeap etc.

Find & Replace option for Indian languages.

Auto save

Define Keyboard Shortcuts for repetitive words to reduce re-typing of same text
again & again.

Insert date & time in Indian languages in 12 formats.

Sorting: To sort Paragraph & Table Data as per Indian Language rules.

Spellchecker On line spell checking facility for Indian languages.

Dictionary : On line Hindi dictionary

Mail Merge in Indian language.

DMP Printing - Built-in fast printing facility

Text Styling using ROOPA: In-built Text Styler to give effects like Condensation,
Expansion, Shadow, Forward / Reverse Slant, Rotation & Out Line to Text etc.
E-mail facility in Indian languages.

Transliteration Facilitates transliteration from one Indian language to another language.

Typing & Menu language selection: User can select typing & menu language like
Hindi, Marathi, Tamil, or Malayalam etc.

Install or Uninstall any number of Fonts easily

15,000 high resolution clipart

Clipart with Indian language calligraphy included

550 attractive Wall Papers with decorative seamless tiles
11 innovative screen savers

Some of the Popular applications supported by Shree-Lipi

MS Office (Word, Excel, PowerPoint, Access, Publisher, FrontPage, Outlook
Express)

Adobe InDesign, InDesign CS
Corel Draw 6/7/8/9/10/11/12/X3/X4
Internet Explorer, Netscape Navigator

Dreamweaver, Flash, Director

Quark Express (4 to 7), Word Pad, PostDeko
Star Office 5/6, Open Office

3D Max, Scala Multimedia
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Freehand, Inscriber, Intellidraw

Indic Software:

Indic Computing means “computing in Indic i.e. Indian Scripts and Languages. It involves
developing software in Indic Scripts/languages, Input methods, Localization of computer
applications, web development, Database Management, OCR, Spell-checkers, Speech to
Text and Text to Speech applications etc. in Indian languages.

Settings required for using Gujarati Fonts:

We need to download a setup for Gujarati Indic IME available at a website http://
www.bhashaindia.com/downloads/dgujarati.aspx. The Gujarati Indic IME provides a very
convenient way to entering text in Gujarati using the English QWERT keyboard in any Office
XP application, Wordpad and notepad on Windows XP platform.

Installation Notes for Windows XP Profession :

The IME cannot be installed or upgraded on a system that doesn’t already support IMEs in
the same language that we are installing. To enable Indic IME in our system, we need to install
complex scripts. The steps mentioned below helps us to install complex scripts.

e C(lick on“Start button.
¢ Goto Control Panel.
e Select Regional and Language.
e Select Language Tab.
e Check the option “Install files for complex scripts and left-to-right Language
e Insert Windows XP CD in your CD-ROM drive and click ok.
e Reboot the computer system.
Installation of Gujarati Indic IME :

¢ Run setup.exe downloaded from http:/www.bhashaindia.com/downloads/
dgujarati.aspx. This installs the Gujarati Indic IME and on our computer.

e Reboot the computer system.
Settings to add local language support:

e C(lickon“Start button.
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Select Control Panel.

Select Regional and Language.

Select Language Tab.

Click on “Details button.

Select keyboard under GU in Installed Services.
Clickon“Add button.

Select Gujarati in Input Language.

Check Keyboard Layout/IME box.

Select Gujarati Indic IME 1.

Click on OK button.

How to Use Gujarati Indic IME ?

After installing Gujarati Indic IME start any office application , WordPad or Notepad.

Click the Language Indicator located in the system Tray on the right side of the
windows taskbar.

@ English (United States)
4 (Gujarati

Shaow the Language bat

Fig : 7.39 IME Status Toolbar
Click on “Gujarati in the shortcut menu that appears.

This will now provide us a virtual keyboard as shown below :

e w|

Fig : 7.40 Toolbar
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Keyboards :

g0

ge

sl

qau

Guyjarati Indic IME provides support for three types of keyboard.

a* | gH

M

g0

94

1. Gujarati Transliteration :Using phonetic typing, the user can type his/her message in
Roman using the standard English keyboard, which is transliterated on-the-fly to
Guyjarati. It works on the logic of phonetics and is most effective when we spell the

word the way it is spoken.

aRa

|[51 |3[l

A

a |4

Ial |3|.- 3

all

4

9

: 7.41 Gujarati Transliteration Keyboard

2. Gujarati Typewriter : This typewriter can be used for typing as per the key mapping
of Gujarati typewriter keyboard. The layout of Gujarati type writer is as shown below.

Gujarati Typewriter =1
SH1 sl i3 ks s e EI? ale efs slo s-  al= I 2]
& 1 2 3 4 5 5 7 =3 3 o DL < &
Tab q Sfw e ¢ 2} 4y Ly 3l cuio p Sl =1 =2
© S [ ol ol 20 It 2L & ) 3 3"
s ofs la t s ok ol = sy B A ]
aps | 0ok oL 5 el ol ~ < ) S a e =5
z Hlx e v -t o m T € g8l o Shitt
S=hift 2 2\ 5 ul (= S L t o
Space Bar

Fig : 7.42 Gujarati Typewriter keyboard

Gujarati Inscript

3. Gujarati Inscript : The user can type the basic characters in sequence and an
underlying logic determines which of these characters have to be combined and
substituted to form a glyph. The keyboard layout for this kind of typing is shown below.

~ {1
25

ki

i i sf 3 sf oF
kS 3 ¥ U 5 = Z

P of

T <[ 4l

- mlw S T A O

o
‘Caps Lock

%[- **I eé

Enter

Shitt

<
<>

u_

R

Pl & o of & o ¢
o uf o 1f

/

L

Shift

Sp=ce Bar

Fig :

7.43 Gujarati Inscript keyboard
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Most of the Indic scripts nowadays use Unicode for working on Computers and Internet. In
Unicode 5.0 following Indian Scripts have been encoded:

e Bengali script , Devanagari , Gujarati , Gurmukhi ,Kannada , Limbu ,Malayalam ,
Oriya ,Sinhala ,Syloti Nagri , Tamil , Telugu

A lot of Indic Computing projects are going on. They involve some government sector
companies, some volunteer groups and individual people.

Sulekh software:

QA

System Requirements

Sulekh 2001 run best on Windows 98 onwards.... because Sulekh 2001 is a 32 Bit software.
Sulekh has 16 Bit Software for Microsoft windows 3.1, 3.11 or Windows95 operating systems.Any
computer on which above operating systems can run smoothly Sulekh Software and should be
equipped with Good word proccessing software, like MS-Word, Excel, Power Point , etc...

How to Open Sulekh Software ?

e Go To Start—> All Programs—>=Sulekh 2001=->Sulekh 2001
Program(32 Bit)

o Register Screen
STATUS

Evaluatian
23 ses N
c-lefe

Eony Sottware 16 type Gujarati & Himdi in
i ahnost’ Al‘l\/ sofhware under Microsoft '\/"Hﬁ clonn rc.
Special e |
Manish Sor@| so
% zoo 1 Rs 2750

=lg : L YOu Can
fE‘ngLEr vca I—'I'vone / ernall / Ieu.ar lJy erchng RIALNO 717
A0 ary Payrnent ta us and l"UNL OCK CODE"
3 (Pemmanent) Copy. Please do contact us ror i
any help you need R’PcluPsth to read HELP.

i ovv= 88 and Difice 2000 Rey

iety, Opp. POIL Euildmu
” Eliara Parlk, Vadad

Gujarat, ( INDLAY - 590029
Pagaer (D2656)- 9622376311 : Mobile : 9825008011
website : vanw.sulekh.com
: email :su or sulekh com
o PRorepst N oy

Fig : 7.44 Sulekh First Screen
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e Then Click on Continue Button
o After clicking the Continue Button Open any word Processing
software such as Word, Excel etc...

[ Biekiy 2001 - EasyWiiter ON

e Click the above button which will be displayed on the Title Bar in order
to ON the Gujarati Fonts. This button can also open Keyboard with
Gujarati Fonts when we select the option “Sulekh Easywriter Keyboard
Program from the Pull-down menu.

e The layout of Gujarati Keyboard is shown below

|
uclp. Gontact]
l‘hmah Sam {

Fig : 7.45 Sulekh Keyboard
Baraha software:
Baraha supports Kannada, Devanagari, Tamil, Telugu, Malayalam, Gujarati, Gurumukhi,
Bengali, and Oriya scripts. Baraha can be effectively used for creating documents, email and
blogging. With an average 25,000 downloads/month, millions of users are using Baraha for
creating content in Indian
languages. Feel free to distribute Baraha to others.

Tocke

ﬁ i e . ¥
.ga.n o | fes va siw susii|ee sw ==

ISP, Do wdTed cfczsmo[
AT HAA TAAHH FUqH
QAnAmeyQamn, wmla Ubsumerdl CasLow
DDA SDo WA Beavo
SMEMAROAM @Mo suMaUdMI] crLIdo
AAGR A Hed sletct@ Bod
EEET 6 HE TowH =HH
ACACIACAR FA° 2RAT FcHA°

= i)

Fig : 7.46 Baraha Language Fig : 7.47 Baraha Opening Screen
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Baraha means ‘writing’ in Kannada. Baraha is a transliteration based application which converts
‘Indian language text written in English’ to their own respective scripts.

Today hundreds of thousands of Indians are using Baraha for sending e-mails to friends & family
across the world in their mother tongue.
Features:

Baraha breaks the keyboard barrier for Indian languages by using a transliteration scheme in
which any Indian language word may be typed using the standard English keyboard. Baraha user
doesn’t feel any discomfort when he switches between typing Indian language text and English.
In fact, writing in Baraha is as simple and easy as writing our names in English! Kannada and
Hindi text such as cheluva kannaDa nADu, merA bhArat mahAn can be typed as shown.

Baraha breaks the script barrier between different Indian languages. All the Indian scripts are
derived from the Brahmi script, which is also the underlying concept in Baraha. Baraha uses a
common code for representing all the Indian languages. So, it is possible to convert text from one
script to another. For example, lets say a Malayalam user who understands Hindi language
receives a Hindi email. If the user is not fluent in reading Devanagari script, then he can convert
the email to Malayalam script and read it.

One of the main objectives of Baraha is “portability of data . Baraha can export the data in
various data formats such as ANSI text, Unicode text, RTF, HTML. User can convert documents
to Unicode format by a few clicks of mouse, which means the documents that are created in
Baraha, stay relevant in the future and will never become obsolete.
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8. Multimedia Softwares and Media Softawares
Introduction

Multimedia is simply multiple forms of media integrated together. Media can be text, graphics,
audio, animation, video, data, etc. An example of multimedia is a web page on the topic of film
trailers, Presentations with audio, video and animated pictures/still images, even a magazine that
includes text and pictures are all considered as examples of Multimedia.

Besides multiple types of media being integrated with one another, multimedia can also stand for
interactive types of media such as video games CD ROMs that teach a foreign language, or an
information Kiosk at a subway terminal, or an interactive website which is user friendly. Other
terms that are sometimes used for multimedia include hypermedia and rich media.

Advertising is perhaps one of the biggest industry’s that use multimedia to send their message to
the mass. Multimedia in Education has been extremely effective in teaching individuals a wide
range of subjects. The human brain learns using many senses such as sight and hearing. While a
lecture can be extremely informative, a lecture that integrates pictures or video images can help
an individual learn and retain information much more effectively.

The Softwares mentioned below are some of the famous multimedia Softwares that are frequently
applied for graphic designing, Web designing, and for 3D, 2D animation. Even though
plenty of multimedia softwares are available in the market we have mentioned few
famous types of software as example for making you familiar in multimedia
applications.

.“15," Graphic Design software:

Paint Brush:

Paint (formerly Paintbrush for Windows) is a simple graphics painting program that has been
included with all versions of Microsoft Windows. It is often referred to as MS Paint, Microsoft
Paint or simply Paint. The program opens and saves files as Windows bitmap with the .bmp
extension, JPEG, GIF, PNG and TIFF. The program can be in color mode or two-color black-
and-white, but there is no grayscale mode.
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Microsoft Paint is an inexpensive painting program that can be used to teach the basics of painting
software. Many sophisticated graphics software applications (such as Paint Shop Pro or
Photoshop) use the same basic principles that can be learned using MS Paint.

Using any painting program involves learning how to use the menu bar and the tool bar. MS Paint
also includes a color palette that allows the user to choose both foreground and background
colors with which to works. MS Paint also includes a great Help system that will have you
mastering your virtual brush-strokes in minutes.

Recent versions of Paint allow the user to pick up to three colors at a time: the primary color (left
mouse click), secondary color (right mouse click), and tertiary color (control key + any mouse
click).We can also use cut, copy, paste method to add any desired pictures in paint brush.

The program comes with the following options in its Tool Box (from left to right in image):

Select, Select, Eraser/Color Eraser, Fill With Color, Pick Color, Magnifier, Pencil, Brush, Airbrush,
Text, Line, Curve, Rectangle, Polygon, Ellipse, Rounded Rectangle

The Image menu offers the following options: Flip/Rotate, Stretch/Skew, Invert Colors, Image
Attributes, Clear Image, and Draw Opaque. The “Colors menu allows the user to Edit Colors

(Only menu option under Colors). The Edit Colors dialog box shows the standard Windows
color picker which includes a 48-color palette and 12 custom color slots that can be edited.
Clicking “Define Custom Colors displays a square version of the color wheel that can select a
custom color either with a crosshair cursor (like a “+ ), by Hue/Saturation/Luminance, or by
Red/Green/Blue values.

There are 28 color wells in the workspace. The user may also draw straight horizontal, vertical,
or diagonal lines with the pencil tool, without the need of the straight line tool, by holding the shift
key and dragging the tool. Moreover, it is also possible to thicken (control key + +) or thin
(control key + ) a line simultaneously while it is being drawn. To crop whitespace or eliminate
parts of a graphic, the blue handle in the lower right corner can be clicked and dragged to
increase canvas size or crop a graphic. The colors in the image can be inverted by pressing
control key + I (This shortcut has been changed to control key + shift key + I in the Windows 7
version of Paint). Users can also draw perfect shapes (which have width equal to height) using
the Rounded Rectangle, the Circle, and the Rectangle Tool by holding down the Shift key while

dragging.

The Screen Shot of MS-Paint is shown below:
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Fig : 8.1 MS-Paint Screen

PowerPoint:

PowerPoint is a presentation software program that is part of the Microsoft Office package and
runs on Microsoft Windows and Apple’s Mac OS X operating system. Power point software
can be effectively used to create mind blowing multimedia presentations by adding audio, text,
video, animated images etc.

PowerPoint is used by business people, educators, students, and trainers. The current versions
are Microsoft Office PowerPoint 2010 for Windows and 2008 for Mac. PowerPoint uses a
graphical approach to presentations in the form of slide shows that accompany the oral delivery
of'the topic. PowerPoint is one of the simplest computer programs to learn. It is the number 1
program used worldwide for presentations. Anyone can create stunning presentations that look
like they were designed by a professional.

PowerPoint presentations can be made into photo albums, complete with music or narrations, to
distribute on CDs or DVDs.

PowerPoint presentations consist of a number of individual pages called “slides . Slides may
contain text, graphics, movies, and other objects, which may be arranged freely on the slide.
PowerPoint, however, facilitates the use of a consistent style in a presentation using a template or
“Slide Master .

How to open a power point screen:

To run Power point on your computer: “Start >>“Programs >>“Microsoft Office >>
“Microsoft Office PowerPoint 2003. Ifthere is an icon of Microsoft PowerPoint available on
_your desktop, you can open up the program by double-clicking it, as well.
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Fig : 8.2 Steps to open MS-Powerpoint

The Screen Shot of Microsoft PowerPoint is shown below:
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Fig : 8.3 PowerPoint Slides -Screen

To create a simple presentation in PowerPoint:

e  When you first open PowerPoint, you will see a blank “slide with a space for a title and a
subtitle in two boxes. You can use this page to begin creating your presentation right away. You
can put a title and subtitle in the boxes if you want to (click inside and type), but you could delete
them and insert anything you want.

e The“subtitle box is a container for inserting text but pictures and other objects can also be
inserted. To do so select the box by clicking on one edge and then “delete. To put a picture into
this space, go to Insert on the menu bar and select Picture. Make sure the picture you want to
insertis saved in a file.
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Note: The picture you select will be inserted on the slide, but it may be so big that it
covers up your entire slide, to resize it just select the picture and make it smaller by grabbing the
edges with your pointer and dragging.

e Now that you have a great-looking title slide, you can create more presentation pages. Go to
the menu bar at the top of the page and select Insert and New Slide.

e PowerPoint also allows the user to create bullets and paragraphs in the slide to have bullet
format in the slide Go to format in the menu bar and select bullets and numbering from the drop
down the same format menu can be used to create the paragraph format in the slide.

e Once you have created your first couple of slides, you may want to add a design to your
presentation to make it more professional-looking.

e To do this go to Format on the menu bar and select Slide Design. Your design choices will
show up on the right side of the window, and then select the desired design for your slide.

e To see the new slides created at work, go to View on the menu bar and select Slide Show.
Your presentation will appear. To move from one slide to another, use your arrow keys on you
computer keyboard. To go back to design mode, simply hit your “Escape key.

e Theuser can also add effects to text by Adding animation schemes to the selected text from
slide show menu in the menu bar, in the same way effects to the whole slide can be added with
the help of slide transition menu.

e Theuser can transfer from one slide to other side during the slide show by adding Action
buttons in the current slide and setting the action setting to get transferred to the desired slide.

e Save the PowerPoint presentation with the extension .ppt.

The presentation can be printed, displayed live on a computer. For larger audiences the computer
display is often projected using a video projector. Slides can also form the basis of web casts.
Allin all, PowerPoint is a “one-stop-shop to create successful presentations for the business
world, the classroom or just for your own personal use.
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CorelDraw:

Corel Draw was the first of the Windows-based Graphic drawing programs and has built on this
early start to become far-and-away the dominant drawing package on the PC. Its biggest strength
- and its biggest potential limitation - is its all-encompassing approach.

CorelDraw transforms ideas into specialized graphics, logos, marketing projects or business

7
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tools. Experiment with CorelDraw as it allows you to build from scratch or edit an existing idea.
Let your imagination soar as you learn and develop the many tools available to create, produce
or edit your next design.The Screen Shot of Corel draw is shown below:
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Fig : 8.4 CorelDraw-Screen
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Adobe*Photoshop 5, 0

Tramas Kncll, Mars Hamburg, Sealba N ayaom, Sean Favent, Dire Good, Greg Sy, Laurd Hoffmen,
Jou duit.
Jerry Harris. Andrai Her asimchuk . Chsties McBrian. Merc Fewlgar . Katis Fimi. Akike Sherry .
Russel Wiliame . Andrew Caven. John Laddy . Kevin Cotnor, AFake Yarhimurs, Luirme Seymour Caben
Cwrot Jonnscn, Matt Foster, Grant Mungey, Toan Rusrk, Paul Melland | Saen Yoiss, Fussel Brove

Licensed ¢

Version 5.0

Photoshop:

Jazon Bartell, Scoit Byer, Jeff Chien, Tom Costs, Chris Cox. Josh Freesman, Tador Georgay.

Adobe Photoshop, or simply Photoshop, is a graphics editing program developed and published
by Adobe Systems. It is the current market leader for commercial bitmap and image manipulation
software, and is the flagship product of Adobe Systems. It has been described as “an industry
standard for graphics professionals and it is compulsory to have a basic knowledge of Photoshop
for any one to pursue their career in field Graphic Designing Industry.
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Photoshop’s popularity among professional designers makes it an industry standard. If you just
want to make your personal photo collection look better, Photoshop can be a powerful tool.

The Screen Shot of Adobe Photoshop is shown below:

Fig : 8.5 Adobe Photoshop-Screen

Before You Edit Your Photos

Before you start editing photos, you’ll need to learn the basics. Familiarize yourself with the
Photoshop interface and how to get your photos into the program.

Photoshop Interface

1.

Menu Bar: This is located at the top of your screen. It has no graphical buttons, just the
words File, Edit, Image, Layer, Select, Filter, View, Window, and Help. In this guide,
we’ll only use the first four.

Toolbox or Toolbar: This is a palette that usually appears on the left side of the screen,
but can be dragged to any location. It contains various tools, including brushes, zoom,
marquee select, and the foreground and background color pickers.

Layer Palette: This window can usually be found in the lower right hand corner of the
screen. It contains the layers in your image. Layers are like cellophane sheets on top of
one another, and the Background Layer is like a sheet of opaque paper underneath
them. It’s ok if this concept isn’t 100% clear yet, all we need to know for now is where
to find the layer palette.

Opening Photos with Photoshop

If your photos are in digital format already (i.e. taken with a digital camera), transfer them

to your computer.
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e Ifyouhave photo prints, you can still edit them with Photoshop! Use a scannerto move
the photos onto your desktop.

¢ Once the photos are on your computer, group them in a folder. To make it easy, call the
folder something simple like “Original Photos.

e Then copy the folder’s contents into a new folder. You may want to call this “Edited Photos.

e Making this duplicate set of photos to work with means that if you make a mistake at any
pointin the editing process, you’ll always have an original copy of your photo to go back to.

e Now start Photoshop by double-clicking on the program.

¢ Go to the File menu and select that you want to open an image.

e Navigate to “Edited Photos folder (or to whatever you called it) and choose a photo.
Adjust Levels in Your Photos

e It’salways a good idea to check a photo’s levels before you do any other editing. When
photos are backlit, lit poorly, or overexposed, the colors may not look quite right. Sometimes
this is very obvious, but other times it’s hard to tell, so always check your photo’s levels. This will
help you make the colors in your photos look their best.

e  With your image open in Photoshop, find and click Edit in the menu bar.

¢ Point to Adjustments > in the drop-down menu and leave the cursor there for a second.
¢ Inthe menu that pops up (usually to the right), click on Auto Levels.

e Save your work by hitting Apple + S in Mac OS X or CTRL + S in Windows.

¢ You should notice a change in the appearance of your photo. If you don’t see a noticeable
difference, it’s okay. It just means your photo looked good right from the start.

Crop Your Photos

Sometimes you frame a photo perfectly. Other times you have a photo that would be perfect, if
it weren’t for that strange event happening in the lower right corner. Here are two easy ways for
beginners to keep the good portion of a photo and cut out the rest:

Crop with the Crop Tool
e Using the Crop Tool is an easy way to delete a portion of your photo.

e Inthetoolbar, choose the crop tool. It should be the fifth button from the top.
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e Now click and drag the mouse across the area of the image that you want to keep.

¢ A dashed rectangular border with small boxes in the corners and the middle of the sides
should appear. The inside of the box will stay the same, and whatever is outside will turn a little
darker.

¢ C(Click and drag any of the little boxes to change the area that the dashed border encompasses.
Thearea inside is the part you will be keeping, and the area outside is going to be cut off.

e  When you’re satisfied with the area, either double-click inside of it or press Enter.
Resize Your Photos
Photoshop can be used to change the image size without losing a piece of it in one of two ways:
. Resize by pixels or percentages.
e Recommended if you want to display your photos on the Internet.
. Resize by inches or other measurements.

e Recommended if you want to print a hard copy of your photos.

Adobe Illustrator:

'\‘ @ Lserces To
Adabe
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Lubamir Deurday ., 'am NMougy , Micheel Yalentiner . Fic Wright . Ted Alzpach, Leon Erown, Suzan Glie
Betlina Genning, Mordy Guidng, Lydiz Yarmazs, Bill Bachmian, Jile Larsen, Michael Abtoit,

Heather Bowman, Chris Scott
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making graphic design and illustrations. It is made by Adobe Systems. Pictures created in Adobe

7

192



\

[Mustrator can be made bigger or smaller, and look exactly the same at any size. It works well
with the rest of the products with the Adobe name.

Adobe Illustrator is a vector graphics editor developed and marketed by Adobe Systems.The

latest version, Illustrator CS4, is the fourteenth generation in the product line.It is a full-featured
drawing program for Windows and Macintosh from Adobe. It provides sophisticated tracing
and text manipulation capabilities as well as color separations. Illustrator was originally developed
for the Mac in 1987 and, up until Version 7.0, which was introduced in 1997, the Mac version
included more features. The Macintosh version is the most widely used drawing and composition
program for the Mac platform.

Fig : 8.6 Adobe Illustrator-Screen

Adobe Dreamweaver:
=ERMX

Adobe Dreamweaver (formerly Macromedia Dream weaver) is a web development
application originally created by Macromedia, and is now developed by Adobe Systems, which
acquired Macromedia in 2005.
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Dreamweaver is a Web design software program you can use to create pages for display on the
World Wide Web. The latest version is Adobe Dreamweaver CS3 (the program was previously
owned by Macromedia). You can use Dreamweaver to create HTML pages, as well as files in
these formats: CSS, XML, ASP, PHP, JSP, and more. Dreamweaver is the most popular Web
design program among professional Web designers.

Dreamweaver is a hybrid WYSIWY G (what you see is what you get) and code-

based web design and development application. It’s made in such a way that even non-coders
can create web pages and sites attractively on their own by the use of Adobe Dreamweaver.

Adobe”

F FLASH Professional

ACTIONSCRIFT 3.0 Praview

Web Designing software:

Adobe Flash player:

Adobe Flash (formerly Macromedia Flash) is a multimedia platform that is popular for adding
animation and interactivity to web pages. Originally acquired by Macromedia, Flash was
introduced in 1996, and is currently developed and distributed by Adobe Systems.

Flash is commonly used to create animation, advertisements, and various web page Flash
components, to integrate video into web pages, and more recently, to develop rich Internet applications

Files in the SWF format, traditionally called “Shock Wave Flash movies, “Flash movies or
“Flash games ,usually have a .swf file extension and may be an object of a web page and the file
is strictly played in a standalone Flash Player only.

Animation
Flash can display moving text by adding then step by step in contiguous frames and it also
displays still images.
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Interactivity

Flash can capture user input via mouse, keyboard, microphone and camera. Using such input,
the flash programmer can create an interactive user interface.

Video

Flash can be used to insert videos in web pages, a feature available since Flash Player version 6.
The technique is to create a flash file (.swf) that provides a user interface for playing the video file,
aso called “player .

The Screen Shot of Adobe Flash Player is shown below:

Macremedia I lash MX - [Untiled-2)
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Fig : 8.7 Adobe Flash Player - Screen
In Flash animation can be done in four basic ways:
Motion Tween

Shape Tween

Frame-by-Frame Animation

Guided Motion Tween

It is very simple and neatly explained below.

A. Creating Motion Tween in Flash

1. Draw a vector using any of the drawing tools in Flash, say a small circle and convert it
into a symbol (F8) by selecting the Graphic option and name the symbol say ‘ball’.
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Click the 20th frame in the Timeline and insert a frame (F5).

Now right-click the 20th frame in the Timeline and select Create Motion Tween and
insert a Key Frame (F6).

Select the 10th frame and insert a Key frame (F6) and move the ball to a different

position say, above the current position to create a motion sequence (automatically tweened
by Flash).

Save your work and test the Movie (Ctrl + Enter). That’s it you have created simple
animation using Motion Tween.

v s 10 {8 zo
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Fig : 8.8 Timeline of Motion Tween

B. Creating Shape Tween in Flash

6.

You can create Shape Tweened animations using Shape option from the Tween panel of
the Properties inspector. Draw a vector using any of the drawing tools in Flash, say a
small circle and remove its border.

Click the 10th frame in the Timeline and insert a Key Frame (F6). Now draw another
shape say a diamond using the rectangle tool without a border.

Now right-click on any frame in between these two Key Frames and select Shape
option from the Tween panel of the Properties inspector.

Save your work and test the Movie (Ctrl + Enter). That’s it you have learnt how to
create Shape Tween in Flash.

\
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Fig: 8.9 Timeline of Shape Tween

¥ Timeline

Fig: 8.10 Timeline of Broken Tween

C. Frame-by-Frame Animation

1.

Create a vector/plain text using any of the drawing tools in Flash, say a text with ‘ Animation’
typed as shown in the example and break it using Break Apart (Ctrl + B) to separate the

alphabets as shown below:
U uiut [
Animation!

Fig: 8.11 Showing Text after Break Apart

In Frame-by-Frame animation we create the object for each frame so as to produce an
animation sequence.

Insert Key frame (F6) and move the alphabets so as to produce an animation sequence.

Repeat the above step as far as desired to create Frame-by-Frame animation as shown
in the example.

Save your work and test the Movie (Ctrl + Enter). That’s it you have created an animation
using Frame-by-Frame animation.
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Fig: 8.12 Timeline of Frame-by-Frame Animation

D. Creating a Guided Motion Tween in Flash

Create a vector/plain text using any of the drawing tools in Flash, say a text with ‘Flash’
typed and break it using Break Apart (Ctrl + B) as done in the previous example and put
each alphabet in different layers and name the layers as shown in the picture below.

Insert a guide layer by right-clicking the topmost layer and select ‘Add Guide Layer’
(Insert—>Timeline—>Motion Guide), draw any path using the pencil tool in the guide
layer as shown in the example.

Now create Motion tween by selecting the object in the 1st frame and snapping its
registration point to one end of the path.

Snap the object in the last frame to the other end of the path in the guide layer.

. Repeat the same for all the objects (alphabets) by snapping their registration points to

the path in the guide layer.

Save your work and test the Movie (Ctrl + Enter). That’s it you have learnt how to
create motion along a guided path.
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Fig: 8.13 Timeline of Guided Motion Tween
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HTML:

HTML is the “mother tongue of your browser.

HTML is a language for describing web pages.

HTML stands for Hyper Text Markup Language

It is exclusively developed to create attractive web pages.

HTML is not a programming language, it is a markup language

It provides a means to create structured documents by denoting structural meaning for
text such as headings, paragraphs, lists etc as well as for links, quotes, and other items.

IT allows images and objects to be embedded and can be used to create interactive
forms.

It is written in the form of HTML elements consisting of “tags surrounded by angle
brackets within the web page content.

It can include or can load scripts in languages such as JavaScript which affect the behavior
of HTML processors such as creating interactive web pages.

HTML files are easy to recognize because they contain the file extension such as ‘html’
or ‘htm.’

HTML s a formal Recommendation by the World Wide Web Consortium (W3C) and is generally
adhered to by the major browsers, Microsoft’s Internet Explorer and Netscape’s Navigator,
which also provide some additional non-standard codes. The current version of HTML is HTML

4.0.

Uses of HTML
If you want to make websites, there is no way around HTML. Even if you’re
using a program to create websites, such as Dreamweaver, a basic knowledge of

HTML can make life a lot simpler and your website a lot better. The good news is that HTML is
easy to learn and use.

HTML Tags
HTML markup tags are usually called HTML tags

HTML tags are keywords surrounded by angle brackets like <htmI>
HTML tags normally come in pairs like <b>and </b>

The first tag in a pair is the start tag, the second tag is the end tag
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o HTML tags generally has a title tag <title> </title>and a body tag <body> </body>

o Start and end tags are also called opening tags and closing tags.

An example of a simple HTML Program is mentioned below:

<html> Am Proud to learn HTML
<body>
<h1>Am Proud to learn HTML</h1> Our national fruit is mango.
<p>Our national fruit is mango.</p>
</body>
</html>

HTML Formatting Tags

HTML uses tags like <b> and <i> for formatting output, like bold or italic text.
These HTML tags are called formatting tags.

Text Formatting Tags

Tag Description

<b> Defines bold text

<big> Defines big text

<em> Defines emphasized text

<> Defines italic text

<hr> Defines a horizontal line above
the text.

<small> Defines small text

<strong> Defines strong text

<sub> Defines subscripted text

<sup> Defines superscripted text

<ins> Defines inserted text

<del> Defines deleted text

<> Deprecated. Use <del> instead

<strike> Deprecated. Use <del> instead

<u> Deprecated. Use styles instead
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Example:

Code Output
<html> This text is bold
<body>
<p><b>This text is bold</b></p> This text is big

<p><big>This text is big</big></p>
<p><i>This text is italic</i></p>
<p><code>This is computer
output</code></p>

<p>This is<sub> subscript</sub> and
<sup>superscript</sup></p>
</body>

</html>

This text is italic

This is computer output

. int
This iS subscript and PP

HTML with JavaScript:

JavaScript is the most popular scripting language on the internet, and works in all major

browsers, such as Internet Explorer, Firefox, Chrome, Opera, and Safari.

JavaScript

JavaScript was designed to add interactivity to HTML pages
JavaScript is a scripting language
A scripting language is a lightweight programming language
JavaScript is usually embedded directly into HTML pages
JavaScript is an interpreted language (means that scripts

execute without preliminary compilation)

Everyone can use JavaScript without purchasing a license

The HTML <script> tag is used to insert a JavaScript into an HTML page.

Code

Output

<html>

<body>

<script type="text/javascript">
document.write("<h1>Hello
World!</h1>");

</script>

</body>

</html>

Hello World!

In this way JavaScript can be added with HTML language to make the web page user

mteractive.
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3D design softwares:

Create breathtaking 3D
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Maya:
Autodesk Corporation’s Maya is a 3D Modeling and Rendering program, similar to Lightwave,
3DMax, Pixar’s Renderman, and other professional 3D programs.

Many pictures have received Academy Awards for Visual Effects because their artists used
Maya for the film one of the most recent examples is the Oscar winning “The Curious Case of
Benjamin Button - itused Maya for its visual effects throughout the picture. King Kong was
also the beneficiary of effects created by Maya.

In addition to 3D work, Maya is also used for Matte painting. Matte paintings are typically
used in digital work for backgrounds.

Many special effects companies use Maya. Autodesk has won a total of 5 Oscars itself from the
Academy for significant contributions to the Motion Picture industry. Autodesk’s achievements
with Maya are not limited to movies - it has also received many awards from the Television and
Broadcasting industries and also in the Gaming Industry for 3D game modeling and effects.

Many people who aren’t familiar with 3D techniques start out with Autodesk’s 3DMax, a
good program in its own right. While not as powerful as Maya, it does prepare users for the
jump to the more complex Maya program. While Maya isn’t for beginners, there are many
good training programs available in the, internet to precede your career in 3D animation

industry.

Maya is a very powerful and very expensive 3D imaging software program that is used mainly for
special effects in movies and modeling objects and characters in video games.

Media players:

Most computers today come with a default media player. A media player is a program that plays audio and
video files for the user’s entertainment. It is a term typically used to describe computer software for
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playing back multimedia files. Most software media players support an array of media formats,
including both audio and video files.

Some media players focus only on audio or video and are known as audio players and video
players respectively. The producers of these players usually focus on providing a better user
experience as they are specifically tailored toward the media type.

Microsoft Windows comes with pre-loaded Windows Media Player. Mac OS X comes pre-
loaded with Quicktime Player for playing Quicktime movies and iTunes for playing a variety of
media formats. Many media players use libraries. The library is designed to help you organize, or
catalog, your music into categories such as genre, year, rating or other. Good examples of media
players that include media libraries are Winamp, Windows Media Player, iTunes, RealPlayer,
Amarok and ALLPlayer.

There are several countless varieties of media players available in the market out of which most popular
media players are given a brief below:

e  Windows Media player
e Quick time media player
e VLC media player.

e  Winamp media player

Apart from this there are several types of media players are available for a wide variety of choice
for us and each has its own features to prove itself.

LIST OF MEDIA PLAYER:

[iTunes - Adobe Media Player - Connect Player - CD
Player - CrystalPlayer - DBpoweramp - Dell

M ediaDirect - DVD Player - foobar2000 -GOM
Flayer -High Definition Compatible Digital -

[nterActual Player - Iriver plus 3 - MadCat Media
Browser - Media Center - Media Go - Media Player -

Windo Med'ia Player Clgssic -MediaM onkey - M0d4W in -
WS M usicBee - Musicmatch Jukebox - MusikCube -
— JPowerDVD - QuickPlayer - Quintessential Player -
SNESAmp - Adobe Shockwave - SonicStage -
Sonique - The Core Media Player - K-Multimedia
IPlayer - WinDVD - WinPlay3 - Winamp - Windows
M edia Center - Windows Media Player - Xiph
QuickTime Components - Yahoo! Music Jukebox -
Zune
Windo
WS IThe Core Pocket Media Player - M edia Player
Mobil
c
Audion - Centerstage - Chroma - Cog -DVD Player -
Mac |[Front Row -ITheater - Peel - Perian - Plexapp - Adobe
0S X Shockwave - Windows Media Components for
QuickTime - Xiph QuickTime Components
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indows Media Player:

Windows Media Player (abbreviated WMP) is a proprietary digital media player and media
library application developed by Microsoft that is used for playing audio, video and viewing
images on computers running the Microsoft Windows operating system, as well as on Pocket

PC and Windows Mobile-based devices. In addition to being a media player, Windows Media
Player includes the ability to rip music from and copy music to compact discs, burn recordable
discs in Audio CD format or as data discs with Playlists such as an MP3 CD, synchronize

content with a digital audio player (MP3 player). Windows Media Player 12 is the most recent
version of Windows Media Player as of July 2009.

Features:

Playback of audio, video and pictures, along with fast forward, reverse, file markers (if
present) and variable playback speed are available.ltems in a playlist can be skipped
over at playback time without removing them from the playlist.

Supports local playback, streaming playback with multicast streams and progressive
downloads.

Full media management, via the integrated media library introduced first in version 7,
which offers cataloguing and searching of media and viewing media metadata. Media
can be arranged according to album, artist, genre, dates and also according to ratings.

Video Smoothing introduced in WMP 9 Series was most used giving a smoother playback
on low-framerate videos.

Can play files in WMA, WAV or MP3 media formats. However, it will not play MP3
files that contain compressed ID3 headers (“tags ); trying to do so results ina “The
input media fileis invalid error message.

Has skinning support since version 7 and includes a color chooser since version 8. Not
all functions are usually exposed in skin mode. Windows Media Player 10 allows setting
the video border color. Color chooser has been removed in Windows Media Player 12.

Since WMP 9 Series, the player features dynamically updated Auto Playlists based on
criteria. Auto Playlists are updated every time users open them.

Features universal brightness, contrast, saturation and hue adjustments and pixel aspect
ratio for all playable video formats.
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e Supports extensive configurable privacy and security settings.
¢ Full keyboard-based operation is possible.
The file types supported by Windows media player:

Files Type (Format) File Name Extension

CD audio .cda
Media Playlist .asx, .wax, .m3u, .wpl, .wvx, .wmx, and
.search-ms
Microsoft Recorded dvi-ms
TV Show '
MIDI file (midi) .mid, .midi, and .rmi

.mpeg, .mpg, .mlv, . m2v, .mod, .mp2, .mpa,

Movie file (MPEG) .mpe, .ifo, and .vob

Windows audio file .wav, .snd, .au, .aif, .aifc, .aiff, .wma, and

(wav) .mp3

p

Windows Media file

(asf) .asf, .wm, .wma, .wmv, and .wmd
Windows picture file . .

(ipe) Jpg and .jpeg
Windows video file )

(avi) .avi and .wmv

Quicktime player:
QuickTime

Quicktime is a multimedia development, storage, and playback technology from Apple. Quicktime
files combine sound, text, animation, and video in a single file. Using a Quicktime player that
either comes with a Web browser or can be downloaded from Apple or the browser company,
you can view and control brief multimedia sequences.

Quicktime files can be recognized by their file name extensions: qt, mov, and moov
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Features:

It is boosted with latest video compression technology. It’s called H.264, and it’s an
important new industry standard available in this software and helps in high definition
playback.
Ultra-efficient, the H.264 codec compresses video tightly — resulting in much smaller
files— without sacrificing any quality.
Full screen playback, now included in the free QuickTime Player, has been enhanced to
allow you to take full advantage of your computer’s widescreen display.
It is very easy to be used because It requires no set up for content that streams over the
network.
QuickTime 7 Player delivers truly outstanding multi-channel audio. In fact, it provides
up to 24 channels of audio. So it offers a surround sound effect when we watch a movie.

‘m\
/& \\ / [_ ( . Other file formats that QuickTime supports natively (to varying
' / J

degrees) include AIFF, WAV, DV-DIF, MP3, and MPEG program stream. With
additional QuickTime Components, it can also support Ogg, ASF, Flash Video,
Matroska, DivX Media Format, and many others.

VLC Media Player:

VLC media player is a free and open source media player and multimedia framework written by
the VideoLLAN project. VLC is a portable multimedia player, encoder, and streamer supporting
many audio and video codecs and file formats as well as DVDs, and VCDs. It is one of the most
platform-independent players which include many advanced features.

Features:

VLC is popular for its ability to play the video content of incomplete, unfinished, or
damaged video downloads before the files have been fully downloaded.

VLC supports all audio and video formats and all file formats supported by libavcodec
and libavformat. This means that VL.C can play back H.264 or MPEG-4 video as well
as support FLV or MXF file formats “out of the box using FFmpeg’s libraries.

VLC media player has some filters that can distort, rotate, split, deinterlace, mirror videos,
create display walls, or add a logo overlay.

VLC media player can display the playing video as the desktop wallpaper.

VLC media player can do screen casts and record the desktop.

VLC can be installed and run directly from a flash or other external drive.
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The file types supported by VLC media player:

Format

Supporting files

Video formats

Cinepak, Dirac, DV, H.263,
H.264/MPEG-4 AVC, HuffYUV,
Indeo 3, MIJPEG, MPEG-1,
MPEG-2, MPEG-4 Part 2,
RealVideo 3&4, Sorenson,
H.263, Theora, VC-1, VPS5, VP6,
WMV.

Audio formats

AAC, AC3, ALAC, AMR,M
DTS, DV Audio, XM, FLAC,
MACE, Mod, MP3, PLS,
QDM2/QDMC,  RealAudio,™
Speex, Screamtracker 3/S3M,
TTA, Vorbis, WavPack,”>’ WMA

Winamp is a proprietary media player for Windows-based PCs. It is freeware/shareware, multi-

Winamp:

format, extensible with plug-ins and skins, and is noted for its graphical sound visualization,
playlist and media library features. Winamp supports music playback using MP3, MIDI, MOD,
MPEG-1,AAC, M4A, FLAC, WAV and WMA. Winamp was one of the first common music

players on Windows to support playback of Ogg, Vorbis by default. It supports gapless playback
for MP3 and AAC, and Replay Gain for volume leveling across tracks.

The file types supported by VLC media player:

AAC
ATF
AIFF
AMF
VLB
ASF
AU
AVI
CDA
FAR
FLV

IT MOD NST STM
ITZ MP1 NSV STZ
KAR MP2 0GG ULT
M2V MP3 OKT FLAC
MP3 M3U M3U8 PLS
M4A MP4 PTM WAV
MDZ MPEG RMI WMA
MID MPG S3M WMV
MIDI MTM S3z XM
MIZ NSA SND XMZ

M4V * MKV SWEF W64
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9. Engineering, Accounting and programming Softwares

Engineering software

AUtOCA D Introduction

Computer Aided Design and Draughting (sometimes known as CADD). Generally, it is the use
of computers in design and drawing processes. Traditionally, technical drawing, are made
using manual drafting. CAD is being used widely in modern practice. The ability of computer
that enables engineers to produce, revise, store and transmit original drawings has made it very
important. This also helps in 2D and 3D design and drawings.

Example of CAD software:

AutoCAD, PRO/Engineer, IDEAS, UNIGRAPHICS, CATIA, Solid Works, etc.

Advantages of CAD
e Easier Creation and Corrections Drawings may be created more quickly and makings
changes is more efficient than correcting drawings made by hand.
e Better Visualization of drawings - Many systems allow different views of the same object
and 3D pictorial view.
e Database of Drawing Aids - Designs and symbols can be stored for easy recall and
reuse.
e Increased Accuracy - Using the computer, the drawing can be produced with more
accuracy.
e Improved Filing - Drawings can be more conveniently filed, retrieved and transmitted on
disks and tape.
e Quick Design Analysis
e Simulation and Testing
The AutoCAD Screen

Cursor

aaaa

sy o

R e P A P F IO N A

Fig : 9.1 Autocad-Screen
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Accounting software

Tally
Power of Simplicity

Tally is a financial accounting software package designed by Tally Solutions mainly for small
businesses and shops. Tally is a complete business accounting and inventory management software
that provides various facilities like Govt. supported formats, multilingual operations, online functions
and processing for small and medium businesses.

It’s easy to use, with dynamic features designed to simplify day-to-day business operations.

Yet it offers comprehensive accounting structure with inventory, statutory processes, data
synchronization capabilities. It also has the ability to go globally with business transactions sans
language or geographical barriers.

While Tally Software is robust, its user interface makes it easy to learn and straight forward to
use.

Tally Account Software offers a range of inventory options from simple inventory and stock
management to advanced including invoicing, purchase orders, discount column in invoicing,
flexible units of measure, stock query and multiple stock valuation methods. It also includes Drill
down display, complete bookkeeping options, flexible classification of accounts, general ledger,
accounts receivable and payable, bank reconciliation and more operating with speed, flexibility
and online help.

Technology and data reliability and security are one of the advantages of using Tally Software
with a diverse protocol support for HTTP, HTTPS, FTP, SMTP and OBDC with raw sockets
with data interchange formats including XML, HTML and HTML with SML Islands, SOAP and
SDF.

It also has the ability to synchronize data across multiple offices. This account software is one of
the best for financial management providing receivables turnover, fund flows, variance analysis,
consolidation of companies and branch accounting. While it is simple and easy to install with
unlimited multi-user support across a single LAN setup, there is also full-featured, multi-directory
setup for company management, web-enabled with the ability to publish financial reports to the
Internet and graphical analysis options.

\
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Tally Software is both flexible and powerful with seamless integration with the Microsoft suite of
business products. Multiple companies with daily transaction values, percentage based reporting,
vouchers and comparison of data with multi-columnar reporting and more makes Tally Accounting
Software on of the premier accounting software packages on the market today.

How to use Tally:

e | 'I}.< L srtt 22wrrallan

Siney Dubbies

Fig : 9.2 Ledger - Screen
Credit Control (Outstanding Management) Including credit Limit
A Tally user can maintain ‘Outstanding Reports’ along with Age Wise analysis. Credit Limits
can be given ‘amount wise’ as well as ‘period wise’. Once Credit limits are set for a Party,
then the user cannot bill the particular Party beyond the specified limit. Only the authorized
user can alter the Credit Limits. This helps to monitor as well as control any potential slow
collection and warns about the potential bad debts.
To set Credit Limits follow the procedure below :

Activate Budgets and controls by pressing F11 (Features) -> Select Accounts Info -> Select
Ledger —> Select Credit limits -> Select Group -> Define the limit for each ledger either by
Value or Period or Both.

Accounts Receivable and Accounts payable

Accounts Receivables is the amount to be received from Sundry Debtors and Accounts Payable,
the amount to be paid to Sundry Creditors. Tally provides complete bill wise information of
amounts receivable as well as payable either Party wise or Group wise. This feature can track
bills, payments/receipts including advances one-to-one.

How to use this facility?

Activate ‘BillWise’ details by pressing F11 (Features). Now Create a Party (Ledger A/c)
under the group ‘Sundry Debtors’ as well as one under group ‘Sundry Creditors’, and also
activate ‘Maintain balances bill by bill” for all the Parties while you are in Ledger creation
mode. Next, select the option “Voucher Entry’ in ‘Gateway of Tally’ -> Select Sales or
Purchase Voucher. Now, while entering the transaction, the user can specify a Ref. no with
due date for the amount or break it up by giving multiple ref no with different due dates.
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Fig : 9.3 Outstanding Details Individual -Screen
To view the reports follow the procedure given below.

Select ‘Display’ (in Gateway of Tally menu) -> Select ‘Statement of Accounts’ -> Select
‘Outstandings’ -> Select ‘Receivables’ (in case you want to see amount due to the company)
-> Select any particular group. The report displays bill by bill outstanding for all parties along
with the pending amount as well as the due date.

In case user wants to see the amount payable by the company then select the option
‘Payable’ under the menu ‘Outstandings’. The user, once he has selected either Payables or
Receivables can toggle between the two reports by clicking F4 function key.

For individual Party wise outstanding:
->select ‘Ledger’ option under ‘Outstandings’. This report gives a bill-by-bill display of all
outstandings for the concerned party along with the total outstanding amount.

Sunap Gumsasding

Fig : 9.4 Outstanding Details Group-Screen
For adisplay of total outstandings for all parties -> select ‘Group’ in the menu ‘Outstandings’
and then select any particular group or sub-group.
Flexible Voucher Numbering
Tally provides predefined vouchers and also allows the user to define different types of
vouchers as per his/her needs. E.g. the user can further classify Payment Vouchers by creating
vouchers by the name Bank Payment and Cash Payment Vouchers. The user can also set
the voucher numbering as per his needs, which is either automatic numbering or manual
numbering or have no numbering at all. Further the user can also assign Prefix and Suffix for
voucher numbers and numbering can restart either from beginning of the year or month.

How to create a new Voucher Type?

\>
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Select ‘Accounts Info’ -> select “Voucher Type’ -> select ‘create’ option -> Now enter the
Voucher name, specify the type of voucher, specify the method of numbering, activate or
deactivate the other functions as per needs.

Flexible Classification of Accounting Heads / Chart of Accounts

Tally allows the user to define account heads as per his requirements. Tally offers 28
predefined widely used Groups. Of these 28 predefined groups 15 groups are Primary
groups and the remaining 13 are sub groups. Among the 15 predefined groups 9 Groups
are Balance Sheet items and the remaining 6 groups are Profit and Loss items. The user is
allowed to alter the nomenclature of any of these 28 Groups. Further the user is allowed to
create any number of Groups as per his/her requirements, which can either be a Primary or
a Sub-Group. Tally also allows the user to have a multiple tree like structure groupings. This
flexibility and ease of configuration allows Tally to be used across industries and geography.

E.g. the user can have Continent wise Debtors groupings (i.e. Asia, America, Europe, Africa,
Australia) under the Group ‘Sundry Debtors’. The continents can also be further bifurcated
into countries and states and so on.

Data Based reporting

Tally allows users to select any report for a particular date or for any range of dates. Once
you have selected a Report, press F2 (F2 in case of Day Book) and specify the date range
(From and to). You can also do simultaneous comparison side by side for any two selected
periods including across financial years. All reports from Tally are generated based on the
transaction date rather than the date of actual entry and hence Tally ensures that information
is always represented accurately. This unique approach to bank reconciliation allows review
of past date status for auditing purpose.

Voucher and Cheque Printing

Tally provides the facility to print any voucher that has been entered. The user can print the
voucher as soon as he has entered the voucher or even later. Tally also provides cheque
printing facility. The Cheque can be printed immediately after printing the voucher or can be
printed later.

To activate Cheque printing option press F11 -> activate ‘Set modify company features’ -
> enable Cheque printing -> specify bank name (as created in Ledgers) -> Specify

\>
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dimensions of Cheque. Now while entering Payment Voucher mention the name to be
printed on the cheque. Once the voucher is saved Tally prompts the user to print cheque.

Fig : 9.5 Voucher Register -Screen

Columnar Reports
Tally provides columnar reports in Sales register, Purchase Register and Journal registers as
well as Ledgers and Cash / Bank Books.

Fig : 9.6 Bank Reconciliation -Screen

For Columnar Reports, Select Display -> Accounts Book -> selects any of the registers ->
Press F5 (Columnar).

\
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Bank Reconciliation

Tally provides the user a facility to reconcile bank accounts with his bank statement and hence
providing the user with information regarding transactions, which haven’t been cleared as yet by
the bank.

For bank reconciliation follow the following procedure:

Firstly, while creating “Bank Account Ledger, specify ‘Effective date of reconciliation’ (ie the
date from which the user wants to reconcile his bank accounts). Then,

Select, -> Display -> Account Books -> Bank Book -> Select the particular ‘Bank’ Select

month -> Press F5 (Reconcile). Now enter the date, on which a particular transaction has been
cleared. Tally now provides information of balances as per company Books as well as per Bank.

E.X. Accounting package:

B
vexr S
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E.X.-The world’s friendliest business accounting software.

In order to use E.X. accounting package it should be installed first. To start EX software, execute
EX.exe file, which may be installed in the EXNextGeneration\Bin directory on the drive in which
you installed the software or click on the start=> All programs—> E.X Next Generation shortcut—=>
E.X. Next Generation shortcut which is created, when you install the software. E.X. Next
Generation Version 1.5, is a product from Tata consultancy Services.

Why E.X. is a best accounting package:

e Mainly mouse driven. Rare use of the keyboard. Efficient and friendly interface.
The only accounting software worldwide using advanced OLE and ODBC concepts.
EXNGN is the only software that is REALLY open and customizable.

Unique features such as Analysis categories, SmartFinder, and Folders.

EXNGN contains over 70 reports designed by Chartered Accountants.

EXNGN contains built in Inventory, Balance Sheet, Bank Reconciliation and many
other features.

YEAR 2000 COMPLIANT. THE FIRST. THE BEST.

Versatile document designer, so you can decide how your invoices, etc look.

Multi company, multi user, multi currency. And now, with network features!
Developed in association with software giant, Microsoft.

Accounting is the backbone of any organization. The requirements in accounting
change from time to time. This calls for more features and reports. New features
and functionality can be incorporated using the latest technology available.
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e E.X. NGN has been designed and developed for the Windows 95 / NT platform. It
fully exploits the power and flexibility of this platform.

e E.X. NGN is user friendly and uses Microsoft Graphic User Interface standards. It is
rigorously tested before release and is highly reliable.

e E.X.-NGN is the only packaged accounting software which will take care of the
changing requirements either through regular upgrades or 'ADDONS’ applications
developed around E.X. NGN. This will definitely satisfy the current accounting needs
as well as the future requirements.

e E.X. NGN uses the most popular and powerful database, Microsoft Access and MS
SQL Server for storing company data.

e MS Access is considered one of the most stable databases available today. Since
E.X. NGN uses the MS Access engine, it has all the data recovery consistencies
supported by Microsoft Access, making any such corruption very low

e The latest releases on MSDE (the desktop version of MS SQL 7.0) are even more
reliable and advanced.

SAP:

SAP stands for Systems Applications and Products in Data
®

Processing. It is divided into modules that include Financial Accounting (FI), Controlling (CO),
Production Planning (PP), Materials Management (MM), Sales and Distribution (SD), etc.
Programming is not a major function of SAP, however it can be configured via its own in-
house programming language known as ABAP.

SAP Accounting Products

SAP Business One is affordable, easy-to-use business management software designed
specifically for small and midsize businesses. It enables you to manage your critical business
functions across sales, distribution, and financials, all in a single integrated system. With SAP
Business One, you can instantaneously access a complete and up-to-the-minute view of your
business, so you can respond to customers faster and grow your business more profitably.

SAP Key Strengths

e The SAP Business One application offers a comprehensive and integrated set of tools
to effectively manage all financial processes in your organization.

e The core functionality of SAP Business One is financials and accounting management
that incorporates all key accounting processes, such as journal entries, accounts
receivable, and accounts payable.

¢ Real-time accounting functions trigger accounting postings automatically when relevant
business events occur. SAP Business One supports automatic tax calculations as well
as multi-currency transactions. Posting templates and recurring postings further
streamline and simplify your accounting processes.

\>

215



7

e SAP Business One offers powerful financial reporting tools such as balance sheets,
profit and loss statements, cash flow statements, and aging reports. The XL Reporter
tool in SAP Business One enables the seamless integration of financial reports into
Microsoft Excel templates.

e The banking software in SAP Business One provides all the tools and functionality
necessary to manage all your payment processing, including checks, cash, credit cards,
and bank transfers. The reconciliation tool allows you to easily reconcile incoming and
outgoing payments with vendor and customer invoices.

e Profit or cost centers are easily created and let you allocate revenue and expenses
according to distribution rules — which are customizable and specific to your business.

Programming Languages:

As we have language to communicate between each other, Computers also have languages
known as programming language to communicate with the hardware parts and to give the desired
output. A programming language is an artificial language designed to express computations that
can be performed by a machine, particularly a computer. Programming languages can be used to
create programs that control the behavior of a machine, to express algorithms precisely, or as a
mode of human communication.

As we have many regional languages such as Hindi, Gujarati, Marathi, and computer also have
different kinds of programming languages used for many purposes such as C, C++, JAVA,
Visual basic, ASPNET etc. Many programming languages have some form of written specification
of their syntax (form) and semantics (meaning).

Need of programming language:

The first question that we might ask is what is the need of programming
languages? Why we cannot write program in English, Hindi or other regional
languages?, The answer is, a sentence in the natural language may not have just
one meaning. This does not work well with computers. For computers to work
properly each sentence has to be clear and precise.

Programming language when used allows us to write an instruction that has only
one meaning. It consists of set of predefined rules. These rules form syntax of
that language. Hence learning a programming language is just like learning a
new language and the syntax used in each programming languages are like
grammar of the natural language.

Quality requirements

Whatever programming language we use and whatever purpose it may solve , the final program
must satisfy some fundamental properties. The following properties are among the most relevant:

\
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Efficiency/performance: the amount of system resources a program consumes
(processor time, memory space, slow devices such as disks, network bandwidth and to
some extent even user interaction): the less, the better. This also includes correct disposal
of some resources, such as cleaning up temporary files and lack of memory leaks.

Reliability: how often the results of a program are correct. This depends on conceptual
correctness of algorithms, and minimization of programming mistakes and logic errors

Robustness: how well a program anticipates problems not due to programmer error
this includes situations such as incorrect, inappropriate or corrupt data, unavailability of
needed resources such as memory, operating system services and network connections,
and user error.

Usability: This includes the ease with which a person can use the program for its intended
purpose, or in some cases even unanticipated purposes. Such issues can make or break
its success even regardless of other issues.

Portability: the range of computer hardware and operating system platforms on which
the source code of a program can be compiled/interpreted and run.

Maintainability: the ease with which a program can be modified by its present or future
developers in order to make improvements or customizations, fix bugs and security holes,
or adapt it to new environments.

What is C programming language?

Cis a general-purpose computer programming language developed in 1972 by Dennis Ritchie

at the Bell Telephone Laboratories for use with the Unix operating system.

Although C was designed for implementing system software, it is also widely used for
developing portable application software.

C is one of the most popular programming languages.It is widely used on many different

software platforms, and there are few computer architectures for which a C compiler does not
exist. C has greatly influenced many other popular programming languages, most notably C++,
which originally began as an extension to C. it is a very powerful and popular programming

language for creating computer programs.

\
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Getting Started with C

Input program OQutput Result
Save the planet Earth

#include <stdio.h>
main ()

{

printf("Save the planet
Earth\n") ;

return 0;

}

The C program is a set of functions. A C program always starts executing in a special function
called main” function. Here is the simple but famous Hello World program which prints “Hello
World greeting to screen.
The first line is the #include directive. C program uses this directive to load external function
library - stdio is c library which provides standard input/output functions, printfis a function
which is declared in the header file called stdio.h, this statement instruct the compiler to include
the contents in the header file “stdio.h .
o The nextis the main function - the first entry point of all C programs. C program logic
starts from the beginning of main function to its ending.
o And finally is the printf function which accepts a string parameter. The printf function is
used to print out the message to the screen.
Structure of a C program:
C program is a set of blocks called functions. A function is made up of one or more statements
used for performing a predefined task.
Structure of a complete C program.

[ Documentation

[ Symbolic Constant definition

|
|
| File include section |
|

[ Global Variable Declaration

main()

{

Declaration

Executable Statements

}

Function 1
Function 2
Function N

\
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Documentation Section:

This section is an optional section. As the name indicates its used for the purpose of documentation.
It is enclosed within /* and */ . Whenever the text is enclosed between /* and */, it 1S
considered as acomment in C. Comments are not processed by compiler and are left as it is.

This section is normally used to tell about the purpose of program, author, date of creation, etc.
Comment in C program can be added anywhere. It is always a good practice to use comments
within the function as it improves the readability and understanding of the program.

Symbolic Constant Definition:

To use such symbolic constant in our program we need to use # define as a prefix to it. Here
#define is known as preprocessor directive. It instructs the compiler to replace all occurrence of
symbolic constants with the values specified against it. Normally symbolic constant are defined
using capital letters. Doing this differentiates them from normal variables.

File includes Section:

C provides inbuilt or library functions. Some examples are pow( ), sqrt( ), etc. These functions
have a predefined purpose like pow( ) is used for calculating value of x raised to given power,
sqrt( ) is used to find square root of a given number. We can use these functions in our program
if needed. To use them we have to include files that hold information about these functions. These
files are known as header files in C. The extension of header file is “.h . We use the syntax
#include <filename.h> to include header files in our program. Appendix gives the list of header
files available in C and their uses.

Global variable declaration section:

C variables are governed by scope. A scope of ¢ variables is decided by using opening and
closing curly braces { }. The variable defined within curly braces are known as local variables.
These variables cannot be used outside the scope. At times we need to use a variable in all the
functions, such a variable is known as global variable. This variable is defined before defining all
the functions.

Main function:

All C programs contain one function with the name main( ). This is the function from where the
execution of any C program starts. The control is first transferred to this function and from here
rest of the operations are carried out.

User defined functions c provides us a facility of breaking a single program into set of small
pieces. These pieces are known as functions. In this section we define all the additional functions
used in our program.

\
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Input program Output Result
#include<stdio.h> Enter the value of x:
2

#include<conio.h>
main()

{
int x,y,result;

printf(“ Enter the value of x:”);
scanf(“%d”,&x);

printf(“Enter the value of y:”);
scanf(“%d”,&y);

result = x+y;

printf(“\n The sum of the two
numbers are % d”,result);

return;

}

Enter the value of y:
4

The sum of the two
numbers are 6

#include<stdio.h>, #include<conio.h> are standard input output header files and clear screen
header files. Every C program must have a main() function. Then your program will be in starting
and ending curly bracket { } ending curly brackets. Here we want to add two numbers x and y
and result of addition will be stored in result. So here we declare three integer variables a,b &
result. clrscr() function is a clear screen function that will clears the screen. printf() function will
print a message “enter any number on the screen to the user to input a number from the keyboard.
scanf() function is used to input a value from the keyboard. When this statement is executed then
user has to input a value from the keyboard. Value input by the keyboard will be stored in
variable a. Same way value of b is to be stored into variable b. In scanf() function, we have used
%d format string. %d is for integer means we have to input a integer from the keyboard. other
format string are as follows that can be used in the program.
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Format Strings:
%d - integer

%f - float

%c - character

Then we come to the statement c=a+b. This statement will add the value of a and b and store into
variable c. then printf() statement will print the value of ¢ variable on the screen. Here + is an
arithmetic operator. More arithmetic operators can be used such as - (subtract), * (Multiply),
/(Divide), % (Mod or Remainder). The return is used to return the control to the main.

C Character set

To learn any new language say English we first need to learn its alphabets. These alphabets form
a basic set in constructing words, sentence, etc in that language. C also has its own character set.
The characters here can be divided into four categories.

1. Letter

2. Digits

3. white spaces

4. Special Characters.
Keyword:

C language has a set of predefined words. To be specific it has 32 predefined words. These
predefined words in C language are known as keyword.

7

auto double int struct
break else long switch
case enum register typedef
char extern return union
const float short unsigned
continue for signed void
default goto sizeof volatile
do if static while

These are the main keywords which we will use while creating a program.

\
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Identifier:

Aword that a user form by making use of C character set is known as identifier. It consist of set
of letters, digits and some special characters. Some example of identifiers are “cost , “main(
) .etc.

Variable;

C program deal with data. To store data we use memory space. The data within this memory
space can vary based on the operations performed on it. To identify this data we use a name, this
name is known as variable name. The data as it is capable of changing itself'is called variable.

Rules for defining variables name:
1. Variable name cannot be same as keyword.

2. Variable name consist of a letter, digit and underscore. No other special characters is
allowed.

3. The first character of the variable name must be a letter or underscore.
4. The maximum length of the variable can be 31 characters.
5. The variable names are case sensitive.

Constant:

The entities of C that do not change its value throughout the execution of program are known as
constant. C constants can be divided into different categories as numeric constant, Integer constant,
Real constant, Character constant, string constant, symbolic constant.

Operators:

We all know mathematics and mathematical operations like addition, subtraction, division,
multiplication etc.

Exapmle:

(3+2+4)-2=7

Here 3,2,4,7 are integer constants and + and — are the operators.

Like arithmetic operators in maths we have eight types of operators in C language:

1. Arithmetic Operators.

\
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2. Assignment Operators.

3. Relational Operators.

4. Increment and Decrement operators.
5. Conditional Operators.

6. Logical Operators.

7. Bitwise Operators.

8. Special Operators.

String:

The string is nothing but the character value that is displayed in the output which we type in the
coding. The string contains two types of objects.

1. Asetof characters, which will be displayed on the monitor as they come into view.

2. The format specifications for each variable in order in which as they come into view.
Special characters:

The C programs also include the special character available in the keyboard such as &, ?, *,

@, {1150 = L0\ S, # ete...

Program to show the C character set.

Input program Output result
#include<stdio.h> Cost of 12 items is
600

Main ()

int

tot cost,qty=12,cost_item=
50;

Clrscr() ;

tot cost=qty*cost item;

printf (“cost of %d items
is %d”,qty, tot cost);

return;
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Here

1. main-isaidentifier

2. int-isakeyword

3. 12isaconstant

4. *isaoperator

5. costof%d items is %d is string

6. }isaspecial character
Looping concept:

C also allows looping concepts were we can take the variables in loop and make them to
display till the end of the loop. This can be done on conditional and unconditional basis. In
conditional basis if the control meets with the condition it breaks the loop and comes out of it.

Example program:
Input Program Output Result
#include<stdio.h> 1010101010
main(){
nt i;

for(i=0;1<5;1++){
int i=10;
printf(" %d",1);
i++;

5

return 0;

\
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Explanation:
e The first line of the program is standard input output header files.
e The second line is the main function
e The third line is the datatype and variable declaration

e The fourth line is the loop conditional statement where the intiall value of 1is 0 and the
condition whether it is less than 5 is checked and then the value of'1is incremented by
one.

e In the fifth line the constant value for the variable i is declared as 10.
¢ Inthe sixth step the value ofiis printed

e Inthenextstep the value of i is incremented

e  When the condition is met the control comes out of the loop

e Then the control is returned to the main by return statement.

C++t

In the above sections the most important and basic

concepts where explained as C programming language is a vast and also an interesting
subject so continue to learn the new and advanced concepts of C language with the
help of a complete C programming language courses.

C++ Programming language:

C++is an “object oriented programming language (Object oriented programming, or
OOP, is one model of programming language. Unlike other examples of computer programming
language, object oriented programming focuses on the use of objects instead of actions in order
to carry out tasks. This uses objects to design applications instead of actions, also involves taking

 an approach that is more mindful of data and less concerned with logic.) created by Bjarne

\

225



7

Stroustrup and released in 1985. It implements “data abstraction using a concept
called “classes , along with other features to allow object-oriented programming. Parts
of'the C++ program are easily reusable and extensible; existing code is easily modifiable
without actually having to change the code. C++ adds a concept called “operator
overloading not seen in the earlier OOP languages and it makes the creation of libraries
much cleaner.

C++ maintains aspects of the C programming language, yet has features which
simplify memory management. Additionally, some of the features of C++ allow low-
level access to memory but also contain high level features.

C++ could be considered a superset of C. C programs will run in C++ compilers.
C uses structured programming concepts and techniques while C++ uses object
oriented programming and classes which focus on data.

Simple program using C++:

Input program Output result
#include <iostream> | Global warming, is a
Global warning.

using namespace std;
int main()

{

cout << Global
warming, is a Global
warning. \n ;

return 0;

}

Explanation:

Structure of a C++ program:

Generally C++ programs will contain four sections; these sections may be placed in the
separate code files and then compiled independently or jointly

\
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Include files

(lass declaration

Member function definition

Main function program

It is a common practice to organize a program into three separate files. The class

decelerations are placed in a header file and the definitions of member functions go

into another file. This approach enables the programmer to separate the abstract

specification of the interface from implementation details. Finally, the main program

that uses the class is placed in a third file which includes the previous two files as well

as the other files required.

A simple C++ program using Class:
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Input program Outputresult
#include <iostream > Enter Name: Gautam Gambir
using namespace std; Enter Age:24
class person Name of the applicant: Gautam Gambir
{ Age of the applicant: 24
char name[30];
int age;
public;
void getdata(void);
void display(void);
}s
void person :: getdata(void)
{
Cout << “Enter Name:”;
Cin >> name;
cout << “Enter Age: “;
cin >> age;
}
void person :: display(void)
{
cout << “\nName of the applicant:” << name;
cout << “\nAge of the applicant:” << age;
}
int main()
{
person p;
p.getdata();
p.display();return();
\S 7,
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The program defines person as a new data of type class. The class person includes two basic
data type items(name, age) and two functions(getdata(), display()) to operate on that data. These
functions are called member functions. The main program uses person to declare variables of'its
type. As pointed out earlier, class variable are known as objects. Here, p is an object of type
person. Class objects are used to invoke the functions defined in that class. Since we use the
functions outside the class we have declared it as public.

Basic concepts of object oriented programming:

As we saw before C++ language is based on the concept of object oriented programming. So it
is very important to understand certain basic concepts of OOP in order to create complex
programs in C++ language.

e Object
e C(lasses
e Data abstraction and encapsulation
e Inheritance
e Polymorphism
e Dynamic binding
e Message passing
Objects:

Objects are the basic runtime entities in an object oriented system. They may represent a person,
aplace, a bank account, o table of data or any item that the program has to handle. When a
program is executed the objects interact by sending messages to one another. For example, if
“customer and “account are two objects in a program, then the customer object may send a
message to the account object requesting for the bank balance.

Classes:

We just mentioned that objects contain data, and code to manipulate that data. The entire set of
data and code of an object can be made a userdefined data type with help of a class. Infact,
objects are variables of the type class. Once a class has been defined, we can create any number
of objects belonging to that class.

Example:

Fruit mango;

\

229



7

The above statement will create an object belonging to the class fruit.
Data abstraction and encapsulation:

The wrapping up of data and function into as single unit (called class)is known as encapsulation
and that data inside encapsulated inside a particular class are accessible only by the functions of
that particular class.

Abstraction refers to the act of representing essential features without including the background
details or explanations.

Inheritance:

Inheritance is the process by which objects of one class acquire the properties of objects of the
another class. Example the child will surely inherit at least any one quality of its mother.

Polymorphism:

Polymorphism is another important OOP concept. Polymorphism means the ability to take more
than one form. An operation may exhibit different behaviors in different instances. The behavior
depends upon the types of data used in the operation. In case of a operator exhibiting different
behavior in a operation then it is known as operator overloading.

Example:
+ Operator: 2+2=4 -thisis the result for integer values.

Hello+world =Hello world - this is the result for string concatenation.

And if a function exhibits different behaviors then it is known as function overloading.
Dynamic Binding:
Binding the code and its procedural functions together is known as Dynamic binding.
Message passing:

An object oriented program consists of a set of objects that communicating with each other. The
process of programming in an object — oriented language, therefore, involves the following basic
steps:

1. Creating classes that define objects and their behavior,

2. Creating objects from class definitions, and

\
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3. Establishing communication among objects.

Simple C++ program to find the Average of two numbers:

Input program Output result

#include <iostream> Enter two numbers: 2.3 3.7
using namespace std; Sum =6

int main() Average =3

{

float numberl, number2, sum,

average;

cout << “Enter two numbers: ;
cin >> numberl;

cin >> number2;
sum=number]l + number2;
average = sum/2;

cout << “Sum = << sum<<
“\n ;

cout << “Average = <<
average << “\n ;

return 0;

}

Explanation:
#include <iostream> - is the header file that contains the data of input output files

using namespace std; - namespace is a new concept introduced by the ANSI C++ standards
committee. This defines a scope for the identifiers that are used in a program. For using the
identifiers defined in the namespace scope we must include the using directive, like

using namespace std;

Here, std is the namespace where ANSI C++ standard class library is defined.
Int main() —includes the main function of the program

Variables used are float number1, number2, sum, average;

All the variables must be declared before they are used.

\
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cin>>and cout << are input output statements
Then the calculation of the sum and average using the operator is carried out.
Then the value of Sum and the Average are printed

Then the control is returned to the main

JAVA Programming Language:

i

————" Javais a programming language that can run on many different
J

computers including mobile phones. It was originally developed by Sun Microsystems and
released in 1995. There are small Java programs, called Applets. They often run inside web
browsers. It enables programmers to write computer instructions using English based
commands, instead of having to write in numeric codes. It’s known as a “high-level language
because it can be read and written easily by humans. Like English, Java has a set of rules that
determine how the instructions are written. These rules are known as its “syntax . Once a
program has been written, the high-level instructions are translated into numeric codes that
computers can understand and execute.

Java should not be confused with JavaScript. JavaScript is a scripting language mainly used by
web browsers.

Java is object oriented. Java code looks a lot like C++ or C code.

Java is platform independent, meaning it can run on many different operating systems. The way
that Java manages this is making the Java compiler turn code into Java bytecode instead of
machine code. This means that when the program is executed, the Java Virtual Machine interprets
the code and translates it into machine code.

\
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Java Technology Changes Our Life
Java was designed with a few key principles in mind:

Easy to Use: The fundamentals of Java came from a programming language called c++.
Although a powerful language, it was felt to be too complex in its syntax, and inadequate
for all of Java’s requirements. Java built on, and improved the ideas of c++, to provide a
programming language that was powerful and simple to use.

Reliability: Java needed to reduce the likelihood of fatal errors from programmer
mistakes. With this in mind, object-oriented programming was introduced. Once data
and its manipulation were packaged together in one place, it increased Java’s robustness.

Secure: As Java was originally targeting mobile devices that would be exchanging data
over networks, it was built to include a high level of security. Java is probably the most
secure programming language to date.

Platform Independent: Programs needed to work regardless of the machine they were
being executed on. Java was written to be a portable language that doesn’t care about
the operating system or the hardware of the computer.

Easy to write code: As compared to program metrics (class counts, method counts,
and so on) tell us that a program written in the Java programming language can be four
times smaller as compare to the same program written in C++.

Write better code: The Java programming language encourages good coding practices,
and manages automatic garbage collection which helps you avoid memory leaks. Based
on the concept of object orientation, its Java Beanscomponent architecture, and wide-
range, easily extendible, flexibility and API can reuse existing, tested code and introduce
fewer bugs.

Develop programs and Time Safer: The Java programming language is easier and
simpler than C++, as such, manages your development time upto twice as fast when
writing in it. The programs will also require fewer lines of code.

Distribute software makes work easy : Using Java Web Start software, users will be
able to launch own applications with a single click on mouse. An automatic version
check initially weather users are always up to date with the latest version of your software.
If anupdate is available for it, the Java Web Start software will automatically update their
installation.

The team at Sun Microsystems was successful in combining these key principles, and
Java’s popularity can be traced to it being a robust, secure, easy to use, and portable
language.
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The JAVA is also a object oriented based programming language, were it has the ability of multi
tasking and also it has JVM (Java virtual Machine) which helps it to match with any platform and
that why we call JAVA as a platform independent language.

Input Program Output Result

AFirst Sinple program: Rolling stone gathers no moss

Let us now have a deep analysis of a very
simple programin JAVA.

/* This is a simple JAVA program

*

Class Exanple{

// your programbegins with a call to main().
Public static void main(String args[]) {

Systemout.println( Rolling stone gathers

nomoss );

h
b

We have enter java programming in any text editor and save it with an extension .java example
here the program can be saved as Example.java

S
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Run 2]

Type the name of & program, folder, document;-or
Internet resource; and Windows will open it for you,

Cpertt [cmdl Ll

| QK I Capcel J Qrowse;..J

Fig : 9.7 Run Dialog Box

Most programs that you run on your computer are windowed applications; they work inside a
window that you can move around on your desktop. The Example program is an example of a
console program. It does not run in its own window; it has to be run through a terminal window
instead. A terminal window is just another way of running programs stored on your hard drive.
To open a terminal window, press the “Windows key and the letter “R .

You will see the “Run Dialog Box .

Type “cmd , and press “OK .

L WENWS st e S eoniloe

Fig : 9.8 Java Compiler

A terminal window will appear on your screen. Think of it as a text version of Windows
Explorer; it will let you navigate to different directories on your computer, look at the files they
contain, and run programs. This is all done by typing commands into the window.

The Java Compiler

Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

Another example of a console program is the Java compiler called “javac . This is the program
that will read the code in the Example.java file, and translate it into a language your computer can
understand. This process is called compiling. Every Java program you write will have to be
compiled before it can be run.
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To run javac from the terminal window, you first need to tell your computer where it is. On my
machine it’s in a directory called “C:\Program Files\Java\jdk\1.6.0 06\bin . If youdon’t have
this directory, then do a file search in Windows Explorer for “javac to find out where it lives.

Once you’ve found its location, type the following command into the terminal window:
set path= *the directory where javac lives*

E.g,
set path=C:\Program Files\Java\jdk\1.6.0 06\bin

Press Enter. The terminal window will just return to the command prompt. However, the path to
the compiler has now been set.

FT L WENDUWS st e S e Sas

Fig : 9.9 Change Directory-Screen
Change the Directory
Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

Next, navigate to where your Example.java file is saved. Here the file has been saved in a
directory called “Java in My Documents. Its location is “C:\Documents and Settings\Paul\My
Documents\Java .

To change the directory in the terminal window, type in the command:
cd *directory where Example.java file is saved*
E.g.,
cd C:\Documents and Settings\Paul\My Documents\Java
You can tell if you’re at the right directory by looking to the left of the cursor.

O WENSWS sy stemn S e sne

Fig : 9.10 Compile Program-Screen
Compile Your Program
Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.

We’re now ready to compile the program. To do so, enter the command:

N
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javac Example.java

i CA\WINDOWS\ system32\ omdoome

iNDacuments and SettingessPaul My Documente’Javadiava HelloWorld
{ello Yorld!

i \Dacuments and Settingsslaul My DocumentesJava?

Fig : 9.11 Run Program - Screen

After you hit Enter, the compiler will look at the code contained within the HelloWorld.java
file, and attempt to compile it. If it can’t, it will display a series of errors to help you fix the
code if you have errors in the code.If some error occurs go back and check the code you’ve
written. Make sure it matches the example code and re-save the file. Keep doing this until you
can run javac without getting any errors.

Run the Program
Microsoft product screen shot(s) reprinted with permission from Microsoft Corporation.
All that’s left to do is run the program.
In the terminal window type the command:
java Example

When you hit Enter, the program runs and you will see “ Rolling stone gathers no moss “
written to the terminal window.

Where JAVA is applied most?

The java programming is applied in all kinds of software programming, graphic designing
wireless technology (Wi-Fi), web based technologies and in mobile development technology.
As JAVA s a very vast subject we have given the basic introduction to it which will make you
familiar with the utility of JAVA programming language.

Visual Basic :

Microsoft®  This productis regishesd tuy
den

VISUA L This program i protected by US and niermaticnal
cepytich! Iws a3 deserbed in Help Aboui,
Ludi0° - cCopyright @ 1927-13% Microsof Carporation

VISUAL BASIC is a VISUAL and events driven Programming Language. These are the main
divergence from the old BASIC. In BASIC, programming is done in a text-only environment )
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and the program is executed sequentially. In VB, programming is done in a graphical environment.
However, In VB, you just need to drag and drop any graphical object anywhere on the form,
and you can change its color any time using the properties windows.

On the other hand, because the user may click on certain object randomly, so each object has to
be programmed independently to be able to response to those actions (events). Therefore,a VB
Program is made up of many subprograms, each has its own program code, and each can be
executed independently and at the same time each can be linked together in one way or another.

It’s a computer programming system developed and owned by Microsoft. Visual Basic was
originally created to make it easier to write programs for the Windows computer operating
system. Visual Basic is often referred to using just the initials; VB. Visual Basic is easily the most
widely used computer programming system in the history of software.

The One reason VB is so great for learning is that the original BASIC (“Beginner’s All purpose
Symbolic Instruction Code ) was designed as a language to teach people how to program.

Simple form creation using Visual Basic 6.0

3 Form1 [:;i

“
New ' | Exintng | Racent|

: a )
D 2z 2 .@
2 2
Rcbax
Corbrol
©
e
Acdn

SAVHEE  AcwexEXE  ArtsX DIL

% ° < ©

d X M S

VB Wizard Active Actives Daafroject

Manage Docurent Dl Bocursent Exo .

e e R «||Here let us create a simple form that has two command

I Dent shaw thy dabog i tre fuhuae

buttons in it and when they are clicked they should display a message.
\S J
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To start VB
Start Visual Basic. Usually, ‘Start > Programs > Microsoft Visual Studio > Microsoft Visual
Basic 6.0’.

To create a form
e C(Click the default “Standard EXE icon and then click the “Open button.

Prapect! - Meroscit Visusd Bass: [desion)] - [Farmal (Farms)] = =0 x)
Dr ER Y Browd Fowel Tebog Ben Qury Dpoun Tds fdeine Widwe by ~lfix3
B-a-BE@ o @alc ol MEEER2QXD T G 317 o0« 0

- T

N o eT—

Fig : 9.14 VB Form - Screen
This creates a window with a form and other components attached to it
e Draga ‘Command Button’ from the “Toolbox’ to the form and drop it. Drag another one

to the form and drop it.

l - E§ Project1 {Project1.vbp) I
= 5 Forms
I B [Fovami R B
_ = view object
E1 Yiew Code

Froperties

Add »
Save Forml.fim

Save Form1 fim &s..,
Remave Formt.frm:

& print...

v Dockable
Hide

.‘@ Publish Compenert. ..

Fig : 9.15 Toolbox & Command Button - Screen
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e Ifyoucan’tsee the toolbox, look for it in the ‘View’ menu. And notice that several other
components can be turned on and off there, too.

R S S e Z g
Frajece - ro P e

5 e L T [

B CEI S e Sa s, Ea
5 Projecti (Project i vbp) "~
= %S Forms o é‘; cul
QWW s ir Ry Copy ok
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Relete

Tk Bring to Front
m‘ﬁ ,.ar_ ” uJ A I

- View nge
= alion to Grid.

S Propettias

Fig:9.16 Popup Command-Screen

Another thing to know is that VB 6 uses the right-click ‘context menu’ a lot. Right click
‘Form1’ for example and notice the options there. This is the fastest way to switch between
viewing an object (like Form1) and the code in that object.
e  (lick the first Command Button to select it. Open the property window and change the
Name property to CommandA. Change the Caption to A.
Select the second Command Button from the drop down window at the top of the property
window and then change the Name property to CommandB. Change the Caption to B.
Click ‘Properties’ at the bottom to open the window. Then click the ‘Name’ property in the
first column and change the value in the second. We do this because we want to use unique
names in our program code to refer to this object. Visual Basic will do it automatically (it
already has) but it’s hard to keep track of a series of objects with names like Command1',
‘Command?2’, and so forth. You might also notice that the Property window is dockable and
resizable. It’s been undocked and resized below:
The name of the command buttons will be changed as A and B

Double click the first ‘Command Button’ object in the form to open the code window for that
button.

Enter the code,

Msgbox “You clicked Button A”
after the automatically entered code
Private Sub CommandA_Click()

Double click the second ‘Command Button’ object in the form to open the code window for
that button.

Enter the code,

N
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Msgbox “You clicked Button B”
after the automatically entered code

Fig: 9.17 Properties Window-Screen
Private Sub CommandA_Click()
Another thing to notice is the ‘naming convention’ used for the subroutine:
CommandA_Click

Fig : 9.18 Command Button Click

This is always the same. The first part is the name of the object. The second part is the event. You
can’t change this name or VB won’t know where to find your event code. Let VB assign these
names and leave them alone.

ﬁ Projectt - Microsoft Yisual Baslc [deston] Run Button
B Edt yen Project Foma: Qebug Eun Query Diworyg Tooks Gdd-ins

B-2-FFR L BBRA 00, 5 Y

Fig : 9.19 Run Button Window
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Click the ‘Run’ button in the toolbar at the top of the VB 6 development environment window

to execute the program.
Click either button A or button B and observe the fruits of your labor!
Visual basic also allows us to do complex calculation here is a simple example program to find
the sum of two numbers.
e Open anew form and draw the objects required to calculate addition of two numbers.
e Select each and every label, textbox, command buttons & change its name and caption

from the properties dialog box.

Fig : 9.20 Project Design Structure

e (Goto the code window by pressing
View - Viewcode
e The code dialog box will get opened where we need to type the necessary codes in

order to run the program and display the result.
e Here we need to add two numbers and display the result in the third textbox when the

command button “Sum is clicked.
So, we need to type the following code in the code section of the command button “Sum .

% i

HHEEOIEC .
2 (2 LY RN

Fig:9.21 Code Window

\
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Private Sub Command1_Click()
Text3.Text=(Val(Textl.text) ) + (Val(Text2.text))
End Sub

e This command will add the two numbers in the the textbox 1 & 2 and will display the
result in third textbox.

e  After writing the code window we can run the program by pressing the run button in the
toolbar.

The result is displayed as below:

Fig : 9.22 Result Window

Applications of visual basic:

Visual basic has replaced the traditional administrative work by facilitating computerized event
,management such as filling up a form in a bank for new account creation or booking a ticket in
mail for holiday vacation, creating an email account for the first time, for filling job applications
online etc.
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National Anthem

Jana-gana-mana-adhinayaka, jaya he

Bharata-bhagya-vidhata.
Punjab-Sindh-Gujarat-Maratha
Dravida-Utkala-Banga
Vindhya-Himachala-Yamuna-Ganga
Uchchala-Jaladhi-taranga.

Tava shubha name jage,

Tava shubha asisa mage,

Gahe tava jaya gatha,
Jana-gana-mangala-dayaka jaya he
Bharata-bhagya-vidhata.

Jaya he, jaya he, jaya he,

Jayajayajaya, jaya he!

By: Ravindranath Tagore ...
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